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In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
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Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the
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This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting
from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair
damage resulting from improper use or connection to incompatible equipment; or c) to service a product that has been
modified or integrated with other products when the effect of such modification or integration increases the time or
difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THIS PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESSED OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Use Proper Power Cord. To avoid fire hazard, use only the power cord specified
for this product.

Avoid Electric Overload. To avoid electric shock or fire hazard, do not apply a
voltage to a terminal that is outside the range specified for that terminal.

Avoid Overvoltage. To avoid electric shock or fire hazard, do not apply potential
to any terminal, including the common terminal, that varies from ground by
more than the maximum rating for that terminal.

Avoid Electric Shock. To avoid injury or loss of life, do not connect or disconnect
probes or test leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Do Not Operate Without Covers. To avoid electric shock or fire hazard, do not
operate this product with covers or panels removed.

Use Proper Fuse. To avoid fire hazard, use only the fuse type and rating specified
for this product.

Do Not Operate in Wet/Damp Conditions. To avoid electric shock, do not operate
this product in wet or damp conditions.

Do Not Operate in an Explosive Atmosphere. To avoid injury or fire hazard, do not
operate this product in an explosive atmosphere.

Use Proper Power Source. Do not operate this product from a power source that
applies more than the voltage specified.

Provide Proper Ventilation. To prevent product overheating, provide proper
ventilation.

Injury Precautions

Product Damage
Precautions
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Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

 

Protective Ground
(Earth) Terminal

ATTENTION
Refer to Manual

Double 
Insulated

DANGER
High Voltage

Refer to the specifications section for a listing of certifications and compliances
that apply to this product.

Symbols and Terms

Certifications and
Compliances
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Preface

This document applies to the deferred-time analysis and generation software and
hardware of the Tektronix MTS 210 and MTS 215 MPEG Test Systems.

NOTE. The MTS 215 and the MTS 210 option AG include all applications
discussed in this user manual. The MTS 210 option 1A includes all applications
except the Multiplexer. The MTS 210 option 1G includes all applications except
the deferred-time Analyzer. You can upgrade an option 1A or 1G Test System to
either an  MTS 210 option AG or an MTS 215; see your Tektronix representative
for more information.

For information about the additional MTS 215 real-time analysis hardware and
software, refer to the MTS200 Series Real-Time Analyzer User Manual,
Tektronix part number 071-0076-0X, that is provided with the MTS 215.

For information about the Windows NT Workstation operating system, refer to
the Microsoft documentation that accompanied your test system.

For information about the Compaq Proliant server, refer to the Compaq
documentation that accompanied your test system.

For the latest information about Tektronix MPEG Test System features and bugs,
refer to the MTS 200 Series Read This First document, Tektronix part number
071-0079-0X, that accompanied your test system.
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Contacting Tektronix

Product
Support

For application-oriented questions about a Tektronix measure-
ment product, call toll free in North America:
1-800-TEK-WIDE (1-800-835-9433 ext. 2400)
6:00 a.m. – 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tek.com

For product support outside of North America, contact your
local Tektronix distributor or sales office.

Service
Support

Contact your local Tektronix distributor or sales office. Or visit
our web site for a listing of worldwide service locations.

http://www.tek.com

For other
information

In North America:
1-800-TEK-WIDE (1-800-835-9433)
An operator will direct your call.

To write us Tektronix, Inc.
P.O. Box 1000
Wilsonville, OR 97070-1000
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Product Description

This section describes the capabilities and components of the Tektronix MPEG
Test System. options AG, 1A, and 1G. These features are shared by the MTS 215
MPEG Test System.

Overview
The MTS 210 hardware and software make it possible to create, generate,
acquire, and analyze MPEG-2 transport streams and DVB multiplexes. The
MTS 210 option AG and MTS 215 include the following applications:

� Multiplexer

� Deferred-time Analyzer

� Table Editor

� DVB Channel Coder/Decoder

� Packet Jitter [Adder]

� Data Store Administrator

The MTS 210 option 1A is intended for transport stream analysis and does not
include the Multiplexer application.

The MTS 210 option 1G is intended for transport stream generation and does not
include the Deferred-time Analyzer application.

All MTS 210 and MTS 215 Test Systems contain the Data Store system which
can acquire and output transport streams at rates from 1 Mbit/s to 55 Mbit/s.
Given the standard 18 Gbytes of Data Store disk capacity, the MTS 210 can store
over 40 minutes of transport stream data at 55 Mbits/s. You can also use
end-to-start looping to continuously (and indefinitely) acquire or output up to
18 Gbytes of transport stream. Data Store I/O can be through a variety of
hardware connections, including TTL serial, ECL parallel, ECL serial, G.703,
and RS-422.
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Applications
The five Tektronix MPEG Test System applications are the Analyzer, the
Multiplexer, the PSI and SI Table Editor, the Channel Coder/Decoder, and
Packet Jitter.

With the Deferred-time Analyzer, you can analyze transport stream data
(acquired by the Data Store System) with the Analyzer application. The Analyzer
provides several graphical views of MPEG and DVB transport stream; the views
give access to each field—and each bit, if you wish, in the transport packets,
PES packets, and the various PSI and SI tables.

Hierarchic View. The hierarchic view provides a diagram of the data components
carried by the transport stream. Icons are used to identify the PAT (Program
Association Table), NIT (Network Information Table), PMT (Program Map
Table), PES (Packetized Elementary Stream), packets, and the three types of
elementary streams (video, audio, and data). Additional icons indicate the PID
(Packet Identification) number for each data component.

Interpreted View. The interpreted view shows every field in the selected transport
packet, table section, or PES (packetized elementary stream) packet. Any packet
in the file may be accessed. Search for errors in this view.

Timing Displays. Two types of timing displays are available: PCR (Program
Clock Reference) contained in the transport packet headers and PTS/DTS
(Presentation/Display Time Stamp) contained in PES packet headers. The PCRs
are shown in a graphical form indicating their arrival time. The graphical display
of the PTS/DTS shows a time line for each access unit (such as a video frame)
indicating data arrival and value of each time stamp.

The Multiplexer provides the means to develop a limitless variety of MPEG
transport stream files, using the elementary streams provided.

Transport streams are produced by the software in non-real time, typically 10 to
100 times the play time of the resulting file. A hierarchy display, similar to the
Analyzer, displays the structure of the transport stream.

Up to 20 programs, with 10 elementary streams each, may be included in one
transport stream file.

Elementary stream files containing both stationary test signals and motion
sequences are provided on the Bit Stream CD ROM. With the MTS 210
Multiplexer and Table Editor applications, you can create a variety of transport
stream files that contain one or more of the provided test signals and motion
sequences.

Analyzer

Multiplexer
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Data necessary for the DVB IRD (Digital Video Broadcasting Integrated
Receiver Decoder) to automatically configure itself is available in the MPEG2
Program Specific Information (PSI). Digital Video Broadcasting Specific
Information (DVB-SI) adds information that enables DVB IRDs to automatically
tune to a particular service and allows services to be grouped into categories with
relevant schedule information.

The PSI and SI Table Editor allows the user to enter and change the data in the
SI and PSI tables to fit requirements.

The European Digital Broadcasting Project (DVB) has specified a baseline
system for satellite broadcasting. The Channel Coding portion of the specifica-
tion has the following coding flow:

� MPEG2 Transport stream file (Multiplexer)

� Energy Dispersal — randomizing

� Outer Coder RS (204, 188) — for byte error correction

� Interleaver — better burst error correction

� Inner Coder (Viterbi p/q) — bit error correction

� QPSK Modulator

This application provides the defined channel coding for the transport stream file
and also provides the decoding to return the coded file to a standard transport
stream file.

In addition to creating error-free transport streams, the MTS 210 can also create
transport stream files with known errors.

The Packet Jitter application allows you to create transport stream files with
simulated timing errors that affect the clocks derived from the transport file. This
allows you to test the robustness of decoders under various conditions.

PSI and SI Table Editor

Channel Coder

Packet Jitter
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Accessories

The following accessories are standard with the MTS 210. All items except the
monitor are shipped in the box that contains the server.

� Tektronix 17 inch monitor and monitor cable. (the monitor power cord is
shipped in the MTS 210 accessories package.)

� Compaq server with the Data Store system installed (referred to as the
MTS 210 server).

� Keyboard and mouse

� Software enable key (HASP; installed on the server parallel port).

� MTS 210 MPEG Test System User Manual (this document)

� MTS 200 Series Read This First, part number 071-0079-0X

� Compaq documentation and back-up copies of the Compaq software

� Windows NT software and documentation package.

� Emergency repair disk.

� MTS 210 Installation Software CD ROM, provided for reinstalling the
MTS 210 software in case it becomes corrupted.

� A CD ROM containing MPEG-2 Elementary Streams

� Two power cords: one each for the MTS 210 server and the monitor.

� Six SMB to BNC adaptors: three with 50 � cables and three with 75 �
cables.

� One shielded 9–pin cable (use this cable to meet EMI requirements).

� One shielded 25–pin cable (use this cable to meet EMI requirements).
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Installation

Tektronix MPEG Test System installation involves selecting an installation site,
installing the server pedestal and door, and connecting all necessary cabling.
Once all items are unpacked, system assembly should require just a few minutes.
Save the shipping carton and all the inserts for use if reshipment of the MTS 210
server becomes necessary. Repackaging instructions are in Appendix F.

CAUTION. To avoid damage to the MTS 210 during shipping, retain the original
shipping carton. Shipping the MTS 210 in any other packaging may void the
warranty.

Assembling the Test System
Before you begin to assemble the test system, please make sure that you have
selected an appropriate location.

� Choose a sturdy, level site that includes dedicated and properly grounded
circuits, air conditioning equipment, and static electricity protection.

� Provide a minimum of three inches (7.6 cm) clearance at the front and back
of the computer for proper ventilation.

� Make sure that no heavy electrical equipment will be located nearby.

Once a good site has been identified, begin assembling the MTS 210 using the
procedure given below. (Figure 1–1 illustrates the rear panel of the test sytem.)

WARNING. Be careful lifting and moving the MTS 210 server. It is heavy.

1. Install the pedestal on the MTS 210 server.

a. Carefully set the server on its top.

b. Align the post on the pedestal with the slots in the server case.

c. Slide the pedestal into the slots until the retaining clip on the pedestal
snaps into place on the server base.

d. Carefully turn the server over to set it upright on the pedestal.

2. Install the door on the front of the server.

a. Line up the hinge pins of the two hinges on the right side of the server
door with the hinge pin holes in the server chassis.
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b. Lower the hinge pins into the hinge pin holes and close the door.

3. Connect the keyboard to the keyboard port on the rear panel of the MTS 210
server.

4. Connect the mouse to the mouse port on the rear panel of the server.

5. Verify the software key (HASP) is attached to the parallel port on the rear
panel of the MTS 210 server. See Figures 1–1 and 1–2. (It should already be
connected.)

NOTE. If you need to use the parallel port for another function, connect that
cable through the HASP.

6. If the MTS 210 is being connected to a network, connect it now. Two types
of ethernet ports are provided: an AUI port and an RJ45 port. See
Figure 1–1. The ethernet ports do not require termination.

7. Connect the monitor cable to the monitor and to the rear of the MTS 210
server at the video port in expansion slot six. Do not use the built-in video
connector.

8. Connect the power cord to the monitor and to a power source.

9. Connect the power cord to the MTS 210 server and to a power source.

NOTE. Although the MTS 210 is based on a standard computer configuration, do
not use the MTS 210 for any other purpose or install boards not provided or
recommended by Tektronix. These actions may cause your system to operate in
an unexpected manner. However, you may connect it to an appropriate network.
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Serial ports

Parallel port
(where HASP

is installed)

Keyboard port

Mouse port

Video
port

SCSI
connector

RJ45-Ethernet
port

AUI Ethernet
port

Data Store I/O

Figure 1–1: The rear panel of the MTS 210 server

The MTS 210 server and monitor are designed to operate from a single-phase
power source having one of its current-carrying conductors at or near earth
ground (the neutral conductor). Systems that have both current-carrying
conductors live with respect to ground, such as phase-to-phase or multiphase
systems, are not recommenced as power sources. A protective ground connec-
tion, by way of the grounding conductor, in the power cord is essential for safe
operation.

WARNING. This equipment is designed for connection to a earth-grounded AC
outlet. The grounding plug is an important safety feature. To avoid risk of
electrical shock or damage to your equipment, do not disable this feature.

Mains Voltage Range. The MTS 210 server (the ProLiant 2500) operates on power
mains from 100 VAC to 230 VAC.

Supplying Power
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The monitor operates on either 115 VAC or 230 VAC source also without having
to set a voltage selection switch.

Mains Frequency. The ProLiant server and the monitor both operate on either
50 Hz or 60 Hz line frequencies.

CAUTION. To prevent damage to the server, you should protect the instrument
from power fluctuations and temporary interruptions with a regulating
uninterruptable power supply (UPS). This device protects the hardware from
damage caused by power surges and voltage spikes. In addition, it keeps the
system in operation during power failure.

Power Cord Options. The server and monitor are delivered from the factory with a
power cord for 60 Hz/117 VAC North American operation unless one of the
power cord options was ordered. Table 1–1 shows the power cord options.

Table 1–1: Power cord identification 

Plug Configuration Normal Usage Option Number

North America
125 V/15A Plug
NEMA 5-15P

Standard

Europe
230 V

A1

United Kingdom
230 V

A2

Australia
230 V

A3

Switzerland
230 V

A5
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The MPEG Test System software is enabled by the software enable key (the
HASP; see Figure 1–2), which is installed on the parallel port and is transparent
to parallel port applications, such as printing. The HASP must be in place on the
ProLiant parallel port for the MTS 210 to operate. Do not lose the HASP. The
software enabler (HASP) should remain with the MTS 210 at all times. If the
entire instrument is returned for service, ship the HASP with the server.

CAUTION. Do not lose the HASP (software enable key). The MTS 210 will not
operate without it being installed on the parallel port. The software enabler key
(HASP) also is required by the Tektronix Service Center if the ProLiant server is
returned for repair.

Figure 1–2: MTS 210 HASP

Software Enable Key
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MTS 210 I/O
The MTS 210 rear panel input/output connectors (I/O) are located in two EISA
slots on the ProLiant server rear panel. Specification of the I/O ports are in
Appendix A, Specifications. Figure 1–3 shows the arrangement of the I/O
connectors. A detailed description of each of the connectors follows the
illustration.

ECL parallel/serial
I/O port

ECL control port

G.703 output
(8.448 Mbits/s)

G.703 input

10 Mbit serial
port (RS-422
levels I/O port)

External clock
input (Clk In)

TTL 50 � serial
port (Clk I/O)

G.703 output
(34.368 Mbits/s)

TTL 50 � serial
port (Data I/O)

Figure 1–3: The MTS 210 signal I/O ports

The bidirectional differential control port adds flexibility to the ECL Parallel and
Serial Ports. Adding the three control signals provides two more operating
modes. (Using this port is optional.) The ECL control port pinout is shown in
Table 1–2.

ECL Control Port
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Table 1–2: ECL control port pinout 

ECL control port Pin Function

1 CHCLK (Channel Clock)

2 Ground

3 CHSYNC (Channel Sync)

2

1
6 4 CHCLKEN (Channel Clock Enable)

3

2
7

5 Shield

5

4
9

8
6 CHCLK (Channel Clock)

5
9

7 Ground

8 CHSYNC (Channel Sync)

9 CHCLKEN (Channel Clock Enable)

Asserted Low differential signal.

The ECL Parallel/Serial I/O port receives and transmits MPEG-2 transport
streams at ECL levels. It is a differential, bidirectional port that operates
independently or in conjunction with the ECL Control Port. The port transmits
or receives either parallel or serial data depending on settings made in the Data
Store Administrator application.

Operating Modes. When the ECL Parallel/Serial I/O port is used independently of
the ECL Control Port there are three operating modes:

� Slave acquisition. Captures input signals using the clock signal on the ECL
Parallel/Serial I/O port as the timing source.

� Master generation. Outputs signals using the MTS 210 internal clock.

� Master generation with external clock. Outputs signals using a timing signal
applied to the external clock input (Clk In).

When the ECL Parallel/Serial I/O port is used in conjunction with the control
port, there are three additional operating modes:

� Master acquisition. Captures input signals using control signals from the
ECL Control Port to drive the signal source.

� Master acquisition with external clock. As above, but uses a timing signal
applied to the external clock input (Clk In) as the clock source.

� Slave generation. Outputs signals using the ECL control port inputs as the
timing source.

ECL Parallel/Serial I/O Port
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NOTE. Master — The unit provides the clock for data transmission.
Slave — The unit does not generate the data clock. The unit returns the clock
provided by an external source.

Parallel Pinout. The parallel data pinout of the ECL Parallel/Serial I/O port is
shown in Table 1–3.

Table 1–3: ECL parallel data pinout 

ECL parallel port Pin Function Pin Function

1 DCLK 14 DCLK

1
4

2 ground 15 ground
2

5

14
3 DATA 7 16 DATA 7

4

3
16

15
4 DATA 6 17 DATA 6

5

4
17

6

5 DATA 5 18 DATA 55

6
9

18 6 DATA 4 19 DATA 4

7

6
19

7 DATA 3 20 DATA 3

9

8
21

20
8 DATA 2 21 DATA 2

9
21

22 9 DATA 1 22 DATA 1
10

4

23 10 DATA 0 23 DATA 0

12

11

5

24 11 DVALID 24 DVALID

13
25

12 PSYNC 25 PSYNC

13 shield

Asserted Low differential signal.

Serial Pinout. The serial data pinout of the ECL Parallel/Serial I/O port is shown
in Table 1–4.
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Table 1–4: ECL serial data pinout 

ECL serial port Pin Function

1 DCLK

1
4

2 ground
2

5

14
3 - 9 Not Managed

4

3
16

15
10 DATA 0

5

4
17

6

11 DVALID
5

6
9

18 12 PSYNC

7

6
19

13 shield

9

8
21

20
14 DCLK

9
21

22 15 ground
10

4

23 16 – 22 Not Managed

12

11

5

24 23 DATA 0

13
25

24 DVALID

25 PSYNC

Asserted Low differential signal.

This serial interface complies with the electrical characteristics of ITU-T
Recommendation G.703 (HDB3 code) for 8.448 Mbit/s and 34.368 Mbit/s.

There are two modes of operation:

� Acquisition. Locks to incoming signal and is self clocking.

� Generation (internal clock source). Uses an internal clock source.

This interface uses three Data Store circuit board mounted SMB connectors. One
connector is a dedicated input for both bit rates. The other two connectors are
dedicated outputs, one for the 34.368 Mbit/s output and the other for the
8.443 Mbit/s output. To reduce spurious emissions, only the output currently
being used should be connected.

NOTE. Do not leave an SMB-to-BNC adaptor cable on an unused G.703 output.
Doing so will cause the MTS 210 to exceed EMC emission requirements.

G.703 Output
(8.448 and 34.368 Mbit/s)

and G.703 Input
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The 10 Mbit Serial port can transmit and receive MPEG transport signals. It has
bidirectional clocks and data pairs. The maximum operating frequency is
10 Mbit/sec. It uses RS-422 voltage levels, with line-to-line input termination of
110 �. The pinout is shown in Table 1–5.

Table 1–5: 10 Mbit serial port pinout 

10 Mbit serial port Pin Function

1 DATA IN

2 CLK IN

3 DATA OUT

2

1
6 4 CLK OUT

3

2
7

5 ground

5

4
9

8
6 DATA IN

5
9

7 CLK IN

8 DATA OUT

9 CLK OUT

Asserted Low differential signal.

The 10 Mbit Serial port uses the following signals:

� Data In and Data Out. These are MPEG serial bit streams.

� Clock In and Clock Out. These are continuous data transmission clocks.

You can choose from three modes of operation:

� Acquisition. Captures an input signal using external timing reference.

� Internal generation. Generates an output signal using the Tektronix MPEG
Test System internal clock as the timing reference.

� External generation. Generates an output signal using the Clock input as the
timing reference.

The Clk In connector provides optional timing input for the ECL Serial, ECL
Parallel, TTL and 10 Mbit Serial outputs. Its maximum operating frequency is
45 MHz.

10 Mbit Serial Port
(RS-422 Levels I/O Port)

Clock Input
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The TTL 50 � Serial Port receives and transmits at TTL levels. It consists of
clock and data inputs with dedicated connectors. The Data signal is a serial bit
stream, and the Clock signal is a continuous data transmission clock. The
maximum operating frequency is 45 Mbits/s.

There are three modes of operation:

� Acquire. Captures an input signal.

� Internal Generation. Generates a signal that is locked to the internal clock.

� External Generation. Generates a signal locked to an external reference (the
Clock Input).

Cables and Mating Connectors for Data Store Inputs/Outputs
The test system is supplied with adapters for connecting the Data Store SMB
connectors to standard BNC connectors. It may be necessary to acquire or
assemble other signal connecting cables and adapters in order to install the test
system in your facility.

The maximum usable cable length for the various ports on the MTS 210 are a
function of data rate, cable type, and ambient environment. See Table 1–6. Low
data rates can stand longer cable lengths than high data rates. Low-loss coaxial
cable and low-capacitance properly pair-twisted cable can support longer
transmission paths than miniature coaxial cable or ribbon cable. Excess RF noise
can induce noise in the cable which will reduce the usable length.

The only ports designed as a transmission system are the G.703 I/Os. The others
are basically short-range interconnects. Note that most ports must control cable
delay matching, to maintain clock to data timing margin, or data integrity will
suffer.

Table 1–6: Estimated maximum cable lengths 

Port Rate, Mbits/s Maximum length Cable type Comments

G.703 8.448 275 meters Belden 8281 4 dB atten at
4.224 MHz

G.703 34.368 125 meters Belden 8281 4 dB atten at
17.18 MHz

10 MBit
(RS422)

1 100 meters 24 AWG
unshielded
twisted pair

Ref. ANSI/TIA/
EIA-422-B-1994

10 MBit
(RS422)

10 15 meters 24 AWG 
unshielded 
twisted pair

Ref. ANSI/TIA/
EIA-422-B-1994

TTL 50 � Serial Port
(Data & Clock I/O)
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Table 1–6: Estimated maximum cable lengths (cont.)

Port CommentsCable typeMaximum lengthRate, Mbits/s

TTL 10 50 meters RG58 type Calculated Value

TTL 50 25 meters RG58 type Calculated Value

ECL
Parallel

1 50 meters Belden 8112 Calculated Value

ECL Serial 45 5 meters Belden 8112 Calculated Value

Adapters
The test system comes with six SMB-to-BNC adapter cables. Three of the
adapters are 75 � to match the impedance of the G.703 inputs and outputs. The
other three adapters are 50 � for use with the TTL Serial Port (Clock and Data)
and Clock Inputs.

Do not leave an SMB-to-BNC adapter cable on an unused G.703 output. Doing
so will cause the test system to exceed EMC emission requirements.
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First Time Operation

Once you have installed the Compaq Proliant server, the Tektronix MPEG Test
System is ready to operate. Slide the power switch cover plate to the right as
shown in and press the power switch.

Slide power switch
cover plate

Power switch

The MTS 210 then goes through the Windows NT initialization process, which
can take up to two minutes. (For more information on the Windows NT
initialization process, please see the Windows NT documentation.) Under normal
circumstances no action is required until the Begin Logon window appears;
when it does, press CTRL + ALT + DELETE (all three keys simultaneously) to open
the Logon Information  dialog box.

Logging In
To logon to the MTS 210, enter “MTS100” in the User name box, leave the
password blank, and then press RETURN (these are the default values set at the
factory). This is the login account you should use for most of your work.
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There are two other logins and passwords available. The first is “guest” with no
password. This level has only limited access to files and applications. The
second is “administrator” with “MPEG2” as the password. This user has
administrator privileges. You must use this login when performing any software
upgrades.

CAUTION. The administrator user has all the privileges of an administrator. If
you are connected to a network, you may have more privileges than you realize
within the network. It is recommended that you do not perform normal opera-
tions while logged in as administrator.

You can change the passwords if necessary; refer to the Windows NT documen-
tation for instructions. If you change any password, be sure to create a new
emergency repair disk. (See page C–1.)

The Initial Window
Once you have logged in, you will have access to the Tektronix MPEG Test
System program group.

This manual explains how to use the Tektronix MTS 210 applications. Refer to
the MTS200 Series Real-Time Analyzer User Manual, Tektronix part number
071-0076-00, for information about the MTS 215 Real-Time Analylzer
application.

Additional Support
Additional support for the MTS 210 can be obtained from the Tektronix support
number. The support number is available from North America. Call 1-800-TEK
WIDE (1-800-835-9433) and ask for MPEG Test System support.
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Operating Basics

There are eight applications provided with the MTS 210. Their names and
functions are given in Table 2–1.

NOTE. The Analyzer application is not included with option 1G. The Multiplexer
application is not included with option 1A. The Real-Time Analyzer application,
included with the MTS 215, is discussed in the MTS200 Series Real-Time
Analyzer User Manual.

Table 2–1: MTS 210 applications 

Icon Application Name FunctionÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Analyzer
(MPEG2 System Analyzer application)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Analyze transport stream files and packe-
tized elementary streams.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Data Store Control 
(Data Store Administrator)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Manage the Data Store Disks. It also
controls acquisition and generation of
MPEG-2 transport streams.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

DVB Channel Coding and Decoding
(Coder/Decoder application)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Code and decode transport stream files to
DVB specifications.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Multiplexer
(MPEG2 Transport Multiplex Generator)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Create transport stream files from PSI and
SI table files, elementary stream files, and
data files. Not included with the MTS 210
option 1A.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Packet Jitter ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Add jitter to the PCR data in the transport
stream file.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Table Editor 
(Edit Table application)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Create and edit PMT, NIT, SDT, BAT, and
EIT files.

Error Injector Insert or correct errors in transport stream
packets.

Set Carb Set parameters of the Data Store system.

Running the Software
Start any of the applications by clicking its name in the Tektronix MPEG Test
System submenu. The HASP� (parallel port software key) must be installed for
any of the applications to operate. If the Data Store board is not installed, the
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Data Store Control will not initialize correctly and you will receive an error
message.

NOTE. This manual is written assuming a basic level of familiarity with the
Windows 95 or the Windows NT 4.0 operating system. If you are not comfortable
with either operating system, review the Windows NT documentation.

Tutorials and Reference Sections
Tutorials and reference information are provided to help familiarize you with the
six software applications in the MTS 210. The first of three tutorials begins on
page 2–7. The Reference section begins on page 3–1.

The tutorials step you through both analyzing transport stream files and creating
(multiplexing) MPEG2 transport streams files and transport streams. They are
presented in a step-by-step manner and designed so that you can follow along
using your own MTS 210. The files required for these exercises are shipped with
the MTS 210.

The Reference section explains all of the commands available from each of the
six applications that are part of the MTS 210 package. The explanations are
given in the following order: Menu Bar commands, Command Buttons, and
finally commands that can only be accessed through “mouse-clicks”.

Acquiring Elementary Bit Stream Files
The standard configuration of the Tektronix MPEG Test System contains several
video and audio elementary stream files and a sample transport stream file.
These files contain pictures, common industry test signals, and sample signals in
MPEG-2 format. They may be used for the following tutorials and for construct-
ing your own transport streams.

There are two sources of additional elementary stream files: a CD ROM (part
number 063-1914-0x) that is supplied with the instrument and the Tektronix
FTP site.
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To use files from the CD ROM, either copy the files to the appropriate directo-
ries on the MTS 210 system disk (drive C) or leave the CD ROM in drive D.

Audio Files. The CD ROM contains the following audio files in the Audio
directory:

15kz–064.mp2
15kz–128.mp2
15kz–192.mp2
15kz–256.mp2
1kz–064.mp2
1kz–128.mp2
1kz–192.mp2
1kz–256.mp2
400–064.mp2
400–128.mp2
400–192.mp2
400–256.mp2

4kz–064.mp2
4kz–128.mp2
4kz–192.mp2
4kz–256.mp2
Music064.mp2
Music128.mp2
Music192.mp2
Music256.mp2
Sync–064.mp2
Sync–128.mp2
Sync–192.mp2
Sync–256.mp2

The file names indicate the elementary stream bit rate. The file 15kz–256.mp2,
for example, contains a 15 kHz audio tone at 0.256 Mbits/s.

Video Files. The CD ROM contains the following video files. The Video\525
directory contains streams with 525-line video; the Video\625 directory contains
streams with 625-line video. Both directories contain all listed files.

100b_015.mp2
100b_060.mp2
100b_120.mp2
Bbc3_015.mp2
Bbc3_060.mp2
Bbc3_120.mp2
Cact_015.mp2
Cact_060.mp2
Cact_120.mp2
Mobl_015.mp2
Mobl_060.mp2
Mobl_120.mp2
Mulb_015.mp2
Mulb_060.mp2

Mulb_120.mp2
Pulb_015.mp2
Pulb_060.mp2
Pulb_120.mp2
Sync_015.mp2
Sync_060.mp2
Sync_120.mp2
Tens_015.mp2
Tens_060.mp2
Tens_120.mp2
V700_015.mp2
V700_060.mp2
V700_120.mp2

The file names indicate the elementary stream bit rate. The file 100b_060.mp2,
for example, contains a video elementary stream with a bit rate of 6.0 Mbits/s.

CD ROM
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Examples. The CD ROM also contains the following files in the Examples
directory:

10khz.mp2
1khz.mp2
Demo_015.mp2

Demo_060.mp2
Sample.trp

A second way to access these same signals (and any new bit streams that may
become available), is via anonymous FTP from the Tektronix FTP site,
ftp.tek.com. If you have a web browser, point it to the following URL:

FTP://ftp.tek.com/tv/test/streams/Element/

Otherwise, use FTP to contact ftp.tek.com, log in as “anonymous,” and use your
email address as the the password. MPEG files are available in subdirectories of
/tv/test/streams/Element. Each directory contains a Readme.txt file that describes
the contents of the directory.

If you have no access to FTP, please contact Tektronix at 1-800-TEK-WIDE and
ask for MPEG Test System support. An engineer will be glad to help you get the
data. If you have Internet access but are having trouble accessing the site, contact
your system administrator for assistance.

The following script illustrates the procedure for connecting to the MPEG Test
System FTP site. Your entries are indicated with bold face type.

% ftp ftp.tek.com

Connected to inet1.tek.com.

220 inet1 FTP server (Version wu–2.4(1) Sun Jan 29 12:29:00 GMT

1995) ready.

Name (ftp.tek.com:user): anonymous

331 Guest login ok, send your complete e–mail address as password.

Password: enter your email address

230–

230– T E K T R O N I X F T P A R C H I V E

230–                /

230–

230 Guest login ok, access restrictions apply.

ftp> cd /tv/test/streams/Element

The MPEG Test System
FTP Site
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250 CWD command successful.

ftp> get README.TXT

The data included in this distribution, on the FTP site, is available to the user on
an “as-is” basis. Tektronix disclaims any and all warranties, whether express,
implied, or statuary, including any implied warranties of merchantability or of
fitness for a particular purpose.
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Tutorial: Analyze a Signal

This section is intended to introduce you to the features and capabilities of the
MPEG-2 System Analyzer. This “guided tour” uses step-by-step procedures and
a standard MTS 210 sample transport stream file so you can follow along with
your own system.

NOTE. To help you follow along with your own MTS 210, all steps that require
your action are numbered.

Terms
Wherever possible, this manual uses terminology consistent with Microsoft�

Windows� and MPEG-2 standards. Refer to the Windows documentation
(included with the Tektronix MPEG Test System) for definitions and explana-
tions of Windows terminology. Refer to the Glossary at the back of this manual
for definitions of terms unique to MPEG or the test system; refer to the Index,
also at the back of this manual, to locate other mentions of any subject.

Getting Help
As you follow the procedures in this section, remember that additional informa-
tion about almost every aspect of MPEG-2/DVB bit streams and analyzer
operation is available from three convenient sources:

� The Reference section of this manual. Using the Analyzer begins on
page 3–1.

� The Analyzer Help menu

� The MPEG-2 Help utility, which contains applicable MPEG-2 standards in
Windows Help format.

Figure 2–1: Starting the MPEG-2 Help utility
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Starting the Analyzer Application
Start the Analyzer by clicking on the Analyzer name in the Tektronix MPEG
Test System submenu.

Figure 2–2: Starting the Analyzer

The Analyzer starts with the Tektronix/Matra background in the application
window. Note the location of the features named in Figure 2–3.

 
Menu bar

Upper toolbar

Lower toolbar

Status bar

Figure 2–3: The Analyzer application window
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There are seven main analyzer menus:

File.  File menu commands control the analyzer/disk interface and printing.

Edit.  Use Edit menu commands to move among items (transport packets,
elementary stream packets, PSI or SI DVB table sections) of the type displayed
in the selected document window.

Selection. Use Selection menu commands to control extractions from a transport
stream file.

Analysis. Analysis menu commands provide access the stream analysis functions.

Options. Use Options menu commands to select analyzer configuration options.

Window. Use Window menu commands to manage the various open document
windows.

Help. The Help menu provides access to various forms of help.

Figure 2–4 shows the functions available from the upper toolbar.

Open Save As Hierarchic View Add View

Figure 2–4: Command buttons on the upper toolbar

To display a reminder of the button function in the status bar (at the bottom of
the application window) at any time, position the mouse cursor over the
command button.

Menu Bar

Upper Toolbar
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Figure 2–5 shows the functions available from the lower toolbar. These
commands duplicate those in the Edit menu; they are available only when the
active window contains one of a possible series of items.

First Previous Go To Next Last Number of items Find next error

Figure 2–5: Command buttons on the lower toolbar

Again, position the cursor over a command button as shown in Figure 2–6 to
display a button function  reminder in the status bar.

Figure 2–6: Using the status bar

Opening an Existing Transport Stream File
Your MTS 210 has the sample transport stream file SAMPLE.TRP to assist in
following the tutorial.

1. From the File menu, choose Open. This brings up the Open dialog box as
shown in Figure 2–7.

Figure 2–7: The Open dialog box

Lower Toolbar
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2. Select Stream from the list of File Types.

3. Select SAMPLE.TRP from the file name list.

4. Choose OK. Figure 2–8 shows the resulting document window. This is the
hierarchic view of the multiplex encoded in the sample transport stream.

NOTE. The Analyzer cannot generate a hierarchic view if the stream does not
contain a PAT (program allocation table, PID 0) or PMT (program map table).

The hierarchic view that appears when you first open a file is based on the first
versions of the PAT and PMT tables found in the stream. You can use the Next
command in the Edit menu or click on the Next command button (in the lower
toolbar) to go to the next PSI version, if any, in the stream.

Figure 2–8: The hierarchic view of the SAMPLE.TRP stream

The Hierarchic View
The hierarchic view allows you to select an icon that represents a particular
element in the stream and make a more detailed analysis. When selected, an icon
displays in reverse video. After selection, all the extraction and analysis
functions are available through the toolbars and menus.

Table 2–2 identifies the icons used in the hierarchic view.
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Table 2–2: Icons used in the hierarchic view 

Icon Element Type
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Multiplex transport packets. This icon represents all (188- and 204-byte) transport
packets that make up the stream. If you visualize the transport stream as a train, this
icon represents every car in the train, regardless of its configuration (flat car, boxcar,
or hopper for example) and what it contains.ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Transport packets of a particular PID (Program ID). Other elements (tables, clocks,
PES packets) are the “payload” contained within transport packets or are constructed
from the payload of several transport packets that have the same PID. The PID
number appears under the icon.

In the hierarchic view, the icon to the right of this icon represents the payload of
packets with this PID.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Transport Packets that contain independent PCR clocks. The PID appears under the
icon.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PAT (Program Association Table) sections. Always contained in PID 0 transport
packets.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PMT (Program Map Table) sections.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

NIT (Network Information Table) Provides access to SI Tables through the PSI/SI
command from the Selection menu. Also used for Private sections.

When the DVB option (in the Options menu) is selected, this icon can also represent
SDT, BAT, EIT, and TDT sections.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Packetized Elementary Stream (PES). This icon represents all packets that, together,
contain a given elementary stream. Individual PES packets are assembled from the
payloads of several transport packets.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Video elementary stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Audio elementary stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Data elementary stream

ECM (Entitlement Control Message) sections

EMM (Entitlement Management Message) sections
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Icon menus. Each type of hierarchic view icon has a context-specific shortcut
menu that allows quick access to the functions available specifically for the
chosen element. Figure 2–9 shows the shortcut menus for the common icons.
Display this menu by clicking the right mouse button on the icon. Hold the
mouse button down, highlight the desired command, and release the button to
select the command.

NOTE. In all cases, you can select the first command on the shortcut menu (or
the only command in one-item menus) by double-clicking on the icon. For all but
elementary stream icons, this will open an “interpreted view” of the packet or
section. Please continue with this tutorial to learn more about interpreted views.

Figure 2–9: Hierarchic view shortcut menus

Additional Information from the TS Icon
1. Click on the TS icon with the right mouse button and hold the button down

to open the TS shortcut menu, as shown in Figure 2–10.

Figure 2–10: The TS icon shortcut menu

2. Highlight Transport Packets and release the button. This opens an interpreted
view of the first complete transport packet in the stream, as shown in
Figure 2–11.
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Item data

Header fields

Packet (item)
contents

Figure 2–11: The interpreted view of the first transport packet

NOTE. You can also open the same interpreted view simply by double-clicking on
the TS icon.

The interpreted view shows the structure of the transport packet and provides
access to all the information contained in the packet header and payload. The
transport packet display shows one transport packet at a time.

1. Use the command buttons on the lower toolbar to quickly scroll among the
transport packets. Notice that the Item number changes as you scroll through
the transport packets.

First Previous Go To Next Last Number of items Find next error

Figure 2–12: Command buttons on the lower toolbar

The transport stream in SAMPLE.TRP consists of 9300 transport packets, as
indicated by the item number (Item 1/9300) at the top of the display. Many
interpreted views do not indicate the total number of items when the view is
first opened; click on either the Number of Items or the Last command
button to add the information to the item data.

Since this is an analysis program, you should be looking for errors in the stream.

2. Find the next error in the stream by clicking the Next Error button. The
program will search forward in the stream until it either finds an error or
reaches the end of the file. If it finds an error, the interpreted view automati-
cally displays the transport packet that contains the error.

The Interpreted View
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3. Double-click on any packet field name for more information about the field,
as shown in Figure 2–13.

Figure 2–13: Double-click for an explanation of the field

Now see what it has to say about the value of the PID.

4. Click anywhere in the interpreted view outside of the PID message box to
dismiss the message. Then double-click on the PID value (0), to display help
information about the value, as shown in Figure 2–14. In this case, the
message reminds you that PID 0 always identifies the PAT.

Figure 2–14: Help information for the packet field value

Sometimes you can learn more by looking at field values displayed in hexadeci-
mal base. Now change the display to show hexadecimal values.

5. Choose Base from the Options menu, select the Hexadecimal option button
in the Base dialog box, and click OK. Or simply press the F2 function key to
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toggle field values (and values in the hierarchic view) between decimal and
hexadecimal base.

Figure 2–15: Press F2 to toggle numeric base

The hexadecimal view shows all bytes that make up the current item. An
MPEG-2 transport packet consists of 188 or 204 bytes.

1. To open a hexadecimal view, first click the Add View command button—on
the upper toolbar—to open the View Type submenu, as shown in Fig-
ure 2–16.

Figure 2–16: The View Type submenu

2. Choose Hexadecimal from the submenu. This produces the hexadecimal
dump shown in Figure 2–17.

Figure 2–17: Hexadecimal view of a transport packet

Notice that the first few bytes appear in blue characters on the MTS 210
display to indicate that they are required header information for the type of

The Hexadecimal View
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item. A transport packet has four required bytes. The blue, required bytes
may be followed by several bytes shown in gray (for an example, use the
command buttons to go to item three of SAMPLE.TRP). These gray bytes
are optional or variable header information. The remaining bytes, displayed
with black characters, are the payload or data bytes.

3. Close both transport packet windows (interpreted and hexadecimal views) so
you are ready to look at a PID map of the sample transport stream.

The PID map can help you quickly locate the stream location and exact packet
(item) number of a particular table section

1. Click on the hierarchic view TS icon with the right mouse button. Hold the
button down to reveal the shortcut menu, as shown in Figure 2–18.

Figure 2–18: The TS icon shortcut menu

2. Choose PID Map from the menu. This creates the window shown in
Figure 2–19.

Figure 2–19: The PID map of SAMPLE.TRP packets 1 to 100

PID Map
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The PID map represents every transport packet in the stream with its PID
(for uniformity, every PID is listed in a four digit field). In the map, each
unique PID is color-coded according to the type of element it identifies. For
example, the PIDs of packets that contain PAT sections are displayed in light
green characters. The black numbers down the left side of the window
indicate the packet number of the first packet of every row. Notice that the
first PAT section is in packet one.

3. Click the Next command button (you remember: the one with the “�” on it)
repeatedly until you see the next light green PID. The second PAT section in
SAMPLE.TRP is in packet 334.

4. Close the PID map so you are ready to look at Multiplex Allocation in the
sample transport stream.

You can use the Multiplex Allocation view to discover what fraction of the
transport stream multiplex is used by each PID.

1. Once again, click on the hierarchic view TS icon with the right mouse button
to open the shortcut menu. This time, choose Multiplex Allocation to create
the window shown in Figure 2–20.

Figure 2–20: The Multiplex Allocation document window

The multiplex allocation pie chart is useful in determining which PIDs are
present in the transport stream and in confirming that each PID is using the
expected amount of the multiplex.

NOTE. PID 8191 is the stuffing PID; it is not shown in the hierarchic view.

Multiplex Allocation
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2. Close the multiplex allocation window so you are ready to look at the
transport packets of a particular PID with a minimum of clutter.

Additional Information from the Transport Packet Icon
The transport packet (rail car) icon represents transport stream packets that are
identified with a particular PID. Other elements (such as table sections or PES
packets) are the payload contained within these transport packets; the elements
may be fully contained within one packet or constructed from the payload of
several packets with the same PID. The PID number appears under the transport
packet icon. In the hierarchic view, the icon immediately to the right of a
transport packet icon represents the payload.

1. Press function key F2, if necessary, to display hierarchic view values in
decimal base.

2. Double-click on the PID 21 transport packet icon, as shown in Figure 2–21.

Figure 2–21: Double-click on the PID 21 icon

The analyzer opens a window similar to Figure 2–22.

Figure 2–22: Interpreted view of the first PID 21 transport packet
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You can search for errors and get additional information about the fields and
field values just as you did with the transport packet at the TS level. The
difference is that now you are looking at only the packets of PID 21, which
contain PMT sections describing program one.

3. Click the Last command button in the lower toolbar to go to the last PID 21
packet in the transport stream (if you have forgotten which button to use,
move the cursor slowly over all buttons in the lower toolbar while watching
the messages in the status bar, immediately below). Notice—by looking at
the item data near the top of the window as shown in Figure 2–23—that
there are only 14 transport packets of the 9300 in the SAMPLE.TRP stream
that are identified with PID 21.

Item data

Figure 2–23: The last PID 21 packet in SAMPLE.TRP

By the way, the item position is the number of the first byte in the packet relative
to the beginning (byte 0) of the transport stream file. In other words, there are
1625260 bytes in the file (and stream) before this packet.

As with the TS interpreted view, you can open a hexadecimal view of the packet
through the Add View command button. Another way to look at the packets is in
a binary view.

1. Click on the Add View button as shown in Figure 2–24.

Figure 2–24: The View Type submenu

2. Select Binary from the View Type submenu. The analyzer opens a window
similar to Figure 2–25.

Notice that the first eight-bit byte, which corresponds to the sync byte (see
the interpreted view in Figure 2–22), is 01000111. Not surprisingly, this is
the binary equivalent of 71 decimal and 0x47 hex. The next three bits
correspond to the following three packet fields, and the 13 bits after that (to
the end of the third byte) correspond to the PID. Sure enough,
00000 00010101 equals 21 decimal.
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Figure 2–25: The binary view of PID 21 item 14

3. Close the PID 21 interpreted and binary view windows before you proceed.

Additional Information from the PAT Icon
The PAT icon represents PAT (Program Association Table) sections. PAT
sections are always contained in PID 0 transport packets.

1. Click on the hierarchic view PAT icon with the right mouse button. Hold the
button down to reveal the shortcut menu, as shown in Figure 2–26.

Figure 2–26: The PAT icon shortcut menu

2. Choose Section from the shortcut menu to open an interpreted view of the
PAT (Program Association Table). The window resembles Figure 2–27.

NOTE. You can also open the same interpreted view simply by double-clicking on
the PAT icon.
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Item data

Header fields

Program 0
information

Section CRC

Program 1
information

Figure 2–27: The PAT section interpreted view

You can do all the same things at the PAT section level that you can at the
transport packet level. You can search for errors, get information on the fields
and field values, and scroll among the PAT sections contained in the stream.

3. Close this window before you proceed.

The analyzer automatically calculates and checks the CRC of the first PAT
section when opening a transport stream file. Select the second PAT shortcut
menu command, Check CRC, to calculate the CRC (cyclic redundancy code) of
every PAT section in the stream and compare it to the number coded into the
section’s CRC field.

4. Click on the PAT icon with the right mouse button and hold the button down
to show the PAT shortcut menu. Highlight the Check CRC command and
release the button. If no erroneous CRCs are found, the analyzer creates the
dialog box shown in Figure 2–28.

Figure 2–28: The CRC Analysis dialog box

5. Click OK to close the dialog box and then close the PAT interpreted view to
continue with the tutorial.
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Additional Information from the PMT Icon
The PMT (Program Map Table) icon, like all others in the hierarchic view, has
its own shortcut menu. As with most other icons, you can double-click on the
PMT icon to open an interpreted view of PMT sections.

1. Click on the PMT icon with the right mouse button and hold the button
down to take a look at the PMT shortcut menu, as shown in Figure 2–29.

Figure 2–29: The PMT shortcut menu

2. Choose Section from the menu or release the right mouse button and
double-click with the left button to open an  interpreted view similar to
Figure 2–30.

Figure 2–30: The PMT interpreted view

Section
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Perform a Syntax Analysis on this PMT section.

1. From the Analysis menu choose Syntaxic, as shown in Figure 2–31.

Figure 2–31: Choosing Syntaxic from the Analysis menu

Syntax analysis checks all PMT sections in the stream for errors and variations
from the standard. It searches for errors that are within the PMT itself and
relative to the other tables (NIT and SDT for example). The example does not
have any PMT syntax errors, as shown in Figure 2–32.

Figure 2–32: The Syntax Analysis message window

2. Click OK to close the Syntax Analysis message window.

Now, the fact that no syntax errors were found in any of the PMT sections does
not guarantee that there are no such errors in the entire stream. Let’s widen the
search.

3. Click anywhere on the hierarchic view window to select it. (Or minimize the
PMT interpreted view window; the remaining, hierarchic view window is
then automatically selected.)

4. Once again, choose Syntaxic from the Analysis menu. This time, the
analyzer searches the entire stream for errors. If it finds any (and it does in
SAMPLE.TRP), it opens a window similar to Figure 2–33.

Syntax Analysis



Tutorial: Analyze a Signal

Tektronix MPEG Test System User Manual 2–25

Figure 2–33: A message window listing syntax errors

Each line in the message window represents one syntax error. You can double-
click on a line to open an interpreted view of the item that contains the error.
Notice that in this case all errors are in one PES packet. Let’s wait until the
discussion of the PES icon to talk about these errors.

5. Close the syntax error message window before you proceed.

You can check the CRCs in all PMT sections through the shortcut menu just as
you did with the PAT sections.

You can also check every CRC in the transport stream just like you checked the
syntax of all items in the stream:

1. Select the hierarchic view again.

2. Choose Check CRC from the Analysis menu, as shown in Figure 2–34.

Figure 2–34: Choosing Check CRC from the Analysis menu

If CRC errors are found, the analyzer lists the errors in a window similar to
Figure 2–33. Because SAMPLE.TRP contains no CRC errors, however, the
analyzer displays the message window shown in Figure 2–35.

Check CRC
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Figure 2–35: CRCs in all sections are correct

3. Click OK (or press Enter) to dismiss the CRC analysis message window and
close the interpreted view window before proceeding.

PCR (Program Clock Reference) analysis allows you to see a graphical
representation of the PCRs versus time.

1. Click on the PMT icon with the right mouse button and hold the button
down to open the PMT shortcut menu, as shown in Figure 2–36.

Figure 2–36: The PMT shortcut menu

2. Choose PCR Analysis from the menu to open a PCR diagram window
similar to Figure 2–37. This diagram shows the first ten clocks in the
program.

Figure 2–37: The PCR analysis display

PCR Analysis
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3. Double-click on the third clock icon. This brings up the PCR value window
as shown in Figure 2–38.

Figure 2–38: Double-click on the clock icon to list clock values

You can also display the values of all of ten diagrammed PCRs at once.

4. Click the Add View command button in the upper toolbar.

5. Choose PCR Values from the View type submenu, as shown in Figure 2–39.
The analyzer creates a window, similar to Figure 2–40, that lists the values
for all ten PCRs in the diagram.

Figure 2–39: The PCR View Type submenu
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Figure 2–40: The PCR values display

You can navigate among the program PCRs with the command buttons on the
lower toolbar.

6. Click the Next command button to show the values of the next ten PCRs
(numbers 11 through 20) in the stream.

7. Select the PCR diagram window again—the window title says: PCR of
SAMPLE.TRP (PID 50, Program 1):1—and notice that the diagram also
shows PCRs 11 through 20.

8. Close all windows except the hierarchic view before continuing with the
tutorial.

T-STD analysis checks the selected program against the (transport stream system
target) decoder model that is defined in the MPEG-2 standard.

1. Select the Options menu and make sure that Visual TSTD and LTW is
selected as shown in Figure 2–41.

Figure 2–41: Visual TSTD and LTW selected

2. Choose T-STD Analysis from the PMT shortcut menu, as shown in
Figure 2–42.

T-STD Analysis
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Figure 2–42: Choosing T-STD Analysis from the shortcut menu

Because visual mode is selected, the analyzer opens a Buffering Simulation
window similar to Figure 2–43. The window contains dynamic bar graphs of the
video, audio, and system buffers; the graphs show how full each buffer is at a
given point in decoding and change color from blue to yellow to red as buffer
overflow approaches and occurs. Notice that the simulation is not real-time and
may take several minutes. If you have the time, do watch to see what happens, as
SAMPLE.TRP will cause buffer overflows and have errors to report when the
simulation in done.

Figure 2–43: The T-STD Buffering Simulation window

3. If you don’t have the time to let the simulation finish on its own, click the
Abort button in the lower-right of the simulation window. The simulation
pauses and you can choose to resume analysis or close the window.

Buffer overflows occur near the end of SAMPLE.TRP, and the analyzer opens
the window shown in Figure 2–44. Each line of text in the window represents
one error. As the analyzer discovers additional errors, it adds them  to the bottom
of the list. At the end of analysis, all activity in the Buffer Simulation window
stops.
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Figure 2–44: The T-STD error list

4. Close all windows except the hierarchic view before continuing with the
tutorial.

Additional Information from the PES Packet Icon
The PES (Packetized Elementary Stream) packet icon represents all packets that,
together, contain a given elementary stream. Individual PES packets are
assembled from the payloads of several transport packets. You can learn more
about the PES packets and their PTS/DTS (Presentation and Decode Time
Stamps) through this icon.

1. Click on the PID 50 PES icon with the right mouse button and hold the
button down to take a look at the PES shortcut menu, as shown in Fig-
ure 2–45.

Figure 2–45: The drop-down menu for the PES icon

2. Choose PES Packets from the menu (or release the right mouse button and
double-click with the left button) to open an  interpreted view similar to
Figure 2–46.

Notice that the item data (near the top of the window) now includes a Time:
entry. This is the time that the first byte of the packet appears in the transport
stream, relative to the beginning of the stream. The time is included in all
interpreted views that you open after performing an analysis that involve a
multiplex rate calculation. Both the PCR analysis and the T-STD analysis,
performed while looking at the PMT icon, involve a “mux rate” calculation.

Interpreted View
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Figure 2–46: The PES packet interpreted view

This interpreted view offers all of the same options as were given in the previous
discussions. Remember the syntax errors the analyzer reported when you
performed a “Syntaxic” analysis of the entire stream? They are in a PID 50 PES
packet.

3. Click the Next Error button on the lower toolbar. The program checks each
packet in the stream for errors. If it finds an error, it automatically jumps to
the transport packet containing the error. There are several errors in the last
PID 50 PES packet in SAMPLE.TRP, as shown in Figure 2–47. The errors
are highlighted in red on the MTS 210 display.

Figure 2–47: The PES Packet with the errors circled

You can find out more about any error by double-clicking on the field name and
its value.
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4. Double-click on the “packet start code prefix” box, as shown in Figure 2–48,
to learn more about the field.

Figure 2–48: Double-click for information about the field

5. Read about the field and then click on the field box once to dismiss the
message window.

6. Double-click on the field, as shown in Figure 2–49, to  reveal the value
help/error message.

Figure 2–49: Double-click for information for the field value

7. Close the interpreted view window.

PTS/DTS analysis extracts the presentation and decode time stamps embedded in
the elementary stream and shows their relative time positions in a graphical
display window. Through this display, you can check that all of the time stamps
“make sense” (PTS must be later than DTS, and both must be after the
associated data arrives) and check for the existence of B fields, which have no
DTS.

1. Click on the PID 50 PES icon with the right mouse button and hold the
button down to open the PES packet shortcut menu, as shown in
Figure 2–50.

PTS/DTS
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Figure 2–50: The PID 50 PES shortcut menu

2. Highlight PTS/DTS and release the button. This opens a window containing
a diagram of the first four PTS/DTS “events” in the elementary stream, as
shown in Figure 2–51.

Figure 2–51: The PTS/DTS diagram

NOTE. The diagram in Figure 2–51 reveals some errors in the SAMPLE.TRP
PID 50 elementary stream:

� Three of the arrival times do not coincide with the start of the associated
access unit.

� Two of the PTS/DTS events involve more than one access unit.

Both of these errors suggest problems in the encoding process. See Figure 2–52
for an example of a diagram from a correctly encoded stream.
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Figure 2–52: PTS/DTS diagram from a correctly encoded stream

Table 2–3 lists and explains the icons used in the PTS/DTS diagram.

Table 2–3: PTS/DTS graphic view icons 

Icon Represents Double-click for

PCR (program clock reference) Value
Location in transport stream (TS packet number)

Arrival time of the PTS/DTS Value
Time since the previous PTS/DTS arrived
Location in elementary stream (PES packet number)

DTS (decode time stamp) Value
Location in elementary stream (PES packet number)

PTS (presentation time stamp) Value
Location in elementary stream (PES packet number)

AU (access unit) Begin time
End time
Size in bytes
Type of frame (intra, predicted, or bidirection)
Reference time

The example timing diagram illustrates several features of a correctly encoded
MPEG-2 video stream:

� Access units arrive one after another, as you can see from the left (“early”)
side of the diagram.

� The order of access unit decoding and presentation is visible in the right
(later) portion of the diagram.
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� Intra (I) and predicted (P) pictures must be decoded before presentation and
therefore have both DTS and PTS. B (bidirection) frames are decoded and
presented at the same time and therefore have only presentation time stamps.

� B frames use information in an associated P frame; the P frame must be
decoded before the B frame(s), but is presented after. In the example, then,
the order of frame decoding is IPBB, but the order of presentation is IBBP.

As the Table 2–3 heading indicates, you can get more information about the
various objects in the diagram by double-clicking on the icon.

3. Double-click on the first arrival icon to reveal its values, as shown in
Figure 2–53.

Figure 2–53: Information about the first arrival time

4. Click within the PTS/DTS diagram window, but outside of the Arrived value
window, to dismiss the value window.

5. Double-click on the first AU icon, as shown in Figure 2–54, to learn more
about the access unit.
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Figure 2–54: Information about the first access unit

Just as you did with interpreted views, you can navigate among the time stamps
of an elementary stream with the lower toolbar command buttons (and the
equivalent commands in the Edit menu).

6. If you wish, experiment using the lower toolbar command buttons to move
among all the time stamps in the elementary stream (or at least the part of the
stream that was saved in SAMPLE.TRP).

7. When you are ready, close all windows but the hierarchic view of
SAMPLE.TRP and continue with the tutorial.

Viewing PSI/SI Data
1. If possible, open a DVB (Digital Video Broadcast) transport stream file. If

you do not have such a file available, continue with the original file,
SAMPLE.TRP.

2. Select the Options menu and choose DVB if it isn’t already check-marked
(✓ ), as shown in Figure 2–55.

Figure 2–55: The check mark indicates that DVB is selected
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3. Select the hierarchic view, if necessary, and then choose PSI/SI from the
Selection menu. The dialog box shown in Figure 2–56 appears.

Figure 2–56: The PSI/SI Selection dialog box

NOTE. Annuler is the Cancel button for this dialog box.

4. Click NIT as shown in Figure 2–56.

5. Click OK to open an interpreted view of the first NIT section in the stream
as shown in Figure 2–57. The exact appearance of the view will depend on
the configuration of your particular DVB stream.

NOTE. You can also open this view by double-clicking on the NIT icon or by
selecting Section from the icon shortcut menu.

Figure 2–57: The NIT section interpreted view
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6. Double-click on a descriptor field, if the NIT contains them, as shown in
Figure 2–58. The resulting descriptor message box contains an ASCII
decode of the network information associated with the transport stream.

Figure 2–58: Double-click for an ASCII decode of the descriptor

You can use the same technique to view descriptor information in any DVB table
in the stream.

7. Close the NIT section window.

Automatic Analysis
In the course of this tutorial, you have used the MPEG-2 System Analyzer to
perform several kinds of analysis on various stream elements. The analyzer also
has an automatic analysis feature that simplifies evaluation of the entire transport
stream, yet still permits detailed analysis of many types of error.

The following procedure assumes that you still have the hierarchic view of
SAMPLE.TRP open on your MTS 210 display. If you closed that window to
view a DVB stream in the last section of this tutorial, open SAMPLE.TRP again
before you continue.

1. Choose Automatic analysis from the Options menu. The dialog box shown
in Figure 2–59 appears.



Tutorial: Analyze a Signal

Tektronix MPEG Test System User Manual 2–39

Figure 2–59: The automatic analysis Options dialog box

2. By default, automatic analysis includes all the listed tests. Automatic
analysis takes several seconds to several minutes, depending on the size and
complexity of the file, speed of your MTS 210, and the number and type of
analyses selected through this dialog box. Dynamic analysis, the last
selection in the dialog box, takes much longer than all other tests combined.
If you are following this exercise to familiarize yourself with the analyzer,
click on the Dynamic check-box to de-select Dynamic analysis.

NOTE. The MPEG-2 System Analyzer can conduct three kinds of Dynamic
analysis: T-STD (transport stream target decoder), LTW (legal time window),
and Smoothing Buffer. Automatic analysis includes only T-STD analysis; the
remaining dynamic analyses must be performed manually. Refer to the Reference
section of this manual for more information about Dynamic analysis.

3. Choose OK to confirm the selections and close the dialog box.

4. Choose Automatic from the Analysis menu. The window shown in
Figure 2–60 appears. This Automatic analysis window contains a table that
shows the progress and results of the various tests. As the analysis sequence
proceeds, cells in the Status column change from blank to Running to
Completed. As each test is completed, either OK or Errors (in red) appears in
the corresponding Result cell, depending on the results of the analysis.

If you wish to end the analysis at any time, click Abort after current task, at
the bottom of the window.
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Figure 2–60: The automatic analysis window

5. When all analyses are complete, the Automatic analysis window provides
access to detailed information about each detected error. For a list of the
syntax errors in SAMPLE.TRP, for example, double-click in the Syntaxic
Result cell, as shown in Figure 2–61. A window that lists the errors appears
in the Analyzer application window; the window listing the syntax errors in
SAMPLE.TRP is similar to Figure 2–62.

Figure 2–61: Double-click for error details
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Figure 2–62: The list of syntax errors found in SAMPLE.TRP

Double-clicking on a listed syntax, PCR, PTS/DTS, or semantic error leads to
even more information about the error.

6. Double-click on a syntax error, as shown in Figure 2–62, to open a window
resembling Figure 2–63. This window contains an interpreted view of the
section (in this case, a PES packet) that contains the error. Red characters (on
the PC monitor) indicate syntax errors.

Figure 2–63: Interpreted view of a PES packet with syntax errors
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This is a good opportunity to review some of the techniques you can use to learn
more from an interpreted view.

� Each “block” in the interpreted view represents a field of data. The field
value (or number of bytes in a data field) appears below the field name. Press
the F2 key to toggle the value between decimal base and hexadecimal base.

� Double-click on a field name for more information about the field.

� Double-click on a data field name to add a byte-by-byte hexadecimal view of
the interpreted view.
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� Double-click on the field value/size to reveal additional information about
the value and error, if any.

7. Return to step 5 and double-click in the remaining “Error” results cells. The
type of display and information available is the same as when the individual
analysis is conducted manually (by selecting it from the Analysis menu).
Refer to the Reference section for more information about each type of
analysis.

Quitting the Analyzer
This completes the tutorial for the MPEG-2 System Analyzer. Exit the applica-
tion by choosing Exit  from the File menu.
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Tutorial: Creating an MPEG-2 Transport Stream

This section explains how to create an MPEG-2 transport stream. First, you will
make a simple transport stream file, then a significantly more complex one.
Finally, this section gives a brief introduction of how to send the signal that you
created out one of the ports on the MTS 210 rear panel as an actual transport
stream. There is an optional tutorial following this one that explains how to build
a transport stream file that contains DVB (Digital Video Broadcast) information.

This section steps you through the Multiplexer, Edit Table, and Disk Manager
applications. These procedures are “step-by-step,” so you can follow along with
your own instrument. You will use files provided with the MTS 210.

NOTE. To aid in following along with your own MTS 210, all steps requiring
action are numbered.

Terms
There are two specific terms used in this section that are not interchangeable:
transport stream and transport stream file.

A transport stream is the signal that comes out (or in) one of the connectors on
the rear panel of the MTS 210.

A transport stream file is a file on a disk. When the MTS 210 sends this file out
one of the rear-panel connectors (properly timed), it becomes a transport stream.

Start the Multiplexer
Click on the Multiplexer name in the Tektronix MPEG Test System submenu.
This starts the Multiplexer application as shown in Figure 2–64.
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Status bar

Menu bar

Tool bar

Title bar

Figure 2–64: The Multiplexer application window

Making a Simple Transport Stream File
1. Choose New from the File menu or the New command button from the tool

bar. This results in the New configuration file box shown in Figure 2–65.

Figure 2–65: The New configuration file dialog box
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Notice that you are not going to make a transport stream file right away, but
rather a configuration file. Since transport stream files can be huge, they are not
generated immediately. Instead, configuration files (*.cfg) are created first. These
contain all of the information required to make the transport stream. (For more
information on how they work, please see File Conventions, beginning on
page 3–59.)

2. Enter the name “simple” in the File Name text box (the *.cfg extension is
added automatically).

3. Choose OK. The Multiplexer application now displays the default configura-
tion file. (See Figure 2–66.)

Duration gauge

Rate gauge

Multiplex window

Figure 2–66: The default configuration in the application window

The Multiplex application window has three parts: the Duration gauge, the Rate
gauge, and the Multiplex window.

The Duration gauge gives the status of the multiplex operation. The gauge sits at
0% until you tell the application to create the transport stream file. Since this
process often takes some time, the Duration gauge tells what percentage of the
operation is complete.
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The Rate gauge shows the percentage of the available transport stream currently
used. Above the rate gauge bar the target multiplex rate. Below the rate gauge is
the amount currently in use, the actual rate. The actual rate is calculated with the
following formula:

Rate = PSI rate + SI rate + Video rate + Audio rate + Data rate

Below the actual rate is the time period when the highest multiplex rate occurs.

The Multiplex window displays the current configuration file in hierarchic form.
Several icons appear in the Multiplex window to represent specific elements of
the transport stream multiplex. Table 2–4 explains these icons.

Table 2–4: The icons in the multiplexer hierarchic view 

Icon Meaning

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Multiplex — the main icon for the configuration file.

Required.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Program Specific Information (PSI) — contains the data that allows the
demultiplexing of the programs by decoders.

Required.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Program Association Table (PAT) — This is the main PSI table. It links the
program numbers and the Program Map Table (PMT) PID.

Every transport stream must have a PAT that is always PID0. This table is
required to identify the PID numbers for the table(s) defining each program.

Required.ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Program Map Table (PMT) — Specifies the PID values and describes the
program components.

There is a PMT for every program in the transport stream. The table states the
PID for each elementary stream associated with a specific program. There are
no specific PID values for PMTs, however certain transmission systems (such
as Grand Alliance and DVB) require specific values.

Required.
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Service Information (SI) — provides information on services and events carried
by different multiplexes or even on other networks. It has up to four tables below
it: NIT, BAT, SDT, and EIT.

Required if using DVB.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Network Information Table (NIT) — provides information about the physical
network.

Required. It is found under PSI if not in DVB mode and under SI if in DVB
mode.
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Table 2–4: The icons in the multiplexer hierarchic view (Cont.)

Icon Meaning
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Bouquet Association Table (BAT) — provides information regarding bouquets (a
collection of services marketed as a single entity).

Optional (for DVB).
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Service Description Table (SDT) — contains data describing the services in the
system, for example, names of services, the service provider, etc.

Optional (for DVB).
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Event Information Table (EIT) — contains data concerning events and programs
(a concatenation of one or more events under the control of a broadcaster),
such as event name, start time, duration, etc.

Optional (for DVB).
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Program 

Required — Each transport stream is required to have at least one program with
one elementary stream.
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Video Elementary Stream 

Optional (must be at least one elementary stream in the program).

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Audio Elementary Stream 

Optional (must be at least one elementary stream in the program).

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Data Elementary Stream

Optional (must be at least one elementary stream in the program).

The simplest transport stream possible would have one program with one
elementary stream in it. In this example, you will put two elementary streams in
one program.

Add an elementary stream to program 1.

1.  Select the program 1 icon.

2. Click the Add (+) command from the tool bar (or choose the Add command
from the Edit menu). This opens the dialog box shown in Figure 2–67.

Add Elementary Streams
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Figure 2–67: The Stream to Add dialog box

3. Select the Video option button and click OK (you will eventually add one
elementary stream of each type). This adds a Video icon to program 1 as
shown in Figure 2–68.

Figure 2–68: The hierarchy with a video icon added to program 1

4. Repeat this procedure (click the Add button, select a type of stream, and
click OK) twice to add an Audio icon and a Data icon to the hierarchy. The
application window resembles Figure 2–69 when you are done.
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Figure 2–69: The hierarchy with the audio and data icons added

Next, associate elementary stream files with the video, audio, and data icons.

5. Double-click on the video icon. This opens the Video Stream dialog box
shown in Figure 2–70.

Figure 2–70: The Video Stream dialog box
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6. Click the Browse button. This allows you to select a video elementary
stream from existing files throught the Video Stream Selection dialog box.
(See Figure 2–71.)

Figure 2–71: The Video Stream Selection dialog box

7. Select c:\mts100\video\625\MOBL_060.MP2, as shown in Figure 2–71.

8. Click OK.

NOTE. The List Files of Type box in the Video Stream Selection dialog box does
not specify the .mp2 file extension. However, you may not select “just any file”
for use as a video elementary stream file. If you select an unacceptable file, you
will see the message box shown in Figure 2–72.

Figure 2–72: Click OK and select another (.mp2) file

All the information about the video elementary stream file loads automatically
into the Video Stream dialog box, as shown in Figure 2–73.
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Figure 2–73: Details of the selected video elementary stream

Only four parameters (Elementary Stream Rate, PES Packet Size, Elementary
Stream Initial Delay, and Offset DTS) are editable. If you would like more
information on these fields, please refer to Selecting a Video Stream, beginning
on page 3–91 of this manual.

9. Click OK to accept the settings and close the dialog box. The lower portion
of the Multiplexer application window now resembles Figure 2–74. Notice
that mobl_060.mp2 is now associated with the video icon. Note too, that the
Multiplex Rate gauge is beginning to fill.



Tutorial: Creating an MPEG-2 Transport Stream

2–54 Tektronix MPEG Test System User Manual

Figure 2–74: The display after a video file is associated

Now associate an Audio elementary stream file with the Audio icon.

10. Double-click on the audio icon. This opens the Audio Stream dialog box
shown in Figure 2–75.

Figure 2–75: The Audio Stream dialog box
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11. Click the Browse button to open the Audio Stream Selection dialog box
shown in Figure 2–76.

Figure 2–76: The Audio Stream Selection dialog box

12. Select c:\mts100\audio\10KHZ.MP2.

13. Choose OK. This returns you to the Audio Stream dialog box with all the
information about the 10KHZ.MP2 file entered, as shown in Figure 2–77.

Figure 2–77: Details of the selected audio elementary stream
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Just like the Video Stream dialog box, the Audio Stream dialog box allows you
to edit only the parameters near the bottom of the dialog box. (Learn more about
these parameters under Selecting an Audio Stream, on page 3–93 of this manual.)
The default parameters are acceptable for the current application.

14. Click OK to select the settings and close the dialog box. This returns you to
the hierarchic display of the configuration file as shown in Figure 2–78.

Figure 2–78: The display after an audio file is associated

Notice that 10KHZ.MP2 is now associated with the Audio Icon and the
Multiplexer Rate gauge is now a little closer to full with the addition of the audio
stream.

You would follow a similar procedure to associate a file with the Data icon.

15. Double-click on the Data icon to open the Data Stream dialog box as shown
in Figure 2–79.
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Figure 2–79: The Data Stream dialog box

Notice that this dialog box does not have as much information in it as the Video
Stream and Audio Stream dialog boxes. This is because it does not require
elementary streams — a file of any type is acceptable.

16. Click Cancel to close this dialog box without entering a file.

17. Select the Data icon again. This time you will delete it.

18. Choose either the Delete (–) command button from the tool bar or Delete
from the Edit menu and click Yes when the dialog box shown in Figure 2–80
appears. The hierarchy now resembles Figure 2–81.

Figure 2–80: Click Yes to delete the data stream icon
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Figure 2–81: The hierarchy with the Data icon deleted

19. Choose Save from the File menu to save the configuration file.
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You are ready to create a transport stream file.

1. Choose Go from the Multiplex menu, or Go from the tool bar. The Multiplex
Output File dialog box appears as shown in Figure 2–82.

Figure 2–82: The Multiplex Output File dialog box

NOTE. The transport stream files can be large. Make sure you have adequate
space on the selected drive before beginning.

You can create the transport stream file directly on the Data Store Board hard
drives by placing the Multiplex Output file in either c:\carb0\mono or
c:\carb0\loop.

Notice that the current configuration file name becomes the default transport
stream file name (with the file name extension changed to .trp).

2. Choose OK to begin creating the simple.trp transport stream file in the
default directory (c:\mts100\cfg-trp). As the MTS 210 generates the transport
stream file, the Duration gauge fills, showing the status of the operation.
When generation is complete, the gauge reads 100% and the Information
message box appears to indicate that the Transport Stream has been
multiplexed.

3. Click OK to continue. The multiplex display resembles Figure 2–83.

Create the Transport
Stream File
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Figure 2–83: Transport stream creation is complete

You have now successfully created an simple transport stream file. Next you will
make a more complex transport stream file.

Making a Complex Transport Stream File
Now you are going to add to simple.cfg file to create complex.cfg, a more
complicated configuration file. Start at the point where you left off (as shown in
Figure 2–83) from the previous steps.

1. Choose Save As from the File menu. The standard Windows Save As dialog
box appears.

2. Enter “complex” in the File Name text box.

3. Choose OK. This saves the information in simple.cfg to a new configuration
file called complex.cfg, creates a new .pmt file (called complex.pmt), and
places the name “complex” in the window title. (Notice that the Duration
gauge has also reset itself to 0%.)
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Now you are going to add two additional programs.

1. Select the MUX (engine and tender) icon.

2. Choose Add from the Edit menu or the tool bar. This creates program 2.

3. Choose Add a second time to create program 3. Figure 2–84 shows the
resulting hierarchy.

Figure 2–84: The hierarchy with programs 2 and 3 added

NOTE. The configuration file can accept up to 20 programs.

4. Follow the procedures given on pages 2–49 to 2–58 to add the
c:\mts100\video\625\testpat\100B_015.MP2 video elementary stream and
the c:\mts100\audio\10KHZ.MP2 audio elementary stream to program 2.

NOTE. Each program can accept up to 10 elementary streams, with a maximum
of 5 of any one type.

The lower portion of the resulting application window looks like Figure 2–85.
Notice the Multiplex Rate gauge is at 85% and is yellow after adding the video
and audio streams to program 2. This is just an indication that the transport
stream is beginning to get full.

Add More Programs
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Figure 2–85: Elementary streams added to program 2

5. Add the same video and audio elementary stream files to program 3. The
same part of the application window now resembles Figure 2–86.

Figure 2–86: The rate gauge shows an overflowed multiplex

Notice that the rate gauge reads 100% and is now red on the MTS 210 display.
Also notice that the rate reported at the bottom of the gauge is greater than the
specified maximum rate at the top. If you multiplex the stream now, you risk
losing data.

Now change the view from hierarchic to dynamic.

6. From the View menu, choose Dynamic, or choose Dynamic from the tool
bar. This results in Figure 2–87.
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Next

Program bars

Multiplex global start time Estimated stop time

Timing cursor

Previous

Figure 2–87: The dynamic view of the complex.cfg configuration file

This view shows the timing relationships between the programs. (For more
information, please see The Dynamic View, on page 3–71 of this manual.)

Next you are going to change to program start time for programs 2 and 3 so the
multiplex rate drops to an acceptable level.

1. Return to the hierarchic view by choosing the Hierarchy command button
from the tool bar.

2. Double-click on the program 2 PROG icon. This results in the dialog box
shown in Figure 2–88.

Changing a Program’s
Starting Time
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Figure 2–88: The Program Parameters dialog box for program 2

You need to enter a number in the Program Start Delay text box that will make
program 2 start after program 1. Referring to Figure 2–87, you can see that the
estimated stop time for all programs is now 15.0 seconds.

3. Enter “15.2” in the program start delay text box.

4. Click OK. The rate gauge drops and turns yellow.

5. Repeat for program 3. Notice that the rate gauge now shows 67% and is
again in the green range.

6. Now go to the Dynamic view, shown in Figure 2–89, to see the new timing
relationship between the programs.

Figure 2–89: The dynamic view after you delay programs 2 and 3
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See that programs 2 and 3 do not begin until program 1 ends, but also notice that
the resulting transport stream now takes longer (look at the Estimated Stop
Time). Use the left mouse button to click and drag the timing cursor to the right
and left. Once the timing cursor is selected, you can also move it 0.01 second at
a time with the the left and right arrow keys.

7. Move the timing cursor into the area with only program 2 and 3 in it. Notice
that the Multiplex Rate drops even lower (Figure 2–90.)

Timing cursor

Figure 2–90: Moving the timing cursor

8. For practice, see if you can move the timing cursor to the space between the
end of program 1 and the beginning of programs 2 and 3 (Figure 2–91). Use
the left and right arrow keys for fine cursor movement.



Tutorial: Creating an MPEG-2 Transport Stream

2–66 Tektronix MPEG Test System User Manual

Figure 2–91: The timing cursor is in the space between the programs

9. Return to the hierarchic view.

Now you can “customize” the header information for the transport stream file.
Double-click on the various header information icons in order to customize
them.

PSI. The PSI contains Program Specific Information.

1. Double-click on the PSI Icon. This opens the PSI Period dialog box. (See
Figure 2–92.)

Figure 2–92: The default PSI Period dialog box

This dialog box allows you to change how often the PSI (Program Specific
Information) appears in the stream. In this example, you want to send the PSI
information more often than the default, so you must decrease the period.

2. Enter 0.01 in the text box (Figure 2–93).

Customizing the Header
Information
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Figure 2–93: The PSI period is changed to 0.01 seconds

3. Click OK.

Notice the affect of the new PSI period on the hierarchic view and the multiplex
rate (Figure 2–94). First, the new period is displayed after the PSI icon in the
hierarchy; second, this action used an additional 3% of the available multiplex
space as shown in the rate gauge.

Increased the
Multiplex Rate

by 3%

Changed the PSI period

Figure 2–94: The configuration file after changing the PSI period

PAT. The PAT is the Program Association Table. It lists the PIDs for the Header
Tables. In this case, it includes the PMTs (one for each program) and NIT.
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1. Double-click on the PAT icon. This brings up the Program Specific
Information dialog box as shown in Figure 2–95. This dialog box allows you
to change the PID numbers of the Network Information Table and/or the
Program Map Tables.

Figure 2–95: The Program Specific Information dialog box

2. Highlight NetWork Information Table, as shown in the illustration.

3. Click Modify to open the PID Modification dialog box as shown in
Figure 2–96. To change the PID, enter a new number in the text box. There
is no need to change the PID of the NIT in this example, however.

Figure 2–96: PID Modification dialog box

4. Close the PID Modification dialog box.

5. Close the Program Specific Information dialog box.
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PMT. The PMT (Program Map Table) contains all the specific information about
the programs in the transport stream file.

1. Double-click on the PMT icon. This automatically starts the Edit Table
Application with complex.pmt (the PMT for the complex.cfg configuration
file) loaded, as shown in Figure 2–97.

For more information about the Edit Table application, refer to Using the PSI
and SI Table Editor, beginning on page 3–103.

Elementary
streams

Program
number

Section
number

Figure 2–97: The Edit Table application with complex.pmt loaded

There are a few things to notice about this display before continuing.

� There is one section for each program and the current file has three pro-
grams.

� Section 1 of 3 is currently being displayed.

� There are two elementary streams (ES; one video and one audio) associated
with this program.
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NOTE. You can change the PCR PID (in the last text box of the right-hand
“Edit” window). The default is the first elementary stream in the program. If you
change it to a different value, and that value is not the PID of another elementa-
ry stream in the program, the PCRs will then reside in their own transport
packets. This should be done if the elementary stream that would carry the PCR
by default is not the longest elementary stream in the program.

Add some descriptors to section 2 of the PMT (program 2).

2. Display Section 2 by choosing either Next from the Section menu or Next
from the tool bar. (See Figure 2–98.)

Figure 2–98: Section 2 (program 2) of the PMT

3. Select the PMT icon.

4. Choose either Add from the Edit menu or “+” from the tool bar. This brings
up the Descriptors Selection dialog box. (See Figure 2–99.)
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Figure 2–99: The Descriptors Selection dialog box

5. Click on the List of Descriptors drop-down list to display the list of
descriptors available.

6. Add a registraton descriptor.

a. Select registration from the drop-down list.

b. Choose Add. This adds the descriptor to the Descriptors Selected list.

The dialog box now resembles Figure 2–100.

Figure 2–100: Registration selected

7. Choose OK to add the descriptor. This results in Figure 2–101.
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Figure 2–101: A registration descriptor added to PMT section 2

Check the information added in the descriptor.

8. Click on the descriptor icon. (See Figure 2–102.)

Figure 2–102: The information for the Video Stream descriptor field

Do not change any of the information.

Now add a video stream descriptor to the video elementary stream.

9. Select the PID 60 ES icon.
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10. Choose Add from the tool bar.

11. Select video_stream from the List of Descriptors.

12. Choose the Add command button to add it to the Descriptors Selected list.

13. Choose OK.

14. Click on the resulting descriptor icon to bring up the display shown in
Figure 2–103.

Figure 2–103: The descriptor at the Elementary Stream level

15. Choose Save from the File menu to save your work.

16. Exit the Edit Table application and return to the Multiplex application.
(Figure 2–104.)
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Figure 2–104: The complex.cfg after table editing

This gives only a small sample of the things that can be done to customize the
header information. Find additional information in both Using the PSI and SI
Table Editor (beginning on page 3–103) and Using the Multiplexer (beginning
on page 3–59), in the Reference section of this manual.
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You are ready to generate the complex transport stream file.

1. Choose Go from the Multiplex menu. (See Figure 2–105.)

Figure 2–105: The Multiplex Output File dialog box

2. Choose OK and begin the multiplex process.

When the multiplex is complete, the duration gauge reads 100% and the
following message appears.

3. Click OK; then exit the Multiplexer application.

In the next steps you will send the transport stream file out the 50 � TTL serial
port as a transport stream.

Sending a Transport Stream
To generate a transport stream (from a transport stream file) use the Data Store
Administrator application.

Select the Data Store Control icon on the Tektronix MPEG Test System
submenu to start the application.

Making the Complex.TRP
Transport Stream File
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Figure 2–106: The Data Store Administrator application window

Before you can send a transport stream file out as a transport stream, you must
first move it from where it is currently stored (in this case the system hard drive)
to the Data Store Disks.

NOTE. You can create transport stream files directly on the Data Store Disks and
skip moving the files to them. See more information in the Using the Multiplexer
section.

1. Choose PC to board (Write) from the File menu. (Figure 2–107)

Moving a File to the
Data Store Disks
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Figure 2–107: Find the command under the File menu

You get the File Write to CARB dialog box as shown in Figure 2–108.

Figure 2–108: The File Write to CARB dialog box

2. Choose the Browse command button to search for the COMPLEX.TRP file.
(See Figure 2–109.)

Figure 2–109: The Windows NT 4.0 Open dialog box
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3. Change the directory to c:\Mts100\Cfg-trp and select complex.trp.

4. Click Open. You return to the File Write to CARB dialog box with the name
of the PC file entered. It should now look like Figure 2–110.

Figure 2–110: The dialog box with a file selected

5. Choose Start. When the transfer is complete, the message box shown in
Figure 2–111 appears.

Figure 2–111: Click OK to acknowledge data transfer
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You are now ready to generate a transport stream from this transport stream file.

1. Choose Generation from the tool bar. Figure 2–112 shows the resulting
dialog box.

Figure 2–112: The Generation dialog box

NOTE. This dialog box is automatically filled in with the first file on the Data
Store Disks. If there are other files on your Data Store Disks, then complex.trp
may not initially appear in the CARB File field.

2. If complex.trp is not in the CARB File Field, select it from the drop-down
list.

3. Make sure that the Loop check box is not selected.

4. Select Master for Protocol.

5. Select TTL for Port. (This indicates that you are going to send the transport
stream out the 50 � TTL port.)

NOTE. You can only output a signal from one port at a time.

6. Set the Output Clock as PLL.

7. Enter 10,000,000 in the Frequency text box.

Generating a Transport
Stream
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NOTE. You must enter the correct output frequency. Transport stream files do
NOT carry any bit rate information so you must know the correct rate for the
transport stream file.

Figure 2–113 shows the resulting dialog box.

Figure 2–113: The dialog box with all parameters entered

8. Choose Start to begin the generation. Figure 2–114 shows the message box
displayed while generation occurs.

Figure 2–114: Transport stream generation in progress

If you have the 50 � TTL port connected to an oscilloscope you can observe the
transport stream. (It is only 32 seconds long.) The message box in Figure 2–115
tells when the transport stream generation is complete.
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Figure 2–115: Transport stream generation is finished

This completes the basic tutorial on creating and outputting a transport stream. If
you need additional information, please see the Using the Multiplexer, Using the
PSI and SI Table Editor, and Using the Data Store Administrator chapters in the
Reference section of this manual.
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Tutorial:
Creating Transport Stream Files with DVB Information

The tutorial in this section steps you through the procedures for adding DVB
information to a transport stream file. DVB information is optional since not all
systems require it.

This section is a continuation from the previous tutorial. It assumes that you
have completed the previous work and have the files created in the tutorial
available.

NOTE. To aid in following along with your own MTS 210, all steps requiring
action are numbered.

1. Open the Multiplexer application by clicking the Multiplexer name in the
Tektronix MPEG Test System program group.

2. Choose Open from the Multiplexer File menu.

3. Select complex.CFG.

4. Choose OK. This opens the previous configuration file and displays it in the
application window.

Now save the file under a new name.

5. Choose the Save As command from the File menu.

6. Type dvb in the File Name text box.

7. Choose OK.

Now add the basic DVB information.
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8. Choose DVB from the Options menu so that DVB is checked. This changes
the appearance of the hierarchy.

� The SI (Service Information) icon is added.

� The NIT (Network Information Table) icon moves to below the SI icon.

9. Double-click on the SI icon to open the DVB File Selection dialog box.

This dialog box allows you to add and edit the NIT, BAT (Bouquet Association
Table), SDT (Service Description Table), EIT (Event Information Table), and
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TDT (Time and Date Table) information to the transport stream file. The Browse
command buttons enable selection from currently existing files. Default files are
provided with the MTS 210 to save you time in creating your own DVB files.

Next, assign some default DVB files to the transport stream.

10. Click Browse in the NIT File section of the DVB Files Selection window.

11. Select DEFAULT.NIT in the Selection SI File dialog box.

12. Click OK to complete the file selection.

13. Click Browse in the BAT File section of the DVB Files Selection window.

14. Select DEFAULT.BAT in the Selection SI File dialog box and click OK to
complete the file selection.

15. Click Browse in the SDT File section of the DVB Files Selection window.

16. Select DEFAULT.SDT in the Selection SI File dialog box and click OK to
complete the file selection. A “stream ID” warning message appears. This
problem will be addressed later in the tutorial.

17. Click Yes to dismiss the warning and continue.

18. Click Browse in the EIT File section of the DVB Files Selection window.
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19. Select DEFAULT.EIT in the Selection SI File dialog box. Click OK to
complete the file selection. Again, the “stream ID” warning message
appears. This problem will also be addressed later in the tutorial.

20. Click Yes to continue.

21. Click OK in the DVB Files Selection dialog box. The hierarchic view now
includes icons for the tables you have added.

You will now edit the information in the individual DVB files.

22. Double-click on the NIT icon. This opens the NIT dialog box.
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23. Click Edit. This launches the Table Editor application with DEFAULT.NIT
open and ready to edit.

24. Select Coherence on the Edit Table Analysis menu or, better yet, click the A
command button on the tool bar. This runs a coherence analysis on the NIT.
A message window appears, listing the problems found in the table.
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25. To correct the first error listed in the message window, select “currently
applicable” from the current next indicator drop-down list.

26. Again select Coherence from the Edit Table Analysis menu or click the A
button on the tool bar to run the analysis again. Note that the messages
window now lists only one warning.

27. To clear this problem, you must add a descriptor that contains the network
name. Choose Add from the Edit Table Edit menu or click the + (Add)
command button. This displays the Add dialog box.
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28. Select Descriptor and click OK. This displays the Descriptors Selection
dialog box.

29. Select network_name from the drop-down list of descriptors.

30. Click Add and then click OK to complete the descriptor selection. The
descriptor icon is added to the right of the NIT icon in the Edit Table
application window.

31. Click on the “Netwo” descriptor icon.

32. Type Tektronix  in the name text box.

33. Select Save As from the Edit Table File menu.
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NOTE. Do not choose the Save command. Doing so would change the default
.NIT file. The default file is provided as a template to save you time when
creating new NIT files and should be kept as universally applicable as possible.

34. Type dvb in the file name box and click OK. The .NIT extension is added
automatically.

35. Select Exit from the Edit Table File menu. This should return you to the NIT
dialog box of the Multiplexer application. If the Edit Table application first
presents a Save Table dialog box, click Ignore (you have already saved
dvb.NIT).

36. Notice that the NIT dialog box still shows that DEFAULT.NIT is selected.
Click Browse and select dvb.NIT from the Selection SI File dialog box
(highlight dvb.NIT in the files list and click OK).

37. When the selection box closes, click OK in the NIT window to confirm the
file selection and dismiss the window. The NIT file associated with the
dvb.cfg configuration file is now dvb.NIT.

Next, edit the Bouquet Association Table (BAT).
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38. Double-click on the BAT icon to open the BAT dialog box.

39. Click Edit in the BAT dialog box. This starts the Table Editor application
with DEFAULT.BAT open for editing.

40. Click the Edit Table Analysis (A) command button  to run a coherence
analysis of the BAT.  Edit Table creates a message window that lists the
problems found in the table.
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41. The first warning line reveals that the value of the current next indicator field
is incorrect. To remedy this, select “currently applicable” from the current
next indicator drop-down list.

The second warning says the Bouquet Name descriptor is not present for this
subtable.

42. Click the Edit Table Add (+) command button to open the Add dialog box.

43. Select Descriptor and click OK. This displays the Descriptors Selection
dialog box.

44. Select bouquet_name from the drop-down List of Descriptors.
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45. Click Add, then OK to complete descriptor selection.

46. Again click the Edit Table A (analyze) command button. Note that there are
no more warnings.

47. Select Save As from the File menu.

NOTE. Do not choose the Save command. Doing so would change the default
.BAT file. The default file is provided as a template to save you time when
creating new BAT files and should be kept as universally applicable as possible.

48. Type dvb in the File Name text box and click OK. The table description is
saved as dvb.BAT.

49. Select Exit from the Edit Table File menu. This returns you to the BAT
dialog box of the Multiplexer application.

50. In the BAT dialog box, click Browse.

51. Select dvb.BAT from the Selection SI File dialog box (highlight dvb.BAT in
the files list and click OK).

52. Click OK in the BAT dialog box to accept the selection of dvb.BAT and
dismiss the box. This associates dvb.BAT with the BAT icon in the dvb.cfg
configuration file.

53. Double-click on the SDT icon to display the SDT dialog box.
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54. Click Edit in the SDT dialog box. This again starts the Table Editor
application, this time with DEFAULT.SDT open for editing.

55. If you run a coherence analysis on the SDT, you will find that the current
next indicator should be set to currently applicable (1), as it was for the NIT
and BAT. Change the current next indicator now.

56. Save the SDT as dvb.sdt (choose Save As from the Edit Table File menu,
type dvb, and click OK).

57. Exit the Edit Table application. Remember the error message that appeared
when you first added DEFAULT.SDT to the hierarchy? It’s back. Now,
however, you can discover the stream ID and add the information to
dvb.SDT to correct the error.

You can discover the transport stream ID from the PAT icon in the Multiplexer
hierarchy; unfortunately, you cannot scroll to view that icon until you close the
SDT window.

58. Click OK in the Error window to close it and click OK in the SDT window
to close it as well.
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59. Scroll the Multiplex window until you can see the PMT icon. Notice that the
transport stream ID is 1.

60. Scroll the SDT icon back into view and double-click it; then click Browse
and select dvb.SDT from the Selection SI File dialog box. You will again
receive the “different Stream ID” message.

61. Click Yes in the Warning message window; then click Edit in the SDT dialog
box.

62. When the Edit Table application window opens, change the SDT transport
stream ID to 1.

63. Choose Save and then Exit from the Edit Table File menu. Click OK in the
SDT dialog box. The transport stream ID Error message no longer appears.

You will now edit the EIT file.

64. Double-click on the EIT icon to open the EIT dialog box.

65. Click Edit in the EIT dialog box to start the Table Editor application.

66. Perform a coherence analysis as before (click the A command button).
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67. Notice that the Messages window contains three warnings and an error
message:

� The service id value is incorrect (Warning)

� The current next indicator should be “1” (Warning)

� The last table id value is incorrect (Warning and Error)

68. Change the current next indicator field to currently applicable, as you have
done in other tables.

69. Type 78 (the ID of this table) in the last table id text box.

70. The service id should be the same as the program id of the associated PMT.
Follow these steps to discover the program id:

a. Click the PMT command button on the Edit Table tool bar. The Table
dialog box appears.
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b. Click Open. The standard Windows Open dialog box appears. Open
c:\mts100\cfg-trp\dvb.PMT. The edit table workspace changes to show
the PMT and its values.

c. Notice that the program id of the first PMT section is 1.

d. Choose Close on the Edit Table File menu to close the PMT file and
return to the EIT display.

71. Type 1 into the service id text box.
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72. Perform a coherence analysis on the EIT to confirm that all reported errors
are corrected.

73. Recall that when you opened this file from the DVB Files Selection dialog
box you received the same Transport Stream ID error message as you did
with the SDT file. You will receive the same message again when you exit
the Edit Table application. Correct the error now by entering 1 in the
transport stream id text box.

74. Save the EIT as dvb.EIT and exit Edit Table. The Transport Stream ID error
message appears because DEFAULT.EIT is still selected.

75. Click OK to dismiss the error message and then click Browse in the EIT
dialog box to select dvb.EIT through the Selection SI File window. When
you are done, click OK to accept the selection and dismiss the EIT dialog
box.

The SI hierarchy should now look like this:
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76. Double-click on the SI icon to again open the DVB File Selection dialog
box.

You can enter the Time and Date Table (TDT) information directly through this
dialog box. Note, however, that the values for the TDT Starting Date and
Starting Time are grayed (and unavailable) until you select the TDT check-box in
the lower-right corner of the window.

77. Select the TDT option box in the lower-right corner of the DVB Files
Selection dialog box.

78. Type 12/31/1999 into the TDT Starting Date text box.

79. Type 01:00:00 in the TDT Starting Time text box.

80. Type 0.1 in the TDT Period text box. The TDT Period specifies how often
the time and date stamp is placed into the transport stream.
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81. Click OK. Notice that the Hierarchic view now shows a TDT icon.

82. Choose Save from the File menu or click the Save command button to save
all the changes to dvb.CFG.

This concludes the tutorial for creating an MPEG-2 transport stream file with
DVB information. Refer to Using the PSI and SI Table Editor, beginning on
page 3–103, for additional information about editing the various tables that have
been discussed in this section.
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Using the Analyzer

The MPEG-2 System Analyzer can examine MPEG-2/DVB binary streams on
the following three levels:

� Transport stream (TS)

� Elementary stream packets (PES packets)

� PSI (MPEG Program-Specific Information) and SI (DVB Service Informa-
tion) tables

The program is not designed to analyze the audio, video, or data contents of the
elementary streams, although you may extract and save the elementary streams
to separate files for use in other applications.

Overview
The three major functions of the Analyzer application are analysis, filtering, and
information extraction (saving streams and stream components).

The program can analyze several different aspects of the MPEG transport stream
and its embedded objects.

� Multiplex characteristics

� CRCs

� Syntax, or structure

� Consistency

� PSI/SI rate

� PCR

� PTS/DTS

� Semantics, or coherence among multiplexed components

� Dynamic T-STD, LTW, and smoothing buffer usage

For convenient one-step analysis of most aspects of all levels of the MPEG data
stream, you can also perform an Automatic Analysis.

The MPEG-2 System Analyzer filters enable finding and viewing transport
stream packets, PES packets, and PSI/SI table sections that meet up to four
criteria of your choosing. You can search for rare, significant, or troublesome
stream items on the basis of several characteristics:

Analysis

Filtering
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� Program ID (PID)

� The presence and value of of up to three selected packet or section fields

� A sequence of up to four bytes

� The presence of the start of an elementary stream access unit

Finally, the analyzer gives you the ability to extract information from the binary
stream and save it to a file for later use or analysis. This information includes the
following:

� Transport packets

� PES packets

� PSI and SI tables

� Elementary streams

Terms
There are two terms that are specific to the Analyzer application. They are
Hierarchic view and Interpreted view.

The Hierarchic view is a graphic representation of the MPEG transport stream
file that uses icons to show the interrelationship of stream components. See The
Hierarchic View, beginning on page 3–13, for a detailed explanation.

The Interpreted view shows the various fields that make up small sections of the
stream—or data (such as tables and elementary stream packets) embedded in it.

Saving Streams and
Stream Components
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The interpreted view shown below is of one 188-byte transport packet in the
SAMPLE.TRP binary stream; this view can be created by double-clicking on the
TS (engine and tender) icon in the Hierarchic view. Refer to The Interpreted
View, beginning on page 3–17, for a detailed explanation.

Analyzer Application Window
The analyzer application window appears on the Windows desktop when you
start the program.

 
Menu bar

Upper toolbar

Lower toolbar

Status bar
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All other Analyzer windows appear within the application window. The menu
bar is immediately below the window title and provides access to the various
Analyzer commands. The upper toolbar, immediately below the menu bar, and
the lower toolbar, below the application workspace, provide direct access to
commonly used menu commands. The status bar, on the bottom of the window,
displays information about the various menu commands and command buttons.

The Menu Bar provides access to the seven main Analyzer menus.

File Menu. The File menu controls the Analyzer/Disk interface. The commands in
this menu operate as in all Windows applications. See Opening a File, on
page 3–12, and Extracting and Saving Stream Elements, on page 3–53, for more
information about opening the various MTS 100 file types and saving transport
stream data to files.

Use To

Open Open an existing transport stream, packets, or PSI/SI file.

Save as Save the current selection to disk

Print Print the current view

Printer setup Change printer settings

Exit Quit the Analyzer application

Menu Bar
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Edit Menu. Use the Edit menu to navigate among sections of a stream or objects
embedded in a stream. These commands duplicate the actions of the command
buttons on the lower toolbar.

The buttons are shown below. The button commands are, from left to right: First,
Previous, Go to, Next, Last, Number of items, and Next error.

Use To

Next Go to the next item (PAT, transport packet, PES packet, table
section...)

Previous Go back to the previous item

First Go to the first item

Last Go to the last item

Go to Go to a selected item

Number of items Count and display the number of items

Next error Locate and display the next item that has at least one syntax error

Selection Menu. The Selection menu provides access to several different views of
stream data on several different levels.
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Use To

PSI hierarchic Create a new hierarchic view of the transport stream represented by
selected window

SI hierarchic Display an SI (DVB) hierarchic view of the transport stream; this
command is present only when DVB is selected in the Options menu

Multiplex Display an interpreted view of the transport packets (all PIDs). This
command is equivalent to double-clicking on the TS (engine and
tender) icon and is not available when a hierarchic view is selected

Transport packet Display an interpreted view of the transport packets of a specified PID

PES packet Display an interpreted view of the PES packets encoded in the
transport packets of a specified PID

Elementary stream Extract an elementary stream and save in a file

PSI/SI or PSI Display an interpreted view of the specified PSI/SI sections; SI only
present when DVB is selected in the Options menu

Filters Open the Filters submenu

Filters Submenu. The Filters submenu enables extraction of transport stream
components or objects that meet user-specified criteria. Refer to Filters,
beginning on page 3–46, for a complete explanation.

Use To

New Create a new filter

Open Open an existing filter (.flt) file

Edit Modify a filter

Save Save a filter to a disk (.flt) file

Apply Apply a filter to the stream represented by the selected hierarchic view
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Analysis Menu. Use the analysis menu commands to analyze stream contents and
characteristics either automatically (selected analyses one after another) or
manually (one analysis at a time).

Use To

Multiplex
Characteristics

Open the Multiplex Characteristics submenu

Check CRC Check CRCs of the various tables in the selected PSI hierarchy
(Check CRCs begins on page 3–24)

Syntaxic Check the stream for syntax errors
(Syntax Analysis begins on page 3–25)

Consistency Check Check for consistency within the stream
(Consistency Check begins on page 3–26)

PSI/SI Rate Analyze the rates of the various PSI/SI tables within the stream
(PSI/SI Rate Analysis begins on page 3–29)

PCR Check the program clock references in the stream
(PCR Analysis begins on page 3–30)

PTS/DTS Check the time stamps in a selected elementary stream
(PTS/DTS Analysis begins on page 3–34)

Semantic Check all transport packets for semantic errors
(Semantic Analysis begins on page 3–37)

Dynamic Open the Dynamic (analysis) submenu

Automatic Perform an automatic sequence of analyses
(Automatic Analysis begins on page 3–44)
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Multiplex Characteristics Submenu. The Multiplex Characteristics submenu
provides access to multiplex-related information.

Use To

Rate Display the overall multiplex rate as calculated from the first ten PCRs
and, if the calculated rate is incorrect, enter the correct value
(Multiplex Rate begins on page 3–22)

Multiplex Allocation Display a pie chart of PID allocation in the stream
(Allocation begins on page 3–23)

PID Map Display the sequence of PIDs in the transport stream
(PID Map begins on page 3–24)

Dynamic Submenu. The Dynamic analysis submenu contains selections for
dynamic analysis of the MPEG bit stream.

Use To

T-STD Conduct a transport stream system target decoder simulation 
(T-STD Analysis begins on page 3–39)

LTW Check the effect of LTW (legal time window) offset and piecewise rate
field values
(LTW Analysis begins on page 3–43)

Smoothing Buffer Conduct a smoothing buffer simulation
(Smoothing Buffer begins on page 3–44)
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Options Menu. Use the Options menu to set various Analyzer options as well as
save and restore program configurations. Refer to The Options Menu, on
page 3–55, for more information.

Use To

DVB Toggle the DVB option on/off

Visual TSTD and LTW Toggle the graphic view of TSTD and LTW dynamic analysis on/off

Output messages in file Toggle output message option on/off

Base Specify the numeric base (decimal or hexadecimal) used in the
interpreted and hierarchic views

Font Specify the text font (typeface and size) used in analyzer views

Directories Configure default directories

Automatic Analysis Configure automatic analysis (specify the analyses to perform)

Interpretation Configure the interpreted view

Save configuration Save the current user configuration to a file

Read configuration Read and apply a previously saved user configuration

Set default
configuration

Reset all options to the default settings
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Window menu. The Window menu is used to manage the various open windows.

These commands—with the exception of Add view—work as in all Windows
applications. Use Add view to create a new window that displays the data of the
current window in a different format. A small submenu, like those shown below,
appears when you choose Add view.

Use To

(the first choice) Create a duplicate of the selected view

Hexadecimal Create a byte-by-byte, hexadecimal view of the data

Binary Create a bit-by-bit, binary view of the data

(PCR or PTS/DTS)
Values

Create a view that lists numeric values related to the clock or time
stamp

Help Menu. 

Use To

Contents Open a Help window and display the table of contents

Using help Get help using Help

About... Display the MPEG-2 System Analyzer version and copyright
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The following table lists the command buttons found on the upper toolbar. Click
the appropriate button to choose one of the functions.

Icon Name FunctionÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Open
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Opens an existing stream. Equivalent to the Open command in the File
menu.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

Save
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Saves streams and stream elements. Equivalent to the Save As
command in the File menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Hierarchy ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Displays the hierarchic structure of the current PSI. Equivalent to the
PSI hierarchic command of the Selection menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

View ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Opens a new window related to the current window. Selecting this icon
brings up a submenu that offers a choice of window display modes.
This selection is similar but not equivalent to the Add view command in
the Window menu.

The commands from the lower toolbar are only available if the selected
document window contains items (stream packets, transport tables, elementary
stream packets, PES, PSI table sections, or SI DVB table sections). When the
document window does not contain any of these items, these command buttons
are not available.

Click the appropriate command button to choose one of these functions.

Icon Name Function

ÁÁÁÁÁ
ÁÁÁÁÁ

Start ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Accesses the first item. Equivalent to the First command in the Edit
menu.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

Previous 
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Selects previous item. Equivalent to the Previous command in the Edit
menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Go To 
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Used to go directly to an item. Equivalent to the Go to command in the
Edit menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Next ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Selects the next item. Equivalent to the Next command in the Edit
menu.

ÁÁÁÁÁ
ÁÁÁÁÁ

End ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Goes to the last item. Equivalent to the Last command in the Edit
menu.ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

Number
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Displays the number of items. Equivalent to the Number of items
command in the Edit menu.

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Error
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Finds and displays the next item that contains at least one syntax error.
Equivalent to the Next Error command in the Edit menu.

The Upper Toolbar

The Lower Toolbar
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Opening a File
The MPEG-2 System Analyzer can open MPEG-2 transport stream files (.trp,
.bin, or .ts file extensions), PES packet files (.pes extension), and section files
(.si extension). To open a file, select Open from the file menu, click the Open
command button in the upper toolbar, or type CTRL+O. Then choose the file from
the Windows Open dialog box

� Select the appropriate drive, directory, and file type. Sample files are in the
c:\MTS100\CFG-TRP directory; if you wish to open a file on the Data Store
Disk, change the directory to c:\CARB0.

� Select the file you want to open from the list of files.

� Double-click on the file name, click the OK button, or press ENTER.

When you open a transport stream file, a PSI hierarchic view appears in the
application window. If you open a transport packet, PES, or section file, an
interpreted view appears.

NOTE. The Analyzer cannot generate a hierarchic view if the stream does not
contain a PAT (program allocation table, PID 0) or PMT (program map table).

The hierarchic view that appears when you first open a file is based on the first
versions of the PAT and PMT tables found in the stream. Use the Next command
in the Edit menu or click on the Next command button (in the lower toolbar) to
go to the next PSI version, if any, in the stream.
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The Hierarchic View
The hierarchic view uses icons to show the interrelationship of stream compo-
nents, and is the starting point for many types of analysis. The figure below
shows the hierarchic view of a simple MPEG-2 transport stream.

The hierarchic view icons, described in Table 3–1, represent the different
elements that make up or are embedded in a transport stream.

Table 3–1: Icons used in the PSI hierarchic view 

Icon Element Type

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Multiplex transport packets. This icon represents all (188-byte) transport packets
that make up the stream.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Transport packets of a particular PID (Program ID). Other elements (tables,
clocks, PES packets) are the payload contained within transport packets or are
constructed from the payload of several transport packets that have the same
PID. The PID number appears under the icon.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Transport Packets that contain independent PCR clocks. The PID appears under
the icon.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PAT (Program Association Table) sections. Always contained in PID 0 transport
packets.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PMT (Program Map Table) sections

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

NIT (Network Information Table) Provides access to SI Tables through the PSI/SI
command from the Selection menu. Also used for Private Data sections.

Stream Elements
and Icons
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Table 3–1: Icons used in the PSI hierarchic view (Cont.)

Icon Element Type
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Packetized Elementary Stream (PES). This icon represents all packets that,
together, contain a given elementary stream. Individual PES packets are
assembled from the payloads of several transport packets.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Video elementary stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Audio elementary stream

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Data elementary stream

ECM (Entitlement Control Message) sections

EMM (Entitlement Management Message) sections

Table 3–2: Special hierarchic view symbols 

Symbol Significance

The question mark is added to a TS icon when the transport packets have
undefined PIDs and are not referenced by any PSI table. (Note that this is
permissible in MPEG-2, but may indicate a PSI configuration problem.)

The lock symbol, superimposed on an icon, indicates that part of the stream is
scrambled. Scrambling on the transport stream level is indicated by a lock on the
TS (rail car) icon and the following PES and ES icons; scrambling on the PES
level is indicated by a lock only on the PES and ES icons.

A red square (border) surrounding a base icon after a Consistency analysis
indicates that the data type, declared in a PSI table, is not valid.

A red X over a base icon as a result of Consistency analysis indicates that a
specific PID, declared in a PSI table, cannot be found in the transport stream.

Double-click for an interpreted view. Double-click on an icon to display an
interpreted view of the stream element. Refer to The Interpreted View, beginning
on page 3–17, for more information.
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Icon menus. Each type of icon has a context-specific shortcut menu that allows
quick access to the functions available specifically for the chosen element.
Display this menu by clicking the right mouse button on the icon. Hold the
mouse button down, highlight the desired command, and release the button to
select the command. In all cases, you can select the first command on the menu
(or the only command in one-item menus) by double-clicking on the icon.

If the open transport stream file contains DVB SI tables, you can use the SI
hierarchic command in the Selection menu to display an SI hierarchic view, as
shown below. Table 3–3 describes the icons used in the SI hierarchic view.

NOTE. The SI hierarchic command is available only when DVB is selected in the
Options menu.

The SI (DVB)
Hierarchic View
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Table 3–3: Icons used in the SI hierarchic view 

Icon Element Type

NIT (network information table) sections

SDT (service description table) sections

EIT (event information table) sections

BAT (Bouquet Association Table) sections

Transport stream referenced in an NIT or BAT

Event referenced in an EIT

TV service referenced in an SDT

Radio service referenced in an SDT

Teletext service referenced in an SDT

Double-click for an interpreted view. As with the PSI hierarchic view, you can
double-click on the table icons to display an interpreted view of table sections.
Refer to The Interpreted View, beginning on page 3–17, for more information.
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The Interpreted View
The interpreted view contains a graphic presentation of one transport packet,
table section, or PES packet at a time, while providing access to all similar
packets or sections that make up the MPEG-2 transport stream or are embedded
in it. The interpreted view of a transport stream packet is shown below. You can
create this view by double-clicking on the multiplex transport packet (engine and
tender) icon in the hierarchical view.

The currently interpreted packet or section is called an “item.” Information about
the item’s relationship to other items and position in the transport stream appears
near the top of the interpreted view window.

Type Number TimePosition

� The item number is the position of the current item relative to all such items
in the transport stream. The total number of items (9300 in the example) is
displayed if you have used a command button (in the lower toolbar) to either
go to the last item or count the items in the stream. You can also use
command buttons to move back and forth among the items and to search for
an item with a syntax error. Refer to The Lower Toolbar, on page 3–11, for
more information.

� The position is that of the first byte in the item, relative to the beginning of
the transport stream. The example item is the second 188-byte packet in the
stream, thus it is no surprise that it begins with byte 188.

� The time is also relative to the beginning of the stream; it is displayed after a
multiplex rate calculation. Perform a multiplex rate calculation by selecting
it from the Multiplex characteristics submenu of the Analysis menu or by
typing CTRL+R. The analyzer also performs the calculation as part of several
other analyses, including PCR, PSI/SI rate, PTS/DTS, and Dynamic.

Item Information
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The interpreted view shows the fields of information and data that make up the
section or packet. Each field is represented by a name box and a value rectangle
below it. Fields vary in length from one bit to many bytes. The width of each
box/rectangle does not indicate the length of the field. You can configure the
interpreted view, through the Interpretation command on the Options menu (see
page 3–20), to show the length or position (in bits) of each information field.
The length or position is indicated below the value rectangles.

The length of data fields—such as the Payload in the above windows—is
always shown (in decimal number of bytes) in the value rectangle. Value
rectangles of information fields contain the value of the field. To toggle
information field values (but not data field lengths) between decimal and
hexadecimal base, press the F2 key.

Double-click on the name box for an explanation of a field.

Fields
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Double-click on the value rectangle for additional information about the value.

Double-click on a data field name to add a byte-by-byte hexadecimal view of the
interpreted section, table, or packet.

You can also display a hexadecimal view or binary view of any section or packet
by selecting the Add view command from the Window menu or by clicking on
the Add view command button in the upper toolbar.

Double-click on the descriptor field name in an SI table (NIT, SDT, EIT, or BAT)
section for an ASCII decode of the descriptor information.



Using the Analyzer

3–20 Tektronix MPEG Test System User Manual

You can customize the appearance of the interpreted view through the Interpreta-
tion command on the Options menu. The Interpreted view options dialog box,
with default selections, is shown below.

The Length and Position settings, explained on page 3–18, apply to all inter-
preted views. You can use the remaining controls to determine which fields
appear in transport packet, PES packet, or (table) section interpreted views.

1. Click the option button in the Type field to select the type of interpreted
view you wish to change.

2. As shown, the default display is All fields, including the Reserved field. To
hide a field, select it in the Display list box and click the << button.

3. To show just a few fields, click Delete all; this clears the display box, All
check box, and ‘Reserved’ field check box. Then select a field name from
the List list box and click the >> button. Repeat this until all the fields you
wish to display are listed in the Display box. If you also want to display the
Reserved field, select that check box. Finally, click OK. The changes take
effect immediately.

Interpreted View Options
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4. When you have made any changes to the displayed fields, ***Warning,
display option*** appears at the top of the interpreted view window.

5. To restore the interpreted view to the original configuration, choose
Interpretation from the Options menu, click the appropriate Type option
button, click either Add all or the All check box, and finally click OK.

Hexadecimal and Binary Views
You can always add a hexadecimal view of the current interpreted view item by
double-clicking on a payload or data bytes name box. However, some items such
as table sections do not have these fields. To create a hexadecimal or binary view
for any interpreted view item, either click on the Add view command button (in
the upper toolbar) or select the Add view command from the Window menu. A
submenu, appropriate to the current item, appears as shown.

Select the top submenu command (Transport packet in the example) to add a new
interpreted view; select Hexadecimal or Binary to view the bytes or bits that are
the basis for the interpreted view.

The hexadecimal view shows the contents of the current item on a byte-by-byte
basis. The first few bytes appear in blue characters on the PC display to indicate
that they are required header information for the type of item. A transport packet
has four required bytes; a PES packet has six. The blue, required bytes may be
followed by several bytes shown in gray. The “gray bytes” are optional or
variable header information. The remaining bytes, displayed with black
characters, are the payload or data bytes.

The hexadecimal view window shows the number of the displayed item, just like
the interpreted view. When you use the command buttons to move among similar

The Hexadecimal View
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items in the stream, the hexadecimal view changes to display the contents of the
current item.

The binary view displays the current item on a bit-by-bit basis. The same
character color conventions used in the hexadecimal view apply to the binary
view. The contents will also change when you use the command buttons to move
among items in the stream.

Multiplex Analyses
The Analyzer can provide valuable information about the way programs are
multiplexed into the MPEG-2 transport stream through the Multiplex Character-
istics command on the Analysis menu. The Multiplex Characteristics submenu
has three commands: Rate, Multiplex Allocation, and PID Map.

To calculate the multiplex rate of a transport stream, select the window that
contains the hierarchic view and then either choose Rate from the Multiplex
Characteristics submenu or type CTRL+R. The Transport Stream Property dialog

The Binary View

Multiplex Rate
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box appears displaying the multiplex (mux) rate and the number of programs in
the stream.

The analyzer calculates the multiplex rate from the first ten PCRs found in the
transport stream. Because the sample is small and the precision of the number is
high, there can be error in the calculation. To ensure maximum accuracy of
analyses that use the multiplex rate to calculate results and detect errors, you can
enter the actual multiplex rate (if you know it) in the dialog box.

For example, if the exact multiplex rate of a stream is 10 Mb/s instead of the
reported 9,999,999 bits/s, enter 10000000 in the Mux Rate text box before
clicking OK. This increases the accuracy of subsequent PCR, PTS/DTS, and
Dynamic analyses, which use the multiplex rate in their calculations.

Choose Multiplex Allocation from the Multiplex Characteristics submenu to see
a pie chart of the transport stream that shows the stream fraction occupied by
packets of each unique PID. The analyzer calculates the portion of the stream
used by the various PIDs and creates a Multiplex Allocation window.

Allocation
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� The percentages shown in the graph key are calculated by dividing the actual
number of transport packets of a given PID by the total number of packets in
the transport stream file.

� All PIDs found in the transport stream are represented; those that are not
referenced in a PAT or PMT will appear in the hierarchic view only after a
consistency check (described under Consistency Check on page 3–26).

� PID 8191 is reserved for stuffing bytes; it is not shown in the hierarchic
view.

The PID map lists the PID of every transport packet in the stream. In the map,
each packet is represented by its PID, and each unique PID is color-coded
according to the type of element it identifies. For example, the PIDs of packets
that contain data for video elementary streams are displayed in light blue
characters.

To open a PID map of transport stream file, select the hierarchic view and then
choose PID Map from the Multiplex Characteristics submenu. A window
containing a PID map of the first 100 packets appears in the application window.
Use either the Edit menu commands or the command buttons in the lower
toolbar to display the PID maps of other 100-packet portions of the stream.

Check CRC
Many MPEG-2 tables (such as the PAT, PMT, and SDT) have CRC (Cyclic
Redundancy Code) fields. CRC field values are calculated from table data during
encoding. The decoder performs another calculation from received data and
compares the result to the field value in order to verify that the received data is
correct.

PID Map
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The analyzer automatically calculates and compares (checks) the CRC of the first
PAT section when opening a transport stream file. To check all CRCs in a
transport stream, select the stream’s PSI hierarchic view and then choose the
Check CRC command of the Analysis menu. If the analyzer finds CRC errors, it
opens a message window. Each line of text in the window represents one CRC
error.

Double-click on a line to open an interpreted view of the table section that
contains the particular CRC error. The CRC field value is displayed in red
characters in the interpreted view to draw your attention to the error.

Syntax Analysis
To perform a syntax analysis of all elements in the transport stream file, select
the hierarchic view and then choose Syntaxic from the Analysis menu. To
analyze the syntax of one stream element, first open an interpreted view of the
element (double-click on the icon in the hierarchic view) and then select
Syntaxic from the Analysis menu. If the analyzer finds any errors, it opens a
message window that lists all the errors found, one error per line of text.

Each line in the syntax analysis window represents one error. Double-click on
the line to open an interpreted view of the item that contains the error. The
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erroneous field value(s) are displayed in red characters. Double-click on the
value rectangle, as shown below, to confirm the error.

Consistency Check
The analyzer can check for consistency within both PSI (MPEG-2) and SI
(DVB) hierarchies. To perform a consistency check, select the window contain-
ing the hierarchic view and then select Consistency Check from the Analysis
menu.

NOTE. The analyzer automatically performs a PSI consistency check on the first
2000 valid transport packets when you first open a transport stream file. Errors
can easily occur in later packets; always conduct a manual consistency check to
be sure of discovering all consistency errors in the transport stream file.

If the analyzer finds any consistency errors in a PSI hierarchy, it opens a window
similar to the next illustration; each line of the window represents one error.
Double-clicking on a line does not have an affect. However, the analyzer does
redraw the hierarchic view after a consistency check to show errors with special
icon symbols as listed in Table 3–4 and shown on page 3–27.

PSI Consistency Check
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Table 3–4: PSI consistency error symbols 

Symbol Significance

A red square (border) surrounding a base icon indicates that the data does not
match the stream type declared in a PSI table.

A red X over a base icon indicates that a specific PID, declared in a PSI table,
cannot be found in the transport stream.

The question mark is added to a TS icon when the transport packets have
undefined PIDs or are not referenced by any PSI table. (Note that this is
permissible in MPEG-2, but may indicate a PSI configuration problem.)

No PES packet in PID #136, and
PID #69 is referenced in PMT but does not exist (0x45=69)

PID #236 is referenced as ECM but does not exist (0xEC=236)

PID #81 is found in the stream, but not referenced (in the PAT or a PMT)
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If the analyzer finds any syntax errors in an SI hierarchy, it creates a message
window that lists the errors. The SI consistency error messages use the abbrevi-
ations listed and defined in Table 3–5.

Table 3–5: SI consistency error abbreviations 

Abbreviation Meaning

S n Section number n (software order)

L n Loop number n

FDL First descriptor loop

D n Descriptor number n in the loop

Nid n Network_id = n

Tid n Table_id = n

Tsid n Transport_stream_id = n

Sid n Service_id = n

Onid n Original_network_id = n

Eid n Event_id = n

Bid n Bouquet_ id = n

Pn n Program number n

Sn n Section number n

Vn n Version number n

SI Consistency Check
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PSI/SI Rate Analysis
To perform a PSI/SI rate analysis of a transport stream, select the hierarchic view
and then choose the PSI/SI Rate command from the Analysis menu. The
analyzer opens a window that contains tabulated information about the various
tables (PAT, PMT, NIT, SDT) in the transport stream and the frequency of their
insertion into the stream. Table 3–6 explains the columns in the PSI/SI rate table.
(Notice that the rate table refers to each PSI/SI table occurence as a “sub table.”)

Table 3–6: Information in the PSI/SI rate table

Column Reports

P. in bytes The average number of bytes from the start of one table occurrence in the
transport stream to the start of the next occurrence

P. in sec. The average time (period, in seconds) between consecutive table occurrences;
(P. in bytes)*(8 bits per byte) ⁄ (multiplex rate)

Table length Table size in bytes

Rate The average subtable bits per second of transport stream; that is, the table
length in bits divided by the average period.

Occurrences The number of times the table occurs in the transport stream file

Min time The shortest time (in seconds) between consecutive table occurrences

Keep the following in mind when interpreting the PSI/SI rate table:

� The times listed depend on the analyzer’s calculation of the multiplex rate. It
is good practice to check the multiplex rate before conducting a PSI/SI rate
analysis and to correct the result if necessary. Refer to Multiplex Rate, on
page 3–22, for more information.



Using the Analyzer

3–30 Tektronix MPEG Test System User Manual

� The PMT program numbers are not readily apparent from the hierarchical
view. To discover the number of the program mapped by a particular PMT,
double-click on the PMT icon; the program number is listed in the title of
the interpreted view window. Program numbers are also listed in the
interpreted view of the PAT.

Timing Analyses
The MPEG-2 System Analyzer can conduct two types of timing analysis: PCR
(program reference clock) and PTS/DTS (presentation/decode time stamps). The
PCR “clocks” are encoded in transport stream packets and pertain to a given
MPEG-2 program. The PTS/DTS are encoded into PES packets and pertain to
that elementary stream only.

PCR analysis can be broken into three distinct tasks or capabilities:

� You can view a graphic diagram of the PCR clocks of each program in the
stream.

� You can learn more about each PCR clock.

� You can search for errors in the clocks of one program or all of the programs
in the transport stream.

Viewing a PCR graphic diagram. To see a graphic diagram of the PCRs in a
specific program, use the right mouse button to click on the PMT or TS (with
PCR) icon and open the shortcut menu. Hold the button down and highlight the
PCR Analysis command—as shown below—and then release the button to
begin the analysis.

(You can also begin PCR analysis by choosing PCR from the Analysis menu. A
dialog box will appear. Enter the number of the program you wish to analyze and
click on OK.)

The analyzer opens a PCR graphic view window. Typically, the first view
contains the ten clocks found first in the transport packets of the selected
program. Each clock face icon represents one PCR clock. The arrow leading

PCR Analysis
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down from the clock icon to the time line is normally black; it is red (on the PC
display) when analysis has detected a clock timing error.

Use either the commands in the Edit menu or the command buttons on the lower
toolbar to view the remaining clocks (of the selected program) in the transport
stream.

Listing PCR values. Double-click on a clock icon to list detailed information
about the clock.

� Interpolated PCR (PCRI). The analyzer calculates Interpolated PCR (PCRI)
from the previous PCR value, the number of intervening bits, and the
multiplex rate. If either the previous PCR or the multiplex rate is incorrect,
the PCRI is also invalid. An invalid PCRI can cause a false PCRI-PCRV
error.

If a PCR analysis results in many PCRI-PCRV errors, check the multiplex
rate as described on page 3–22. In the case of an isolated PCRI-PCRV error,
always check the previous PCR for accuracy.

� Previous PCR Arrived Since. Previous PCR Arrived Since is the time
elapsed since the previous PCR of the same program. Any value over 0.1
second is an error and is displayed in red characters.
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� Packet Number. The packet number identifies the transport packet that
contains the PCR. To display an interpreted view of the packet, double click
on the TS (engine and tender) icon in the hierarchic view to open an
interpreted view of the first transport packet, and then use the Edit menu or
lower toolbar buttons to go to the packet that has the same item number as
the PCR packet number.

� Packet Number of PID n. Packet Number of PID n identifies the packet that
contains the PCR relative to all packets that have the same program ID. To
display an interpreted view of the packet, double click on the PID n PCR
(freight car with clock) icon to open an interpreted view of the PID n
packets, and then go to the packet with the same item number.

To list the values for all PCRs shown in the graphic view window, either choose
Add view from the Window menu or click on the add view command button in
the upper toolbar. Then choose PCR Values from the View Type submenu.

Searching for PCR errors. As mentioned earlier, PCR errors are indicated by red
arrows in the graphic view. The erroneous information will also appear in red
characters on the PCR value lists. One way to search for PCR errors is to open a
PCR graphic view and then click the next error command button on the lower
toolbar.

Another, better way to search for all PCR errors in the entire transport stream file
is to use Automatic analysis. Automatic analysis is explained in detail beginning
on page 3–44; follow this procedure to search for PCR errors only:

1. Choose Automatic analysis from the Options menu. An automatic analysis
options dialog box appears in the analyzer application window.

2. Clear all check boxes except the one corresponding to PCR clocks. Then
click on OK.



Using the Analyzer

Tektronix MPEG Test System User Manual 3–33

3. Select the PSI hierarchic view of the stream you wish to check for PCR
errors.

4. Choose Automatic from the Analysis menu. An automatic analysis status
window appears to show the progress of the PCR analysis.

5. When the analysis is complete, either OK (black characters) or Errors (red
characters) will appear in the PCR result cell.

6. If errors are reported in the PCR result cell, double-click on the cell. A
window containing a list of errors appears. Each line of the list represents
one PCR error.

7. Double-click on a line to create a PCR graphic view that contains the
erroneous clock. Double-click on the clock icon to create a window that lists
the PCR values.
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PTS/DTS analysis extracts the presentation and decode time stamps from PES
packets encoded in the transport stream and shows those time stamps in a
graphical format. The PTS/DTS timing diagram, like the PCR clock diagram,
provides access to numerical data about the time stamps; it also offers informa-
tion about the associated MPEG-2 access units.

PTS/DTS analysis also enables viewing the “vital statistics” (numerical data) of
various timing objects and searching for PTS/DTS errors in one elementary
stream or all elementary streams in the file.

Viewing a PTS/DTS timing diagram. 

1. Right-click on the PES icon associated with the stream you want to analyze.
Hold the mouse button down and highlight PTS/DTS on the shortcut menu.

2. Release the button. A PTS/DTS timing diagram window appears, showing
the first four PTS/DTS “events” and the closest PCRs. Table 3–7 explains
the icons used and lists the information you can display by double-clicking
on each icon.

NOTE. You can also begin PTS/DTS analysis by choosing PTS/DTS from the
Analysis menu. A dialog box will appear. Enter the numbers of the program and
stream you wish to analyze and then click OK.

PTS/DTS Analysis
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Table 3–7: PTS/DTS graphic view icons 

Icon Represents Double-click for

PCR (program clock reference) Value
Location in transport stream (TS packet number)

Arrival time of the PTS/DTS Value
Time since the previous PTS/DTS arrived
Location in elementary stream (PES packet number)

DTS (decode time stamp) Value
Location in elementary stream (PES packet number)

PTS (presentation time stamp) Value
Location in elementary stream (PES packet number)

AU (access unit) Begin time
End time
Size in bytes
Type of frame (intra, predicted, or bidirection)
Reference time

The arrows leading down from the A, D, and P icons to the time line are
normally black; they are red (on the PC display) when an error is associated
with the object. Red characters also highlight errors in the PTS/DTS value
windows that appear when you double-click on an icon.

The example timing diagram illustrates several features of a correctly
encoded MPEG-2 video stream:

� Access units arrive one after another, as you can see from the left
(“early”) side of the diagram.

� The order of access unit decoding and presentation is visible in the right
(later) portion of the diagram.

� Intra (I) and predicted (P) pictures must be decoded before presentation
and therefore have both DTS and PTS. B (bidirection) frames are
decoded and presented at the same time and therefore have only
presentation time stamps.

� B frames use information in an associated P frame; the P frame must be
decoded before the B frame(s), but is presented after. In the example,
then, the order of frame decoding is IPBB, but the order of presentation
is IBBP.

3. Use the Edit menu commands or the command buttons on the lower toolbar
to view diagrams of other time stamps—and search for time stamp
errors—in the same elementary stream.
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4. To view the data for all time stamps and access units at once, choose Add
view from the Window menu or click on the Add view command button.
Then choose PTS/DTS values from the View type submenu. The resulting
window lists information about the displayed time stamps in the left column
and information about the access units on the right. The number of access
units in the display appears after “Nb Access Unit:” at the top of the window.
Incorrect values (such as equal PTS and DTS values, or an arrived value that
is later than either the PTS or DTS) are displayed in red characters.

Searching for PTS/DTS errors. As mentioned earlier, one way to search for
PTS/DTS errors is to open a graphic view and look for red arrows leading from
A, P, and D icons to the time line. If no errors are present, click on the Next error
command button (on the lower toolbar) to search for errors later in the elementa-
ry stream.

Another, better way to check the entire transport stream file for PTS/DTS errors
is to use Automatic analysis. Automatic analysis is explained in detail beginning
on page 3–44; follow this procedure to search for PTS/DTS errors only:

1. Choose Automatic analysis from the Options menu. An Options dialog box
appears in the analyzer application window.

2. Clear all check boxes except the one corresponding to PTS/DTS stamps.
Then click on OK.

3. Select the PSI hierarchic view of the stream you wish to check for errors.
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4. Choose Automatic from the Analysis menu. An automatic analysis status
window (as shown on page 3–33) appears. When the analysis is complete,
either OK (black characters) or Errors (red characters) will appear in the
PTS/DTS result cell.

5. If the PTS/DTS result cell reports errors, double-click on the cell. A window
containing a list of errors appears. Each line of the list identifies an incorrect
time stamp and describes the error.

6. Double-click on a listed error to create a PTS/DTS graphic view that
contains the erroneous time stamp. A red arrow leading from an icon to the
time line indicates an error. Double-click on the icon that represents the
incorrect time stamp to create a value window for the stamp.

Semantic Analysis
Perform the following steps to conduct a Semantic analysis of an MPEG-2
transport stream:

1. Select the PSI hierarchic view of the stream you wish to analyze.

2. Choose Semantic from the Analysis menu. If the analyzer finds any errors, a
message window, containing a list of the errors, appears.

3. Double click on a list entry to create an interpreted view of the item that
contains the error.

NOTE. The error description in the message window identifies the item and field
containing the error. The analyzer does not identify semantic errors with red
characters or special symbols in the interpreted view.
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4. For more information about the erroneous field, double-click on the name of
the field that contains the error.

Dynamic Analysis
The analyzer can conduct three types of dynamic analysis.

� T-STD, which checks the selected program against the (transport stream
target) decoder model that is defined in the MPEG-2 standard.

� LTW (legal time window) offset, which checks the validity of the optional
LTW offset and piecewise rate adaptation fields of the transport packets.

� Smoothing buffer simulation

Both T-STD and LTW analysis have a visual mode that you can toggle on and
off by selecting Visual TSTD and LTW in the Options menu. Visual mode
graphically represents the contents of the various decoder buffers, shows the
progress of the analysis, and provides a way to abort the process; it does,
however, increase the time required for the analyses. Visual mode selection does
not affect how the analyzer reports errors. Toggle visual mode on or off before
you begin a T-STD or LTW analysis.

Visual Mode
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The MPEG-2 System Analyzer can perform T-STD analysis either on a selected
program in the current transport stream or on all programs in the stream.

Analyzing a Selected Program. There are two ways to begin analysis of a single
program:

� Click on the appropriate PMT icon with the right mouse button; then choose
T-STD Analysis from the shortcut menu. The analyzer checks all video and
audio streams in the program, and, if visual mode is selected, creates a
buffering simulation window, as shown on page 3–40. The graphic simula-
tion shows the buffer use of the first video stream and the first audio stream
listed in the PMT.

� With a hierarchic view selected, choose T-STD from the Dynamic submenu
of the Analysis menu. A dialog box appears.

You must enter the program you wish to analyze. The program number in
this dialog box refers to the order that the particular program is listed in the
hierarchic view.

T-STD Analysis
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To limit the portion of the stream to be analyzed, click the “Selected TS
packets” option button and enter the starting and ending packet numbers.

The analyzer checks all elementary streams in the selected program but, by
default, shows a graphic presentation of only the first video and the first
audio elementary streams listed in PMT and hierarchic view. If you wish to
see how a different stream uses the buffers, enter the stream number
according to the order the stream is listed among the video and audio streams
in the program.

When you have entered all the appropriate information, click OK. If you
have selected visual mode, a Buffering Simulation window appears.

The Buffering Simulation window has the following features:

� A counter that shows the current packet number

� A display of the current PCR time

� Dynamic bar graphs of the three video branch buffers. If the program has no
video elementary stream, “***unused***” appears under each bar (instead of
size information). The buffer bars change colors to indicate the usage: blue =
normal; yellow = filling up; orange = close to overflow; and red = buffer
full.

� Dynamic bar graphs of the three audio branch buffers that use the same
usage and color conventions as the video branch buffers.

� Dynamic bar graphs of the two system buffers that also use the same usage
and color conventions as the video branch buffers.

� An Abort button that permits you to pause or end the simulation before the
end of the stream.
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T-STD analysis can take several minutes, depending on the size of the transport
stream file. If the analyzer encounters buffer overflow or underflow errors, it
creates a message window and lists the errors. At the end of analysis, all activity
in the Buffer Simulation window stops; if you are not using visual mode, the
analyzer presents an “End of simulation” dialog box.

Analyzing all Programs in the Stream. You can use Automatic analysis to check
the entire stream at once for T-STD buffering errors. Automatic analysis is
explained in detail beginning on page 3–44; follow this procedure to search for
T-STD errors only:

1. Choose Automatic analysis from the Options menu. The automatic analysis
options dialog box appears in the analyzer application window.

2. Select the Dynamic check box and clear all others. Then click OK.

3. Select the PSI hierarchic view of the stream you wish to check for T-STD
errors.

4. Choose Automatic from the Analysis menu. An automatic analysis
progress/results window appears. A Buffering Simulation window will not
appear, even if Visual TSTD and LTW is selected in the Options menu.



Using the Analyzer

3–42 Tektronix MPEG Test System User Manual

T-STD analysis of an entire stream can take many minutes, depending on the
size of the file. The only way to stop an automatic dynamic analysis is to
type CTRL+ALT+DEL and use the Windows NT End Task command to quit
the analyzer application completely.

When analysis is complete, either OK (black characters) or Errors (red
characters) appears in the Dynamic result cell.

5. If the analyzer has found errors, double-click in the results cell to create a
message window that lists all errors, one per line.

6. To identify the program that contains an error, double-click the correspond-
ing line in the message window. An interpreted view of the transport stream
packet appears. Note the PID and then look in the PSI hierarchic view to find
the stream associated with that PID.

T-STD Notes. 

� Overflow at the beginning of the simulation may not indicate encoder
problems, as the analyzer must wait for the first DTS in the stream before
emptying the EB and B buffers. Buffer overflow after the first DTS,
however, indicates improper encoding.

� T-STD errors can arise from several different sources, including PCR errors,
PTS/DTS errors, and multiplexing errors. PCR analysis, PTS/DTS analysis,
and analysis of the Multiplex Characteristics may help locate the problem.
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� Remember that although the error message window lists the last packet that
results in buffer overflow or underflow, the cause of the error is probably
earlier in the stream.

LTW analysis checks the validity of the optional LTW offset and piecewise rate
adaptation fields of the transport packets that contain the selected stream. The
analyzer does this by remultiplexing the packets to place each at the end of its
legal time window and then performing a standard T-STD analysis on the
resulting transport stream. To begin LTW analysis, choose LTW from the
Dynamic submenu of the Analysis menu. A dialog box, similar to the one for
T-STD analysis, appears.

To analyze the stream listed fourth under the program listed third in the
hierarchic view, enter 3 in the Program number box and 4 in the Stream number
box. To limit the portion of the stream to be analyzed, click the “Selected TS
packets” option button and enter the starting and ending packet numbers.

When you have entered all appropriate values, click OK. If you have selected
Visual TSTD and LTW from the Options menu, a graphic window identical to
the T-STD Buffering Simulation window (shown on page 3–40) appears.
However, because only one stream is analyzed at a time, only the video or audio
branch buffers (depending on the type of stream) are used.

NOTE. If the packets of the selected stream do not contain LTW offset fields, the
analyzer conducts a normal T-STD analysis of the stream.

LTW Analysis
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LTW analysis can take several minutes, depending on the size of the transport
stream file. If the analyzer encounters buffer overflow or underflow errors, it
creates a message window and lists the errors. At the end of analysis, all activity
in the Buffer Simulation window stops; if you are not using visual mode, the
analyzer presents an “End of simulation” dialog box.

This analysis simulates a smoothing buffer using the values in the smoothing
buffer descriptor field that is optional in PMTs.

To begin smoothing buffer analysis, select the hierarchic view and then choose
Smoothing Buffer in the Dynamic submenu of the Analysis menu. If the analyzer
detects any overflow or underflow errors, it creates a message window and lists
the errors. There is no graphic representation of smoothing buffer analysis.

Automatic Analysis
Automatic analysis makes it possible to conduct a sequence of analyses on an
entire transport stream file with one click of the mouse button. It provides a
convenient way to screen a newly captured transport stream for a wide variety of
errors. As explained in the discussions of PCR analysis (page 3–32), PTS/DTS
analysis (page 3–36), and T-STD dynamic analysis (page 3–41), Automatic
analysis can be especially helpful in performing a search for errors in the entire
transport stream/multiplex, as opposed to the narrow searches of a single
program or stream conducted by initiating the same single analysis through the
Analysis menu.

Conduct an automatic analysis with the following steps:

1. Choose Automatic analysis from the Options menu. The following dialog
box appears.

Smoothing Buffer
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2. By default, automatic analysis includes all the listed tests. Automatic
analysis takes several seconds to many minutes, depending on the size and
complexity of the file, speed of your computer, and the number and type of
analyses selected through this dialog box. Dynamic analysis, the last
selection in the dialog box, takes much longer than all other tests combined.
Be sure you want to check all elementary streams in the transport stream
multiplex for compatibility with standard decoder buffers before selecting
the Dynamic check box. You may find it more convenient to select all
analyses but Dynamic for the first look at a transport stream and later go
back and select only Dynamic when you are ready to confirm decoder
compatibility.

NOTE. The MPEG-2 System Analyzer can conduct three kinds of Dynamic
analysis: T-STD (transport stream target decoder), LTW (legal time window),
and Smoothing Buffer. Automatic analysis includes only T-STD analysis; the
remaining dynamic analyses must be performed manually. Refer to Dynamic
Analyses, on page 3–38, for more information.

3. Choose OK to confirm the selections and close the dialog box.

4. Choose Automatic from the Analysis menu. A window containing an
analysis status and results table appears. As the analyses proceed, cells in the
Status column change from blank to Running to Completed. As each test is
completed, either OK (black characters) or Errors (in red characters) appears
in the corresponding Result cell, depending on the results of the individual
analysis.

If you wish to end the analysis at any time, click on Abort after current task,
at the bottom of the window.
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5. When all analyses are complete, the Automatic analysis window provides
access to detailed information about each detected error. For a list of the
syntactic errors in SAMPLE.TRP, for example, double-click in the Syntaxic
Result cell.

A window that lists the errors appears in the Analyzer application window.

6. Double-clicking on a listed syntax, PCR, PTS/DTS, semantic, or Dynamic
error leads to still more information about the error. The type of display and
information available is the same as when the individual analysis is
conducted manually (by selecting it from the Analysis menu). Double-click-
ing on a syntax error, for example, creates an interpreted view of the section
(in this case, a PES packet) that contains the error. Red field value characters
indicate syntax errors.

Filters
The MPEG-2 System Analyzer filtering capability enables finding and viewing
transport stream packets, PES packets, and PSI/SI table sections that meet one or
more criteria of your choosing. For example, you can create filters to find and
display the following stream objects:

� Transport packets that contain the first bytes of all PES packets of a given
elementary stream (as indicated by the presence in the payload of hexadeci-
mal string 00 00 01).

� Transport packets of a given PID in which the payload unit start indicator is
set to one.
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� PSI/SI (table) sections of a given PID that contain a descriptor tag with a
value of 64.

� PES packets of a given PID that lack both PTS and DTS (PTS/DTS flag set
to zero).

In defining a filter, you first specify the output level (transport packets, table
sections, or PES packets) and, if necessary, the PID. Then you enter up to three
more filtering criteria. When applied, the filter will look for packets or sections
that meet all criteria and open an interpreted view of the first item found.

Once a filter is created, you can save it to its own (.flt) file for use in later
analyzer sessions. You can also edit existing filters and save them under a new
name. You can save an unlimited number of filters and have up to five open at
any time, ready to apply to the current transport stream.

1. Choose Filters from the Selection menu; then choose New from the Filters
submenu. The first filter definition dialog box appears.

2. Enter the appropriate information and select options as necessary.

� The filter name can be up to eight characters long. By default, the name
you enter is proposed as the file name when you save the filter.

� The comment field can contain up to 255 characters. Enter a description
that will help you identify the filter and its function when you later open,
edit, or apply it.

Defining a Filter
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� Output level is the type of object that you want to find. The filter result
is an interpreted view representing the packets or sections that meet the
filter (search) criteria.

� Enter the PID of the packets you wish to filter; you can select All PIDs
only if you have specified transport packet output.

Your selections in this dialog box fill in the blanks in the statement “I want
to find the [blank_1] items that are identified with [blank_2]...” where
blank_1 is the output level and blank_2 is either “any PID” or PIDn.

The remaining filter definition steps let you add “...and that [satisfies another
criterion] and [satisfies a third criterion] and [satisfies a fourth criterion].”
Strictly speaking, none of these additions is necessary, but a filter without at
least one extra criterion would do no more than you could by double-clicking
on a hierarchic view icon. The third and fourth filter criteria are optional but
may help you narrow your search to exactly the packet or section you are
interested in.

3. Click the Next button. The second filter definition dialog box appears.

4. Use this dialog box to fill the blanks in one of the two following statements:

� Each item I am looking for must be—or contain the part of—a
[blank_3] that has a [blank_4] field with the value [blank_5].

� Each item I am looking for must be—or contain the part of—a
[blank_3] that contains the byte sequence [blank_6].
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Where blank_3 is the Criterion level, blank_4 is a selection from the Field
drop-down list box, blank_5 is a number entered in the (field) Value box, and
blank_6 is a hexadecimal or text value entered into the last value box when
the “4 bytes search” check box is selected.

For example, you can make selections to complete the above statements in
the following ways:

� Each item I am looking for must be a PES packet that has a PTS/DTS
flag field with the value 3.

� Each item I am looking for must contain the part of a PES packet that
contains the byte sequence 00 00 01.

� Each item I am looking for must be a transport packet that contains the
byte sequence 00 00 01 C0.

It may help to be aware of several conventions that apply to this dialog box:

� Some criterion levels may not be available, depending on the output
level specified in the first filter definition dialog box.

� The fields listed in the Field: drop-down list box depend on the criterion
level selection.

� The Next button disappears when you select the Elementary Stream
criterion level or the 4-bytes search check box because the filter cannot
be any more specific than these selections.

� Selecting the Elementary Stream criterion gives you no further options;
the Field drop-down list contains only Beginning of Access Unit (AU),
and 4-bytes search is not available. Use Elementary Stream criterion to
find either transport stream packets that contain the start of an AU or
PES packets that contain the start of an AU.

5. Click Next >> to define up to two more filter criteria; click << Previous to
return to the first filter definition dialog box; or click End to conclude filter
definition.
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Once a filter is defined, you can save it to a file for use in later analyzer sessions.
Choose Save from the Filters submenu (of the Selection menu). A dialog box
showing all currently loaded filters appears. Select the option button that
corresponds to the filter you wish to save; then click OK.

A standard Windows Save As dialog box appears. The filter name (with a .flt
extension) is in the File Name box. Click OK to accept the file name and save
the filter file; enter a different name and then click OK to save the file under a
different name.

To open a previously saved filter, select Open from the Selection/Filters
submenu. If no more than four filters are already loaded, the standard Windows
Open dialog box appears. Select and open the filter as you would any document
from within any Windows application.

Saving a Filter

Opening a Filter
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If five filters are already loaded, the dialog box showing all currently loaded
filters appears. Select a filter to be replaced by the filter you are opening and then
click OK. The Windows Open dialog box now appears.

Follow these steps to edit an existing, open filter:

1. Select Edit from the Selection/Filters submenu. The filter list dialog box
appears.

2. Select a filter and then click OK. The first filter definition box, with current
filter selections and settings, appears.

3. Proceed as if you were creating a new filter (see page 3–47), changing
existing selections and making new ones as necessary. When you are done,
click End.

If you change the name of the filter in the course of editing it, the new name will
appear in place of the original name in the filter list dialog box. Note that the
saved filter file is not affected. You may save the edited filter as described under
Saving a Filter. Use the original name if you wish to overwrite the old .flt file;
enter a new name if you don’t.

1. Open an existing filter, or create a new one.

2. Select the hierarchic view or a transport packet (interpreted) view of the
transport stream.

Editing a Filter

Applying a Filter
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3. Choose Apply from the Selection/Filters submenu. The filter selection dialog
box appears.

4. Select the option button that corresponds to a named filter. The comment
field applies to the selected filter.

5. Click OK. The analyzer displays an interpreted view of the first packet or
section (if any) that satisfies all filter criteria. Use the lower toolbar
command buttons to move among all items in the stream that meet the
criteria. Notice that window heading reminds you that this is a filtered view
and that messages at the top of the window provide useful information about
the items found.

If the analyzer finds no item that satisfies all filter criteria, it says so.
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Extracting and Saving Stream Elements
The analyzer allows you to extract transport packets, PES packets, PSI and SI
tables, and elementary streams from the from the current transport stream and
save them to disk files for later use or analysis.

To save a portion of a transport stream, double-click on a hierarchic view TS
(engine and tender or freight car) icon to open an interpreted view of the
transport packets. Then choose Save As from the File menu or click the Save
command button on the upper toolbar. A dialog box appears.

Make the appropriate selections and click OK. A standard Windows Save as
dialog box opens, with the file type set to Transport Stream (.trp). Select the
appropriate drive and directory, enter a file name, and click OK.

Transport Packets
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To save some or all of the packets in a PES stream, open an interpreted view of
the PES packets and choose Save As from the File menu or click the Save
command button. A dialog box appears.

Make the appropriate selections and click OK. A standard Windows Save as
dialog box opens, with the file type set to Pes Stream (.pes). Select the appropri-
ate drive and directory, enter a file name, and click OK.

To save one or more sections of a particular table (PAT, PMT, NIT, SDT, for
example) in the transport stream, double-click on the hierarchic view table icon
to open an interpreted view of the section. (If you want to save more than one
section, click the End button on the lower toolbar to go to the last section and,
more importantly, discover the number of sections in the stream.) Then choose
Save As from the File menu or click the Save command button. A dialog box
appears.

PES Packets

PSI and SI Tables
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To save a particular section or sections, enter the appropriate From and To values
(if you clicked the End button before choosing Save As, the number of the last
section appears in the To box). Click OK to open A standard Windows Save as
dialog box. The file type matches the type of section (for example, PAT/.pat).
Select the appropriate drive and directory, enter a file name, and click OK.

To save an elementary stream, double-click on the stream icon in the PSI
hierarchic view. A Save as dialog box appears with the file type set to match the
type of stream. Select the appropriate drive and directory, enter a file name, and
click OK.

The Options Menu
The options menu provides you a way to customize analyzer configuration and
to save your configuration choices in a file so you can easily restore them in
future analyzer sessions.

Select DVB in the Options menu to activate/deactivate recognition of DVB
syntax and semantics.

�DVB (DVB recognized) DVB not recognized

When DVB is not selected, the SI hierarchic command disappears from the
Selection menu, and the analyzer interprets any DVB SI sections as private
sections. Activate DVB when you are analyzing DVB SI streams; deactivate it
only if you know the streams you are analyzing contain no DVB elements.

Elementary Streams

DVB Option
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This selection determines whether the T-STD and LTW dynamic analyses are
conducted as visual buffer simulations or “in the background.” Refer to Visual
Mode on page 3–38 for more information.

Select this option to automatically save error messages and the contents of error
message windows to a text file.

If this option is selected and you open a file of a transport stream with PAT CRC
errors, for example, the analyzer writes a list of the errors to a ASCII text file.
The file receives the name of the transport stream file, but has a .log extension; it
is saved in the directory specified through the Options menu Directories
command. You may read the .log file with any ASCII text editor, such as the
Windows NT Notepad application.

The analyzer similarly creates a .log file when necessary and saves any message
window error lists that are generated during stream analysis. Examples of error
lists are those that can result when you conduct a syntax analysis or a consisten-
cy check and those that result when you double-click on an “Error” result cell
after an automatic analysis.

Remember that selecting this option can, over time, result in many error log files
in the Message directory. It is good practice to periodically delete outdated files.

The Base command opens a dialog box for selecting the numeric base used in the
hierarchic and interpreted views. You may find it more convenient to remember
that F2 is the shortcut key for toggling between the two settings.

Hierarchic view Interpreted view

Visual TSTD and LTW

Output Messages in File

Base
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Use the Font command in the Options menu to change the typeface used in the
hierarchic and interpreted views. Choosing the command opens a dialog box for
selecting font, style (normal, bold, italic), and size. Make your selections and
click OK. The display changes immediately.

Eight point Arial bold

Five point Times roman (default)

Use this command to specify default directories for output messages and
configuration files. Enter the complete paths in the Message directory and
Configuration directory text boxes; then click OK.

Use this command to configure the automatic analysis sequence. Refer to
Automatic Analysis, beginning on page 3–44, for complete instructions.

Choose this command to control the information that appears in the transport
packet, PES packet, and section interpreted views. See Interpreted View Options
on page 3–20 for a full explanation.

Font

Directories

Automatic Analysis

Interpretation
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All selections you make through the Options menu change the analyzer
configuration. The configuration in use when you exit the analyzer application is
restored the next time you start the program. The three configuration commands
in the Options menu let you save one or more configurations to files for later use
and allow you to easily return to the default configuration.

Save Configuration. Use Save configuration to save the current option settings to
a file. A standard Windows Save as dialog box opens. Be sure to select a Drive
and Directory that will make it easy to later retrieve the file; then enter a
descriptive name for the configuration file and click OK. The file receives the
extension .acf by default.

Read Configuration. Choose Read configuration from the Options menu to restore
a configuration file that you saved earlier. A standard Windows Open dialog box
appears. Change the Drive and Directory if necessary and then select the file
name. Click OK to restore the configuration saved in the file.

Set Default Configuration. Choose Set default configuration to restore all the
default analyzer settings. A dialog box appears to give you one more chance to
reconsider. Click OK to confirm the command. The following settings make up
the default configuration:

Option Default Setting

DVB Not selected

Visual TSTD and LTW Selected

Output messages in file Not selected

Base Decimal

Font Times New Roman, Regular, seven point

Directories See note below

Automatic Analysis All analyses selected

Interpretation Neither field Length nor Position displayed
All fields displayed for all types of interpreted view

NOTE. When you select Set default configuration, the message and configuration
directories are changed to the directory that contains the most recently opened
file. This can cause confusion because the directories remain the same until you
change them through the Options menu Directories command, read a saved
configuration file, or—after opening a file from a different directory—again
select Set default configuration.

Configuration
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Using the Multiplexer

This section is intended as a reference for the Multiplexer application. When nec-
essary, the Multiplexer automatically starts the MTS 210 Edit Table application.
Refer to Using the PSI and SI Table Editor, beginning on page 3–103, for in-
formation about Edit Table. Save your changes and close Edit Table before re-
suming work in the Multiplexer window.

Overview
With the Tektronix MPEG Test System Multiplexer application, you can specify
the characteristics and contents of an MPEG-2 or DVB transport stream and then
generate a file that contains the transport stream for use in testing MPEG-2 or
DVB hardware or software applications.

The use of the terms “multiplex” and “transport stream” in this section may
cause confusion. In practice, multiplexing is the process of combining and
arranging the program data and (PSI and SI) overhead so it can be transmitted
and later decoded; this application is called the Multiplexer because that is what
it does. The product of the process is both a multiplex and a transport stream.

Technically speaking, a transport stream is a digital data structure, defined in
ISO/IEC 13818-1, that is tailored to communicate one or more programs
encoded according to MPEG-2 standards. The transport stream data may be
broadcast, transmitted, or stored in a computer file as it is on the MTS 210
system and data store disks.

When it generates a transport stream, the Multiplexer combines information from
elementary stream files and table files according to instructions contained in a
configuration (.cfg) file.

Configuration file
Transport
stream
files

Video elementary
stream files

Data files

Audio elementary
stream files

Link

Link Link

Links
.BAT file
.NIT file

.SDT file
.EIT file

.RST file

Definitions

File Conventions
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To create an MPEG-2 or DVB transport stream with the Multiplexer, you must
first create a configuration file that contains all the instructions for making the
desired transport stream. The configuration file contains general information,
such as the Mux Rate, and also links to other required files, such as the video
elementary stream files and PSI and SI table files. (You can create the BAT, NIT,
SDT, and EIT files, if necessary, with the Edit Table application.)

The configuration file is similar in structure to a Windows *.ini file. An example
configuration file appears at the end of this section, beginning on page 3–99. The
configuration file is independent of the transport stream, which allows you to
create transport streams with only minor variations by using the same base
configuration file.

The overall procedure for creating a transport stream with the MTS 210
Multiplexer is as follows:

1. Create a new configuration file with default information.

2. Add stream icons to program 1.

3. Add more programs and stream icons as desired.

4. Associate Video, Audio, and Data files with all stream icons.

5. Add and edit SI (DVB) tables, if necessary.

6. Edit multiplex, PSI table, and program parameters as necessary; confirm that
the highest actual multiplex rate does not exceed the rate chosen for the
multiplex (transport stream) as a whole.

7. Generate the transport stream file from the configuration file.

A tutorial for creating an MPEG-2 configuration file and transport stream begins
on page 2–45; a tutorial for creating a configuration file with DVB information
begins on page 2–83.



Using the Multiplexer

Tektronix MPEG Test System User Manual 3–61

Remember that additional information about almost every aspect of Multiplexer
operation and MPEG-2/DVB bit streams is available from two convenient
sources:

� The Contents command on the Multiplexer Help menu

� The MPEG-2 Help utility, which contains much of the ISO/IEC 13818-1
MPEG-2 standard in Windows Help format. Start this utility from the
Tektronix MPEG Test System program group.

You can access either source any time you are using the MTS 210 Multiplexer.

Starting the Multiplexer
To start the Multiplexer, double-click the Multiplexer icon in the Tektronix
MPEG Test System program group window.

NOTE. You cannot start the Multiplexer application if either the MTS 210
Analyzer or the MTS 210 Data Store Administrator is running.

The Multiplexer application window opens to its most recent size and screen
location; size the window and position it as necessary on your Windows NT
desktop.

Getting Help
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The Application Window
The Multiplexer application window has the common Windows features: a title
bar, a menu bar, a tool bar, and a status bar. Once you open a new or existing
configuration file, the center workspace is divided into three parts: the duration
gauge, the rate gauge, and the multiplex window.

Duration gauge

Rate gauge

Multiplex window

Status bar

Menu bar

Tool bar

Title bar

The Menu Bar accesses the six main Multiplexer menus. The command buttons
on the tool bar provide convenient shortcuts for many menu commands.

File Menu. Use the commands in the File menu for creating new files, opening
existing files, saving files, closing files, and exiting the Multiplexer application.

Menu Bar and Tool Bar
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You can choose the New, Open, and Save commands by clicking the equivalent
command buttons.

New Open Save

Use To
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁNew

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁOpen a new configuration fileÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁOpen
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁOpen an existing configuration fileÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁSave
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁSave the current configuration fileÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁSave As
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁSave the current configuration file under a new nameÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Close
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Close the current configuration file

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Exit ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Close the Multiplexer application

Edit Menu. Use the Edit menu to add and delete items in the configuration file
hierarchy. Both commands on the Edit menu have command button equivalents.

Add Delete

Use To
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Add
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Add an item to the multiplex
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Delete
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Delete the selected item (and any sub-items) from the multiplex
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Multiplex Menu. The Multiplex menu has one command; choose it or click the
equivalent command button to generate a transport stream file (also known as a
“multiplex”) according to the instructions in the configuration file.

Go (generate
a Multiplex)

Use To

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Go ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Create (generate) a transport stream file from the configuration file

View Menu. 

Hierarchic Dynamic

Use ToÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁHierarchic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁDisplay a hierarchic view of the configuration fileÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Dynamic
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display a timing diagram of the programs listed in the configuration
file

Options Menu. For more information, refer to The Multiplexer Environment,
beginning on page 3–73.

Use To

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

DVB ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Toggle DVB required table files (SI) on and off

Dynamic SI Toggle Dynamic SI on/off

Directories Configure default directories
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Save Environment ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Save the current options settings to a file



Using the Multiplexer

Tektronix MPEG Test System User Manual 3–65

Use To

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Load Environment ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Read and apply a previously saved environment

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Default Environment ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Reset all options to the default settings

Help Menu.

Use ToÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Contents
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Open a Help window specific to the Multiplexer application

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Using Help ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display standard Windows help (about using help)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

About MPEG 2 System
Multiplexer

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the Multiplexer application version and copyright

The duration gauge is active only during multiplex (transport stream) generation.
The gauge shows 0% until you choose the Go command from the Multiplex
menu or click the equivalent command button. Then the gauge shows what
portion of the operation is complete. When the entire transport file has been
generated, the gauge shows 100%. The gauge returns to 0% when you close the
configuration file and later reopen it and when you save the configuration file
under a new name. Refer to Generating a Multiplex, beginning on page 3–98, for
more information.

The rate gauge shows the portion of available transport stream capacity that is
used for program data and overhead. The target, maximum multiplex rate
appears above the gauge. The highest actual rate appears below the gauge. The
actual rate is calculated with the following formula:

Rate = PSI rate + SI rate + Video rate + Audio rate + Data rate

Below the actual rate is the time period during which the highest multiplex rate
occurs.

NOTE. The actual rate number and the time it occurs are the worst case for the
resulting transport stream. To see the rate across the entire transport stream,
change to the dynamic view; refer to The Dynamic View, on page 3–71, for more
information.

The Duration Gauge

The Rate Gauge
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The color or the rate gauge bar depends on the portion of the available rate used
by the highest actual rate as listed in Table 3–8.

Table 3–8: Multiplex rate bar colors 

Actual rate/maximum rate Bar color

0 to 69% Green

70% to 89% Yellow

90% and above Red

Notice that you can create and save a configuration file with greater than 100%
mulitplex rate usage. However, the application warns you of multiplex overflow
if you attempt to generate a transport stream from a configuration that uses more
than 100% of the available multiplex rate.

The Multiplex Window displays the current configuration file in one of two
forms: the hierarchic view and the dynamic view. The hierarchic view is a
graphic representation of the transport stream/multiplex configuration that uses
icons to show the interrelationship of stream components. The dynamic view
shows the timing relationships between the various programs in the transport
stream; it is very useful for seeing how the programs use the available multiplex
rate and for resolving timing conflicts.

The multiplex window views are explained later in this section. The Hierarchic
View is next; The Dynamic View begins on page 3–71.

The Multiplex Window
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The Hierarchic View
The hierarchic view uses icons to show the interrelationship of transport stream
components and is the workbench for assembling and editing transport stream
configuration files. When you create a new configuration file or open an existing
one, the configuration appears first in the hierarchic view, as shown below.

Each transport stream item is represented in the hierarchic view by a unique icon.
Table 3–9 lists and explains all of the icons and lists the actions you can perform
by clicking the icon with either mouse button (in all cases, click once with the
left button to select the icon and the item it represents).

Some items (and their icons) apply only to DVB streams and can appear only
when DVB is selected on the Options menu; refer to Environment Options, on
page 3–73, for more information.

Hierarchy Icons
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Table 3–9: Hierarchic view icons 

Icon Item Double-click to Right-click?
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Multiplex. This is the main icon for the configuration file.

Required.

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Set multiplex rate and start timeÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Yes, collapses/expands
the hierarchy at this icon

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Program Specific Information (PSI). MPEG2 decoders use
PSI when demultiplexing the programs in a transport stream.

Required.

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Set the PSI period ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Yes, collapses/expands
the hierarchy at this icon

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Program Association Table (PAT). The PAT provides the
correspondence between each program in the stream and the
PMT that describes the program. The PAT is always
identified with PID 0.

Required.
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Read and set the PIDs of
associated tables and programs
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No
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Program Map Table (PMT). The PMT specifies a PID value
for each elementary stream associated with the program and
describes the program components. Some transmission
systems (such as Grand Alliance and DVB) require specific
PID values.

Required.
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Edit the PMT (with the Edit
Table application)
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No
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ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Service Information (SI). SI consists of up to five tables (NIT,
BAT, SDT, EIT, and TDT) and provides information on
services and events carried by this multiplex, different
multiplexes, and even on other networks.

Required for DVB configuration files.

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Add or edit DVB table files (NIT,
BAT, SDT, and EIT); set TDT
parameters

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Yes, collapses/expands
the hierarchy at this icon
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Network Information Table (NIT). The NIT provides
information about the physical network.

Required; found under the PSI icon for non-DVB and under
the SI icon for DVB configurations.
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Select or edit the NIT file and
set the NIT period

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

No
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Bouquet Association Table (BAT). The BAT provides
information regarding service bouquets (collections of
services that are marketed as single entities).

Optional. (DVB only)
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Select or edit the BAT file ÁÁÁÁÁÁÁ
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No
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Service Description Table (SDT). The SDT contains data
describing the services in the system such as names of
services, the service provider, etc.

Optional. (DVB only)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select or edit the SDT file ÁÁÁÁÁÁÁ
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No
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Event Information Table (EIT). The EIT contains data
concerning events and programs (a concatenation of one or
more events under the control of a broadcaster), such as
event name, start time, duration, etc.

Optional. (DVB only)
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Select or edit the EIT file ÁÁÁÁÁÁÁ
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No
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Table 3–9: Hierarchic view icons (Cont.)

Icon Right-click?Double-click toItem
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Time and Date Table (TDT). The TDT provides the UTC time
and data information

Optional (DVB only).

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Set TDT parameters
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

No

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Program. A multiplex can have up to 20 programs.

Required. Each transport stream must have at least one
program with one elementary stream.

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
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Set the PCR period and pro-
gram start delay.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Yes, collapses/expands
the hierarchy at this icon
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ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Video Elementary Stream. A program may have up to 5 video
elementary streams and up to 10 elementary streams of all
types.

Optional (although each program must have at least one
elementary stream).
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Select a video elementary
stream or set stream parame-
ters.
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No
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Audio Elementary Stream. A program may have up to 5
audio elementary streams and up to 10 elementary streams
of all types.

Optional (although each program must have at least one
elementary stream).
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Select an audio elementary
stream or set stream parame-
ters.
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Data Elementary Stream. A program may have up to 5 data
elementary streams and up to 10 elementary streams of all
types.

Optional (although each program must have at least one
elementary stream).
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Select a data file or set stream
parameters.
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ÁÁÁÁÁÁÁ

No
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You can expand or collapse the hierarchy structure below several hierarchy items
by right-clicking the icon. For example, if you right-click the PSI icon...

...the hierarchy will collapse below the icon, hiding the PAT and PMT. This is
useful if you are working with large number of programs that also have large
numbers of elementary streams.

Right-click on the PSI icon to restore the hierarchy to its original appearance.

Collapsing and Expanding
the Hierarchy
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The Dynamic View
The dynamic view is a diagram that shows the timing relationships of all
programs in the multiplex. The entire multiplex is represented by a wide bar at
the bottom of the diagram. The programs that make up the multiplex are shown
as narrower bars, each on its own time line above the multiplex bar. The
duration, starting time, and ending time of a program is indicated by the length
and horizontal position of the program bar. The figure below shows the dynamic
view of a configuration file that has five programs, each with its start time
delayed one second after the end of the previous program.

Multiplex global start time Estimated stop time

Previous

Program bar

Next

Slider
bar

Timing
cursor Multiplex

bar

Cursor
position

NOTE. When the dynamic view is visible, the rate gauge shows the actual
multiplex rate of the transport stream at the time indicated by the cursor
position.

There are several important features of the dynamic view:

� Multiplex Global Start Time. The beginning time of the multiplex. Double-
click the multiplex icon (in the hierarchic view) to set this time.

� Estimated Stop Time. The ending time for the multiplex, when all elementary
streams for all programs have been sent.

Features
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� Timing Cursor. Move the timing cursor by selecting the slider bar; hold the
mouse button down and slide the cursor to the desired location. Click the
multiplex bar on either side of the cursor to move the cursor one second at a
time. Once you have moved the cursor by sliding it or clicking the multiplex
bar, you can also move it 0.1 second at a time with the left and right arrow
keys.

� Previous. The dynamic view can display up to five program bars at once. If
there are more than five programs in the multiplex, click this button to
display the the program (if any) with the next lower number.

� Next. If there are more than five programs in the current multiplex, click this
command button to display the the program (if any) with the next higher
number.

� Program Bar. The program bar indicates the timing relationship of the
program relative to the entire multiplex. Double-click the program bar to
open a message window containing program timing values. Click anywhere
else in the multiplex window to dismiss the value message window.

The Multiplexer lets you set two timing offsets in addition to the global
multiplex start time: program start delay and elementary stream initial delay. You
can see the effects of all three delays in the following dynamic view, which
shows the timing relationships of three identical programs. The global multiplex
start time is 15.00 seconds, programs 2 and 3 have 15.5 second program start
delays, and the video elementary stream in program 3 has a 5 second initial
delay.

Timing Offsets
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The diagram below shows how all the timing delays fit together and how the
multiplexer handles the extra space created.

PAT, NIT, and
null packets onlyNo packets

PAT, NIT, PMT, and
null packets

no program packets

All packets

t0 t1 t2 t3

� t0 = 27 MHz system clock (clock-on-the-wall) is zero

� t1 = Global Multiplex Start Time (set in conjunction with the total bit rate)
see page 3–83

� t2 = Program Start Delay (set for each program) see page 3–89

� t3 = Elementary Stream Initial Delay (set for each video, audio, or data ES)
see pages 3–92, 3–94, and 3–95.

The Multiplexer Environment
To prevent confusion with transport stream configurations and configuration
files, this section refers to the Multiplexer application settings as the “environ-
ment” rather than the more familiar “configuration.”

You can change environment settings through three commands on the Options
menu: DVB, Dynamic SI, and Directories. You can save and restore environ-
ments through the remaining three Options menu commands; refer to Saving and
Restoring Multiplexer Environments, on page 3–77, for instructions.

The Multiplexer environment options are saved when you exit the application
and restored the next time you launch it. However, the DVB and Dynamic SI
settings become part of a configuration file when you save it. Therefore, opening
an existing configuration file can change the DVB and Dynamic SI settings.

Three commands on the Options menu control settings of the multiplexer
environment: DVB, Dynamic SI, and Directories.

DVB. The DVB (Digital Video Broadcasting) option determines whether DVB
Specific Information (SI) may be added to the configuration file. SI exists in the
NIT and up to four additional tables that are encoded into the multiplex
(transport stream). The SI tables contain information regarding services and
events carried on this multiplex as well as different multiplexes or even different
networks. Besides the NIT, the SI tables are the BAT, SDT, EIT, and TDT.

Environment Options
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� NIT (Network Information Table). The NIT provides information about the
physical network. This table is mandatory. (It appears under the PSI icon in
non-DVB mode.)

� BAT (Bouquet Association Table). The BAT provides information regarding
bouquets (collections of services marketed as a single item).

� SDT (Service Description Table). The SDT contains data describing the
services in the system. For example, the name of the services, the service
provider, etc.

� EIT (Event Information Table). The EIT contains data concerning events and
programs (a concatenation of one or more events under the control of a
broadcaster), such as event name, start time, duration, etc.

� TDT (Time and Date Table). The TDT contains information relating to the
current time and date.

The DVB option is off in the default Multiplexer environment and results in this
default non-DVB hierarchic view:
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When you toggle the DVB option on, the SI icon appears in the hierarchy and
the NIT moves beneath it. This is the default DVB hierarchic view:

You may add the appropriate SI tables to this hierarchy; refer to Adding and
Editing SI Tables, beginning on page 3–95, for more information.

Toggling the DVB option off when the hierarchy contains no SI tables simply
removes the SI icon and moves the NIT back under the PSI icon. However, if
you have added SI tables, a warning message reminds you that the SI tables will
be removed.

If you click Yes, the SI tables are removed from the configuration file (the
separate SI table files themselves are not deleted from the disk); if you click No,
the Multiplexer remains in DVB mode.

Dynamic SI. When Dynamic SI is selected, the multiplexer dynamically manages
the contents of the SDT and EIT according to the TDT time. All SDT running
status fields are changed according to the program state (running/not running).
The EIT is managed as follows:

� Present events are removed when necessary

� Following events become Present events

� Schedule events change to Following events when necessary
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If, when Dynamic SI is selected, you attempt to generate a multiplex from a
configuration file that does not contain a TDT, the Warning shown below
appears. Add a TDT and try again.

Directories. Use the Directories command to open the Directories Selection
dialog box to specify default directories for various types of files used by the
Multiplexer application.

The recommended directories are shown in the above illustration. Change
directories by entering the complete path in the appropriate text boxes; click OK
to accept the displayed paths and close the dialog box.
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Use the Save Environment, Load Environment, and Default Environment
commands of the Options menu to save and later restore multiplexer environ-
ments.

Save Environment. Choose Save Environment to save the current option settings
to a file; a standard Windows file saving dialog box opens.

The drive and directory settings are the selections made through the Directories
command. By default, the file receives the extension .mcf (multiplexer configu-
ration file). Enter a descriptive name for the settings file and click OK to save the
file and dismiss the dialog box.

Load Environment. Choose Load Environment from the Options menu to restore
a (.mcf) settings file that you saved earlier. If you choose Load Environment
when the DVB option is selected, the warning message shown below appears to
remind you that the DVB option may not be selected in another environment (the
warning should say “The SI tables can be suppressed”). Click OK to acknowl-
edge the warning.

A standard Windows Open dialog box appears. Again, the drive and directory
settings are the selections made through the Directories command. Change the
Drive and Directory if necessary and then select the appropriate (.mcf) file name.
Click OK to restore the settings and dismiss the dialog box.

Saving and Restoring
Multiplexer Environments
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Default Environment. Choose Default Environment to restore all the default
multiplexer settings. A warning message appears to give you one more chance to
reconsider. Click Yes to confirm the command; click No to cancel.

Because the DVB option is not selected in the default option settings, the
warning message shown on page 3–77 appears if you choose to restore the
default settings when DVB is selected. Click OK to acknowledge the warning. If
there actually are SI tables in the current multiplex configuration, yet another
message appears.

Click Yes to remove the tables from the current hierarchy; click No to restore all
defaults but the DVB option, which will remain selected.

Table 3–10 lists the default multiplexer options settings.

Table 3–10: The default multiplexer settings 

Option Default Setting

DVB Not selected

Dynamic SI Not selected

Directories

Output
Video Streams
Audio Streams
Data Streams:
SI Tables
Configurations

c:\mts100\cfg-trp
c:\mts100\video
c:\mts100\audio
c:\mts100\data
c:\mts100\cfg-trp
c:\mts100\cfg-trp
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Creating and Editing a Configuration File
To create an MPEG-2 or DVB transport stream with the multiplexer application,
you must first create a configuration file that describes the stream. A tutorial for
creating an MPEG-2 configuration file and transport stream begins on page
2–45; a tutorial for creating a configuration file with DVB information begins on
page 2–83.

This section explains the basic techniques and includes reference material
regarding configuration files.

To create a new configuration file, choose New from the File menu or click the
New button (the left-most command button on the tool bar). The standard
Windows dialog box appears.

Enter an appropriate name in the File name text box and click OK; the .cfg
extension is added automatically. The default hierarchy appears in the Multiplex
window.

Creating or Opening a
Configuration File
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To open an existing file, select Open from the File menu or click the Open
command button (the second button on the tool bar). The Configuration file
dialog box appears. Again, this is the standard Windows Open file dialog box.

Enter or select the file name and click OK (just as in any other Windows
application). The configuration file opens with its hierarchy in the Multiplex
window.

If you intend to create a DVB transport stream from the new configuration file,
be sure that DVB is selected in the Options menu before proceeding; if you do
not intend to include DVB (SI) tables in the eventual transport stream, check to
be sure that DVB is not selected. The status of the DVB option is saved with the
configuration file; therefore, opening an existing .cfg file can change the status of
the option. Refer to DVB under Environment Options, on page 3–73, for more
information.

To add items to the configuration file hierarchy, select the appropriate hierarchy
icon and choose Add from the Edit menu or click the Add (+) command button
on the Multiplexer tool bar. Table 3–11 summarizes the use of the Multiplexer
Add command.

Table 3–11: Using the Add command 

Icon Item Name Use the Add Command to
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Multiplex ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Add an empty program to the end of the hierarchy
(Up to 20 programs)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Service Information ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Add DVB files to the configuration
(Only available with DVB option.)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Program
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Add an elementary stream to the selected program
(Up to 10 elementary streams per program)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Video Stream
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Splice another video stream to the existing stream. The
multiplex rate of the added stream can be no higher than
that of the existing stream.

NOTE. The Add command is not available when other icons are selected.

The DVB Option

Adding and Editing
Hierarchy Items
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You can tell from the appearance of the Add and Delete command buttons
whether you can use the Add and Delete commands with the selected item. As
shown below, the + or – symbol on the button is highlighted (and appears blue
on the MTS 210 monitor) to indicate that the corresponding command is
available.

Add/Delete Add only NeitherDelete only

Refer to Deleting Hierarchy Items, on page 3–97, for more information about the
Delete command.

You can begin editing the contents or characteristics of most items by double
clicking on the icon. Table and Stream file associations and many other
parameters are edited from within the Multiplexer application. Table files
themselves are edited from within the Edit Table application, which you can
launch from the Multiplexer when necessary. Editing that can be done in the
Multiplexer is explained in this section; table editing is discussed in Using the
PSI and SI Table Editor, beginning on page 3–103.

Instructions for the following procedures appear in this section:

� Editing Multiplex Parameters (page 3–82)

� Editing the PSI Period (page 3–83)

� Editing PAT Parameters (page 3–84)

� Editing the PMT (page 3–85)

� Editing the NIT (page 3–85)

� Adding Programs to the Multiplex (page 3–88)

� Editing Program Parameters (page 3–88)

� Adding Elementary Streams to a Program (page 3–90)

� Selecting a Video Stream (page 3–91)

� Selecting an Audio Stream (page 3–93)

� Selecting a Data Stream (page 3–94)

� Adding and Editing SI Tables (page 3–95)
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Editing Multiplex Parameters. Double-click the MUX icon to open the Multiplex
Parameters dialog box.

Select or enter the appropriate multiplex rate and enter the global multiplex start
time, if appropriate. Click OK to accept the values and dismiss the dialog box.

The Multiplex Rate is the number shown in the multiplexer rate gauge. This
number defines the data rate for the generator. You can either define your own
multiplex rate (the default is 10 Mbits/s) or use one of the predefined G703
frequencies: 8.448 MHz or 34.368 MHz.

NOTE. If you are creating a transport stream file for a G.703 port, you MUST
select either the 8.448 or the 34.368 MHz option for the correct G703 rate.



Using the Multiplexer

Tektronix MPEG Test System User Manual 3–83

The global multiplex start time is the system clock time at the beginning of the
transport stream. You can see the effect of changing the start time in the dynamic
view.

Multiplex start time

Editing the PSI Period. Double-click the PSI icon to open the PSI Period dialog
box.

Enter the appropriate period for the PAT and PMT. Click OK to accept the value
and dismiss the dialog box. MPEG-2 requires a PSI period of 0.1 s (10 times per
second) or less. However, the Multiplexer allows you to set this number out of
specification in order to thoroughly test your receiving system. Remember that if
you make the period too small, you will have less of the available multiplex rate
left in the transport stream for other, perhaps more important, information.
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Editing PAT Parameters. Double-click the PAT icon to open the Program
Association Table dialog box.

To change the transport stream ID, enter the new value in the text box and click
OK. To change the PID of a PMT section, highlight the section entry in the PID
Values list box and then click Modify. Enter the desired PID number in the
resulting PID Modification dialog box and click OK in both the PID Modifica-
tion box and in the Program Association Table dialog box.

NOTE. The Multiplexer automatically assigns PIDs when you add programs and
tables. You need not change program PIDs unless the intended stream use
requires it. Many table PIDs are specified in the appropriate MPEG or DVB
standard. Do not change a table PID unless you know the consequences and
have a good reason for doing so.
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Editing the PMT. Double-click on the PMT icon to start the Edit Table application
with the .PMT file open for editing (the application creates the .PMT file if it
does not already exist).

You can enter appropriate information in the Edit window, on the right half of
the Edit Table application window, and you can add descriptors by clicking the
Add (+) command button. Refer to Using the PSI and SI Table Editor, beginning
on page 3–103, for complete instructions.

Editing the NIT. Double-click the NIT icon to open the NIT dialog box.

If you have not already associated a .NIT file with the NIT icon, the table name
field will contain only the word “default.” You must select a file, through the
Browse button, before you can edit the Network Information Table.
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1. Click Browse in the NIT dialog box. The Selection SI File dialog box
appears; select DEFAULT.NIT or another file to use as a template. When
you complete file selection (either by double-clicking the file name or by
highlighting the file name and clicking OK), the file selection dialog box
closes and leaves the NIT dialog box open. The name of the opened file is in
the table name field.

2. Click Edit to start the Edit Table application with the selected .NIT file open
for editing.

3. Use the Save As command on the Edit Table File menu to save the table
under a new, unique name (usually the name of the configuration file); the
table automatically receives the .NIT filename extension when you save it.

4. Edit the table as necessary. You can enter appropriate information in the Edit
window, on the right half of the Edit Table application window, and you can
add transport streams or descriptors by clicking the Add (+) command
button. Refer to Using the PSI and SI Table Editor, beginning on page
3–103, for complete instructions.

5. Save the file again before exiting Edit Table. If you attempt to exit without
saving changes to the table, the Save Table dialog box opens to give you the
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opportunity to save the changes, ignore the changes and exit the application
anyway, or cancel the exit command and return to the Edit Table application.

6. After you exit Edit Table, the NIT dialog box remains in front of the
Multiplexer application window with the original file name (usually
DEFAULT.NIT) in the table name box.

7. Click Browse to open the Selection SI Tables dialog box and select the
newly edited and saved table.
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8. If appropriate, change the period (the time between occurrences of the NIT in
the transport stream). Then click OK to accept the NIT file and its period
setting and to dismiss the NIT dialog box. The name of the table file and the
period appear to the right of the NIT icon in the Multiplexer hierarchic view.

Adding Programs to the Multiplex. To add a program to the hierarchy, select the
MUX (multiplex) icon and then click the Add (+) command button. A new
program icon is added to the end of the configuration hierarchy. A transport
stream can contain up to 20 programs.

Adding a program automatically adds a section to the PMT and updates the PAT
to reference the PID of the new section. Once you have added a program, be sure
to edit the program parameters and add elementary streams, as necessary.

Editing Program Parameters. Double-click on the Program icon to open the
Program Parameters dialog box and set the PCR (Program Clock Reference)
period and program start delay.

The PCR period determines the frequency of program clock references in the
program stream. MPEG-2 requires at least 10 clock references per second, for a
maximum of 0.1 seconds between PCR signals. If you enter a PCR period over
0.1 seconds, you will receive a warning when you close the Program Parameters
dialog box.
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NOTE. The Multiplexer encodes the PCR by default with the first elementary
stream you add to the program. You can, however, change the PID of either PCR
or elementary stream when you edit the PMT (see page 3–85 for instructions). If
the PCR is not encoded with one of the elementary streams, it will be in its own
packets. This may be useful for some applications or experiments.

Program start delay determines the start time of the program relative to the
beginning of the transport stream. Select dynamic view to see the effect of
program start delay.

The above dynamic view shows how program start delay affects the resulting
transport stream. Each of the five programs starts at a different time. The start
delays allow the transport stream to carry more information than if all programs
started at the same time.
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Adding Elementary Streams to a Program. Adding an elementary stream to a
program is a two-step process. First, add a video, audio, or data stream icon to
the hierarchy. Then associate a file (of the appropriate type) with the stream icon.

To add a stream icon to the program, select the program icon and click the Add
(+) button or press INSERT. The Stream to add dialog box opens.

Select the type of stream that you wish to add and click OK. The appropriate
icon appears in the hierarchy as a component of the selected program. Each new
stream icon is simply added to the end of the program’s list. Elementary streams
are not sorted by type.

Now you must associate a stream file with each new icon. Begin the process by
double-clicking on the elementary stream icon; refer to Selecting a Video Stream
(on page 3–91), Selecting an Audio Stream (on page 3–93), or Selecting a Data
Stream (on page 3–94) for more information.

CAUTION. Although MPEG-2 transport streams allow elementary streams with
encoding changes between field and frame, the Multiplexer does not support
such changes.
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Selecting a Video Stream. Double-click on the Video icon to open the Video
Stream dialog box. Through the dialog box, name a video stream file and set
several parameters that determine how the Multiplexer encodes the stream.

Either enter the complete path and file name in the video file name box or click
Browse to select the video elementary stream. Browse opens a standard
Windows file selection dialog box. You can select a file with any file extension,
but the Multiplexer application will not accept the file unless it has the correct
video sequence header.

There are five editable parameters (in addition to the file selection) in this dialog
box. The remaining parameters are extracted from the file’s video header and are
included as information only. The editable information includes elementary
stream rate, PES packet size, elementary stream initial delay, offset DTS, and use
of the sequence header.

� The elementary stream rate is the rate at which the elementary stream is to be
multiplexed into the transport stream, after compression. The default value is
the rate specified in the elementary stream header. This is the recommended
value. You can change the rate to meet your specific requirements, as long as
you do not intend to decode the transport stream in real time. A rate that is
too slow will not give the decoder all the information required to decode in
real time.
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� The PES packet size can range from 100 to 64000 bytes; the default is 2048
bytes. If you specify a packet size of 0, the Multiplexer will put the complete
video picture in one PES packet.

� The elementary stream initial delay determines when the elementary stream
begins appearing in the transport stream. The delay is relative to the start of
the program, which can have its own delay relative to the start of the
transport stream (refer to Editing Program Parameters, on page 3–88, for
more information). Delaying the start of the elementary stream extends
program length by an equal amount of time but does not reduce the fraction
of multiplex rate used during the delay.

NOTE. The multiplex rate is not reduced during an elementary stream initial
delay. Null packets fill in to replace elementary stream packets in the time
between the start of the program and the start of the elementary stream.

� Offset DTS is the time interval between the PTS (presentation time stamp)
and the DTS (Decode Time Stamp).

� Sequence header, when selected, causes the Multiplexer to ignore any video
stream data before the first sequence header. If you leave Sequence Header
unchecked, the Multiplexer inserts the entire video stream into the multiplex.

When you are done selecting the video stream file and setting the stream
parameters, click OK to confirm the choices and close the dialog box. Informa-
tion about the selected file appears to the right of the video icon.



Using the Multiplexer

Tektronix MPEG Test System User Manual 3–93

Selecting an Audio Stream. Double-click on the Audio icon to open the Audio
Stream dialog box. Through the dialog box, name an audio stream file and set
parameters that determine how the Multiplexer encodes the stream.

Either enter the complete path and file name in the audio file name box or click
Browse to select the audio elementary stream. Browse opens a standard
Windows file selection dialog box. You can select a file with any file extension,
but the Multiplexer application will not accept the file unless it has the correct
audio header information.

There are four editable parameter fields in the Audio Stream dialog box:
elementary stream rate, PES packet size, elementary stream initial delay, and
offset PTS.

� The elementary stream rate is the rate at which the elementary stream is to be
multiplexed into the transport stream. The default value is the rate specified
in the elementary stream header. This is the recommended value. You can
change the rate to meet your specific requirements as long as you do not
intend to decode the transport stream in real time. A rate that is too slow will
not give the decoder all the information required to decode in real time.

� The PES packet size can range from 100 to 64000 bytes.



Using the Multiplexer

3–94 Tektronix MPEG Test System User Manual

� The elementary stream initial delay determines when the elementary stream
begins appearing in the transport stream. The delay is relative to the start of
the program, which can have its own delay relative to the start of the
transport stream (refer to Editing Program Parameters, on page 3–88, for
more information). Delaying the start of the elementary stream extends
program length by an equal amount of time, but does not reduce the fraction
of multiplex rate used during the delay.

� Offset PTS is the interval between the PTS (presentation time stamp) and
arrival time.

When you are done selecting the audio stream file and setting the stream
parameters, click OK to confirm the choices and close the dialog box. Informa-
tion about the selected file appears to the right of the audio icon.

Selecting a Data Stream. Double-click on the data icon to open the Data Stream
dialog box. Through the dialog box, name a data file and set parameters that
determine how the Multiplexer encodes the stream.

Either enter the complete path and file name in the file box or click Browse to
select the data file. Browse opens a standard Windows file selection dialog box.
You can select a file with any file extension.

� Rate determines how quickly the data is multiplexed into the transport
stream. The default value is 0.1 Mbit/s.
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� The initial delay determines when the data begins appearing in the transport
stream. The delay is relative to the start of the program and works in the
same way as the initial delays for the video and audio elementary streams.

� Use the data format selections to specify how the data is to be formatted in
the transport stream. Select without format if the data is not in PES or
section format. Select PES format if the data is in PES format. Select Section
if the data is in section format. Select Loop sections if the data is in section
format and the sections should be looped.

When you are done selecting the data file and setting the stream parameters,
click OK to confirm the choices and close the dialog box. Information about the
selected file appears to the right of the data icon.

Adding and Editing SI Tables. The SI icon is present in the Multiplexer hierarchy
when DVB is selected on the Options menu.

To add or edit SI tables (NIT, BAT, SDT, EIT, and TDT), select the SI icon and
click the Add (+) command button, select the icon and press INSERT, or
double-click the SI icon.

Select the SI icon and use the Add command (or press INSERT) to add one SI
table at a time.
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Double-click the SI icon to open the DVB File Selection dialog box and
select/edit two or more of the tables.

Use the same selection and editing techniques that are described for the NIT
beginning on page 3–85:

1. Select a template table file either by entering the name directly into the text
box (use the full path name) or by clicking Browse.

2. Click Edit to open the Edit Table application. Be sure to save the table file
under a new name (usually the name of the configuration file).

3. When you are done editing the table and have returned to the table dialog
box, select the newly edited and renamed table file either by clicking Browse
or by entering the path and table name in the file name box.

4. Change the table period if necessary. You may wish to set the period much
higher than the standard 0.5 seconds to create a transport stream that
thoroughly exercises the MPEG-2 receiving equipment.

5. When you are finished, click OK (not Cancel) to confirm the table selec-
tion(s) and table period(s).
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A tutorial for creating a configuration file with DVB information begins on page
2–83. The tutorial contains detailed instructions for adding the SI table files. For
more complete information about editing the tables, refer to Using the PSI and SI
Table Editor, which begins on page 3–103.

Once you add a table, you can later double-click the (NIT, BAT, SDT, EIT, or
TDT) icon to open a table dialog box and select a new table file, edit the table, or
set the table period.

The Delete command on the Edit menu deletes the selected item and any icons
under it. For example, if you delete a program, all the associated elementary
streams are also deleted.

You can only delete the following:

� Programs (check first if it has elementary streams)

� Elementary Streams: Video, Audio, and Data

� SI Tables: EIT, SDT, BAT, TDT, and NIT (replaced with the default NIT).
The SI itself cannot be deleted. If you want to remove the SI, deselect DVB
in the Options menu; refer to DVB, on page 3–73, for more information.

If the NIT file exists (and is different from the default), the current NIT is
replaced by the default NIT. An NIT must always be present. If you try to delete
the NIT and it is already the default NIT, no action occurs, even though the
command is available. The BAT, SDT, or EIT are simply deleted from the
configuration file. The multiplex rate and the Rate Gauge are updated after each
deletion from the SI file.

If you choose to delete a program and it is not empty (it has elementary streams),
a dialog box appears requesting confirmation before the Multiplexer application
will delete the program.

When you delete a program, its PID is automatically removed from the PAT.

If an elementary stream is selected, it deletes the selected elementary stream. The
Rate Gauge is then updated.

The Delete command in the Edit menu is equivalent to the Delete (–) command
button on the upper tool bar.

Deleting Hierarchy Items
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Generating a Multiplex
Once you have finished creating a configuration file, you may generate the
described multiplex/transport stream by choosing Go from the Multiplex menu
or by clicking the equivalent command button.

Go (generate
a Multiplex)

If the configuration file definition is not complete, transport stream generation
does not begin, and a message box appears to indicate the problem. The
multiplex definition is not complete in the following cases:

� There is an empty program (a program without an elementary stream).

� There is an undefined elementary stream or the Multiplexer cannot find the
linked file.

After checking the validity of data, a dialog box opens up and asks for the TS
file name. It always starts with the current configuration name with the .trp
extension. That name is not required and you can change it as desired. (The .trp
extension is required.)

You can place the transport stream file directly on the Data Store Disks. The
c:\carb0\mono directory is the link to the Data Store Disks.

NOTE. Although Windows NT as installed on the MTS 210 cannot handle files
larger than 2 GB, files greater than this may be generated and placed directly on
the Data Store Disks.

The duration gauge shows the progress of multiplex generation.

Times shown are “real” stream times; actual .trp file generation takes much
longer.

� Time (on the left side of the gauge) indicates the stream time elapsed since
the beginning of the stream; it is equivalent to bits written divided by the
multiplex rate.

� Estimated Final Time is an estimate of the duration of the entire stream.
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� The percentage shown on the gauge is simply the current Time (on the left
side of the gauge) divided by the Estimated Final Time (times 100).

� Running Time shows the actual stream duration after generation is complete.

During transport stream file generation, all other commands are disabled
(grayed). Press the ESC key to stop multiplex calculation at any time.

An Example Configuration File
You can view (and edit) configuration files with any text editing application such
as Notepad, which is included with Windows NT. An example of a configuration
file is shown below. Notice that each heading is enclosed in brackets.
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Using the PSI and SI Table Editor

With the PSI and SI Table Editor application, you can create and edit the
following components of MPEG-2 and DVB transport streams/multiplexes:

� MPEG-2 Program Specific Information (PSI) contained in the PMT
(Program Map Table).

� Digital Video Broadcasting Specific Information (DVB-SI), contained in five
different tables:

Network Information Table (NIT)

Service Description Table (SDT)

Event Information Table (EIT)

Bouquet Association Table (BAT)

Running Status Table (RST)

PSI tables give information pertaining only to the multiplex that contains them.
The PMT identifies and indicates the locations of the streams that make up each
service and the Program Clock Reference (PCR) fields for a service. The table is
transmitted in sections.

In contrast, DVB-SI tables provides information on services and events carried
by different multiplexes and other networks.

� The NIT conveys information relating to the physical organization of the
multiplex, the transport streams carried on a given network, and the
characteristics of the network itself.

Transport Streams are identified In the NIT by the combination of an original
network ID and a transport stream ID.

� The BAT provides information regarding bouquets (collections of services
that are marketed as a single entity).

� The SDT contains data describing the services in the system.

� The EIT contains data concerning events and programs, such as event name,
start time, duration, etc.. (An event is a grouping of elementary broadcast
data streams with a defined start and end time belonging to a common
service. A program is a concatenation of one of more events under the
control of a broadcaster.)

The PSI and SI Table Editor application can also display a global view of the
relationships between the various SI tables.
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For brevity, the PSI and SI Table Editor application is referred to as the Edit
Table application throughout this manual.

NOTE. This software complies with Draft prETS 300 468 May 1996 document.
Please refer to this document for more details on parameter values in order to
generate correct tables.

Edit Table Application Window
You can access the Edit Table application in two ways.

� Through the Windows Start menu.

� While in the Multiplexer application, double-click the PMT icon or select
Edit in one of the SI table dialog boxes (this method ensures correct
association of the table and configuration files.)

The Figure below shows the default application window with the default PMT
table file displayed. Most parts of the Edit Table window are similar for all table
types. The exceptions are the Hierarchy window and Edit window.

Menu bar
Toolbar

Hierarchy
window

Edit window

Status bar
Toolbar

The Hierarchy window shows the structure of the currently selected table.
Additions to and deletions from the table are made in this window. Insert and
change the parameter values in the Edit window.

Hierarchy Window
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The Edit window displays and edits the parameters contained in the currently
selected icon. If you want to add or delete an entire item, select it from the
Hierarchy window.

The following section lists the commands available from the Menu bar and
explains their function and use.

File Menu. The File menu provides the commands for file management. It
accesses the Global View and opens new or existing table files. It also closes the
application.

With no tables open With at least one table open

Use To

New Create a new table file

Open Open an existing table file

Save Save the current selection to disk

Save as Save the current selection with a new file name
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Save All ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Save all open tables to their respective files
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Close ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Close the currently selected table
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Global View ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Show the association between selected NIT, SDT, and EIT table
files

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Exit ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Exit (quit) the Edit Table application
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Program Map Table ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the current PMT. If a PMT is not currently open, then you
can either create a new one or open an existing PMT file.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Network Information
Table

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the current NIT table file. If an NIT file is not currently open,
then you can either create a new file or open an existing NIT file.

Edit Window

Menu Commands
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Use To

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Service Descriptor Table ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the current SDT file. If an SDT file is not currently open,
then you can either create a new file or open an exiting SDT file.

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Bouquet Association
Table

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the current BAT file. If a BAT file is not currently open, then
you can either create a new file or open an existing BAT file.ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Event Information Table
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the current EIT file. If no EIT file is currently open, then you
can either create a new file or open an existing EIT file.

Running Status Table Display the current RST file. If no RST file is currently open, then
you can either create a new file or open an existing RST file.

Edit Menu. The Edit menu allows you to add and delete items from the table files.

Use To
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Add ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Add various items to the table file
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Delete
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Delete the currently selected item and all its sub-items. Deleted items
are not copied to the Windows clipboard. (The main icon cannot be
deleted.)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Cut ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Cut the currently select item and all its sub-items and copy them to
the Windows clipboard. (The main icon cannot be deleted.)ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Copy
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Copy the currently selected item and all available sub-items to the
Windows clipboard. (The main icon cannot be copied to the clipboard.)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁPaste

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁPastes the content of the clipboard at the currently selected location

Section Menu. Each table file can have up to 800 sections.
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The sections of a PMT correspond to programs. The sections of an NIT describe
the physical organization of the multiplex (network). The sections of the SDT
describe transport streams. The sections of a BAT describe a bouquet. The
sections of the EIT each describe a service.

Use To
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Next
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Display the next section. (Current section number + 1.)ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁPrevious

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁDisplay the previous section. (Current section – 1.)ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁNumber
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁDisplay the entered section numberÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁNew
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁCreate a new section with the default valuesÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Delete
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Delete the current section. (No warning or recovery.)

Analysis Menu. The Analysis menu allows you to check the integrity of your
table files.

Use ToÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Coherence
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Check the open table files for both internal and intra-table
coherence to the standards. Refer to Coherence Analysis, on
page 3–115.

Help Menu. The Help menu provides standard Windows and application-specific
information.

Use To

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Index ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Launch Windows Help, if necessary, and open the Edit Table help
indexÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

About
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Open the About window and discover version information about the
Edit Table application
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The command buttons on the upper and lower toolbars act as shortcuts for
several menu commands. Table 3–12 lists the tool bar commands and their
functions.

Upper buttons

Lower buttons

Table 3–12: Functions available from the tool bars 

ÁÁÁ
ÁÁÁ

IconÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Function ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Equivalent Menu Command

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select, create, or open a PMTÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Program Map Table

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select, create, or open an NITÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Network Information Table

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select, create, or open an SDT
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Service Description Table

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select, create, or open a BAT
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Bouquet Association Table

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select, create, or open an EITÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Event Information Table

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Select, create, or open an RSTÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Running Status Table

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Add an item to the selection ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Edit: Add (see page 3–116)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Cut the selected item
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Edit: Cut (see page 3–119)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Analyze the table coherence
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Analysis: Coherence

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Access the Global View ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

File: Global View (see page 3–148)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

View the previous section 
(current section number –1)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Section: Previous (see page 3–113)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

View a specific section ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Section: Number... (see page 3–113)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

View the next section
(current section number +1)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Section: Next (see page 3–113)

The Command Buttons
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Table 3–13 lists all of the icons that may be displayed and their meanings.

Table 3–13:  Icons used in the Edit Table application

ÁÁÁ
ÁÁÁ

Icon Meaning

Beginning of a Program Map Table (PMT only)

Beginning of a Network Information Table (NIT and global view only)

Beginning of a Service Descriptor Table (SDT and global view only)

Beginning of Bouquet Association Table (BAT only)

Beginning of an Event Information Table (EIT and global view only)

Elementary Stream (PMT only)

Transport Stream (NIT, BAT, and global view only)

Service (SDT and global view only)

Event (EIT and global view only)

Descriptor

Subdescriptor

A service defined as a TV service (in a descriptor); its name appears instead of its
Service ID number (Global View only)

A service defined as a Radio service (in a descriptor); its name appears instead of its
Service ID number (Global View only)

A service defined as a Teletext service (in a descriptor); its name appears instead of
its Service ID number (Global View only)

Hierarchy Icons
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Table File Operations
Table descriptions are contained in individual files that are manipulated much
like any other file in Windows NT. Unlike document files in a typical word
processing application, however, only one table file of a given type (PMT, NIT,
SDT, BAT, EIT, or RST) can be open at a time.

Choose the New command from the File menu to open the Table Type dialog
box. Select the desired option button (PMT, NIT, SDT, BAT, or EIT) and then
choose OK.

If a table of the selected type is open, the table editor automatically closes it
unless you have changed the table since it was last saved. If there are unsaved
changes, Edit Table opens the Save Table dialog box to give you the opportunity
to save the changes before closing the file, ignore the changes and close the file,
or cancel the New command.

Creating a New Table
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To open an existing table file, choose Open from the File menu. The Table Type
dialog box is opened; select the appropriate table type and click OK. A standard
Windows Open dialog box appears.

Select the desired table file from the list. (You can change directories as
required.)

After selecting the OK command button, the selected file is displayed in the
Hierarchy and Edit windows.

The Save, Save As, and Close commands (in the File menu) work as in most
other Windows applications. The Edit Table application also has a convenient
Save All command that lets you save all open table files in one operation.

Save. The Save command saves the current table file. If the current table file is
untitled, then the Save As dialog box is automatically displayed.

Save As. Choose the Save As command to save a table file under a new name.
The Windows Save As dialog box appears. Enter a new name in the File Name
Text box and choose OK. The correct extension for the table type (.pmt, .nit,
.sdt, .bat, .eit, or .rst) is added automatically to the file name.

NOTE. The Edit Table application requires the correct file name extension. Do
not use a different extension.

Save All. The Save All command allows you to save all open table files at the
same time. (The Save command only saves the current file.) If any of the files is
untitled, it will automatically provide the Save As dialog box. After you name
the file, the application continues saving the remaining files.

Opening an Existing Table

Saving Tables



Using the PSI and SI Table Editor

3–112 Tektronix MPEG Test System User Manual

Close. The Close command closes the current table file window, but it does not
close the application.

The Save Table dialog box appears if the table file has unsaved changes or if it is
currently untitled. You can then either save the file, ignore the changes (and close
without saving), or cancel the close command.

In Edit Table, you can have only one of each table type open at a time, and you
can display only one of the open tables at a time. To quickly select among all
open tables, click the command button that corresponds to the desired table type
or select the type of table from the File menu.

Selecting Among
Open Tables
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Table Sections
The sections of a PMT correspond to programs. The sections of an NIT describe
the physical organization of the multiplex (network). The sections of the SDT
describe transport streams. The sections of a BAT describe a bouquet. The
sections of the EIT each describe a service. Each table file can have up to 800
sections.

Section information

The Section menu contains commands for moving among table sections.

Next. Choose the Next command (or click the Next command button on the
lower tool bar) to display the next section of the table file. (Next is defined as the
current section number +1.)

If the last section is currently displayed, you will receive an error message and
the application will continue to display the current section.

Previous. Choose the Previous command (or click the Previous command button)
to display the previous section of the current table file. (Previous is defined as
the current section –1.)

If the first section is currently being displayed, you receive an error message and
the application continues to display the current section.
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Number. Choose the Number command, or click the Go To (?) command button,
to select the section number to display (rather than scrolling through them). The
Section Number dialog box appears.

Enter the desired section number in the text box and choose OK. The application
then displays the desired section number. If you enter a section number that is
beyond the range of available section numbers, the last available section is
displayed.

New. The New command adds a new section at the end of the table file and then
displays that section. For example, if you are initially displaying section 2 of 5,
after the New command, section 6 of 6 is displayed.

The new section contains only the default information for that table file.

Delete. The Delete command removes the currently displayed section. If the
deleted section is a middle section, the sections that follow are then appropriately
renumbered.

CAUTION. Sections are deleted without confirmation. Take care when using this
command; deleted sections cannot be recovered.
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Coherence Analysis
Choose the Coherence command (on the Analysis menu) or click the A button
on the tool bar to conduct an analysis of all open table files (not just the table file
displayed). The application returns with a report listing any non-conformities to
the standard, both within a table file (INTRA ANALYSIS) and between the open
table files (INTER ANALYSIS).

Double-click on any error listed in the Messages window to select the table and
item (such as a stream, event, service, or descriptor) that contains the error. The
hierarchy of the appropriate table section will be displayed in the Hierarchy
window; the non-conforming table item will be selected with its parameters
visible in the Edit window.

You can correct the errors through the Edit window and then rerun the Coherence
Analysis to check the corrections. The message box shown below appears after
an analysis of error-free table files.
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Adding Table Items
To add an item to a table section, first select the insertion point by clicking the
appropriate table, stream, loop, or descriptor icon. Then choose Add from the
Edit menu or click the Add (+) command button on the upper tool bar. Where
there is only one appropriate type of item, that item is automatically added. In
most cases, however, Edit Table opens a dialog box for specifying the type of
item to add.

The items available depend on the table type and the insertion point. At the table
icon level, you have the following choices:

Selected icon Items that can be added

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PMT ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

An elementary stream or a descriptor

NIT or BAT A transport stream or a descriptor

SDT A service

EIT An event or a descriptor

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

RST ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

An event

You can add the following items at the stream, event, or service level:

Icon Items

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Elementary stream ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Another elementary stream or a descriptor

Transport stream Another transport stream or a descriptor

Service Another service or a descriptor

Event (EIT) Another event or a descriptor

Event (RST) Another event
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At the stream/service/event level, a stream, service, or event is added “in
parallel” to the existing item; a descriptor is added to the item.

Stream selected,
stream added

Stream selected,
descriptor added

At the descriptor level, you can add another (parallel) descriptor. You can also
add a subdescriptor to some types of descriptor (refer to Table Item Parameters,
beginning on page 3–120).

Descriptor selected,
subdescriptor added

Descriptor selected,
descriptor added

At the subdescriptor level, you can add another, parallel subdescriptor or—in
one case—a sub-subdescriptor.

Subdescriptor selected,
subdescriptor added

Subdescriptor selected,
sub-subdescriptor added
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When you add a transport stream, service, or event, the icon is placed immedi-
ately in the hierarchy. When you choose to add an elementary stream to a PMT,
the following warning window appears.

Because it is likely to produce incoherence, you may not add or delete elementa-
ry streams when you start Edit Table from the Multiplexer application.

After you add a new item, select the icon and enter the appropriate values in the
Edit window text boxes on the right side of the Edit Table application window.
See Table Item Parameters, beginning on page 3–120, for more information
about the various stream, service, and event parameters.

When you select Descriptor in the Add dialog box and click OK, Edit Table
opens the Descriptors Selection dialog box.

1. Select the type of descriptor you wish to add from the drop-down List of
Descriptors.

Adding a Stream,
Service, or Event

Adding Descriptors
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2. Click Add. The descriptor name appears in the Descriptors Selected list.

3. Repeat steps 1 and 2 until the Descriptors Selected field lists all desired
descriptors.

4. Click OK to add the selected descriptors to the table and hierarchy.

5. Select the descriptor icons one at a time and enter the appropriate informa-
tion in the Edit window text boxes. See Table Item Parameters, beginning on
page 3–120, for more information about the various descriptor parameters.

Use the Delete, Cut, Copy, and Paste commands of the Edit menu as you would
in any Windows application to edit the table section.

Delete. The Delete command removes the selected item and any items below it in
the hierarchy display. The icons that represent the file type can not be deleted.
The delete command does not place removed items onto the clipboard.

Cut. The Cut command is identical to the Delete command except that cut items
are placed on the clipboard. They can then be pasted back in the table file at the
same or a different location.

Copy. The Copy command copies the currently selected item to the clipboard. It
is then available to paste at different locations. All items below the selected item
on the hierarchy are also copied to the clipboard.

You cannot copy the entire table with this command. If you wish to copy the
entire table, use the File menu Save As command and save the table file under a
different name.

Paste. The paste command places the contents of the clipboard at the selected
point in the table file.

Removing and Copying
Table Items
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Table Item Parameters
Editing a table involves entering the appropriate information and parameter
values for each table section, elementary stream, descriptor, and subdescriptor.
For example, an SDT must have the appropriate original network ID and
transport stream ID if it is to be associated with the correct transport stream.

This section lists the fields and parameters of each item available in the MTS 210
Edit Table application. Other parameters are either fixed or determined automati-
cally by the application. If you need more information about PSI and SI table
items, refer to Learning More About Table Items, on page 3–146.

You can specify the parameters of five PSI and SI tables: PMT, NIT, SDT, BAT,
and EIT.

PMT. The Program Map Table identifies the streams that make up each service
and indicates the packets that contain the service streams and PCRs.

Parameter Possible Values Notes

Program number 0 to 65535 Identifies the program

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the drop-down list box or
enter 0 or 1; the corresponding entry
changes automatically.

PCR PID 0 to 8191 The PID of the transport packets that
contain the PCR fields for this program. By
default, it is the PID of the first ES in the
program. If you enter a PID other than
those of the program streams, the PCRs
reside in their own transport packets.

Tables
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A PMT may be further defined with the addition of the following descriptors:

Registration
Conditional_access
ISO_639_language
System_clock
Multiplex_buffer_utilization
Copyright
Maximum_bitrate
Private_data_indicator
Smoothing_buffer
Service_move
User defined

Refer to PSI Descriptors (page 3–128) and SI Descriptors (page 3–134) for more
information.

NIT. The Network Information Table conveys information relating to the physical
organization of the multiplexes (transport streams) carried on a given network
and to the characteristics of the network itself.

Parameter Possible Values Notes

Table ID 64 (actual network)
65 (other network)

Select through the drop-down list box or
enter 64 or 65; the corresponding entry
changes automatically.

Network ID 0 to 65535 ETSI publication ETR 162 lists valid IDs
for various networks.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the drop-down list box or
enter 0 or 1; the corresponding entry
changes automatically.

An NIT may be further defined with the addition of the following descriptors:

Network_name
Stuffing
Linkage
Private_data_specifier
User defined

Refer to SI Descriptors, beginning on page 3–134, for more information.
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SDT. The Service Description Table lists the names and other parameters
associated with each service in a particular multiplex.

Parameter Possible Values Notes

Table ID 66 (actual transport
stream)
70 (other transport stream)

Select through the drop-down list box or
enter 66 or 70; the corresponding entry
changes automatically.

Transport stream ID 0 to 65535 Identifies the transport stream that this
SDT pertains to.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the drop-down list box or
enter 0 or 1; the corresponding entry
changes automatically.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

An SDT may be further defined with the addition of the following descriptors:

Stuffing
Bouquet_name
Service
Country_availability
Linkage
NVOD_reference
Time_shifted_service
Mosaic
CA_identifier
Telephone
Private_data_specifier
User defined

Refer to SI Descriptors, beginning on page 3–134, for more information.
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BAT. The Bouquet Association Table provides a means of grouping services that
might be used as one way a decoder presents the available services to the viewer.
A particular service can belong to one or more bouquets.

Parameter Possible Values Notes

Bouquet ID 0 to 65535 ETSI publication ETR 162 lists valid IDs
for various bouquets.

Version number 0 to 31 Incremented by 1 when the information
contained in the table section changes.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the drop-down list box or
enter 0 or 1; the corresponding entry
changes automatically.

A BAT may be further defined with the addition of the following descriptors:

Stuffing
Bouquet_name
Country_availability
Linkage
CA_identifier
Private_data_specifier
User defined

Refer to SI Descriptors, beginning on page 3–134, for more information.

EIT. The Event Information Table is used to transmit information relating to all
events that occur or will occur in the MPEG multiplex. The EIT contains
information about the current transport stream and optionally covers other
transport streams that the decoder can receive.

Parameter Possible Values Notes

Table ID 78 (actual TS present/follow)
79 (other TS present/follow)
80 to 95 
(actual TS, schedule)
96 to 111
(other TS, schedule)

Select through the drop-down list box or
enter the appropriate number; the
corresponding entry changes automati-
cally.

Service ID 1 to 65535 Must be the same as the program
number in the corresponding PMT.

Current next indicator 0 (not yet applicable)
1 (currently applicable)

Select through the drop-down list box or
enter 0 or 1; the corresponding entry
changes automatically.
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Parameter NotesPossible Values

Section number 0 to 255 Is incremented by 1 for each additional
section with the same table ID, service
ID, TSID, and original network ID.

Last section number 0 to 255 The number of the last section with the
same table ID, service ID, TSID, and
original network ID.

Transport stream ID 0 to 65535 Identifies the transport stream that this
EIT pertains to.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

Segment last section
number

0 to 255 The last section of this subtable seg-
ment. If the subtable is not segmented, it
is the same as the last section number.

Last table ID 0 to 255 The last table ID used. Equal to the ID of
this table, if there are no other tables.

The PMT can have up to ten elementary streams. A transport stream (and
therefore a single PMT) can have no more than five elementary streams of a
given type.

Parameter Possible Values Notes

Stream type see table below Select through the drop-down list box;
Edit Table changes the corresponding
value.

Elementary PID 16 though 8190 Assigned automatically by Edit Table;
change to prevent conflicts with other
elementary streams in other programs.

Stream Types. The following stream types may be assigned:

Stream Type Description Value

ITU–T | ISO/IEC Reserved 0

ISO/IEC 11172 Video 1

ITU–T Rec. H.262 | ISO/IEC 13818–2 Video or ISO/IEC 11172–2 constrained
parameter video stream

2

ISO/IEC 11172 Audio 3

ISO/IEC 13818–3 Audio 4

ITU–T Rec. H.222.0 | ISO/IEC 13818–1 private_sections 5

ITU–T Rec. H.222.0 | ISO/IEC 13818–1 PES packets containing private data 6

Elementary Streams
(in PMT)
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Stream Type Description Value

ISO/IEC 13522 MHEG 7

ITU–T Rec. H.222.0 | ISO/IEC 13818–1 Annex A DSM CC 8

ITU–T Rec. H.222.1 9

ISO/IEC 13818–6 type A 10

ISO/IEC 13818–6 type B 11

ISO/IEC 13818–6 type C 12

ISO/IEC 13818–6 type D 13

ISO/IEC 13818–1 auxiliary 14

ITU–T Rec. H.222.0 | ISO/IEC 13818–1 Reserved 15 – 127

User Private 128 – 255

Descriptors. An elementary stream may be further defined with the addition of
the following descriptors:

Video_stream
Audio_stream
Hierarchy
Registration
Data_stream_alignment
Target_background_grid
Video_window
Conditional_access
ISO_639_language
Multiplex_buffer_utilization
Copyright
Maximum_bitrate
Private_data_indicator
Smoothing_buffer
STD
IBP
Mosaic
Stream_identifier
Teletext
User defined

Refer to PSI Descriptors (page 3–128) and SI Descriptors (page 3–134) for more
information.
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The transport streams carried in a network or bouquet are uniquely identified by
a combination of transport_stream_id and original_network_id.

Parameter Possible Values Notes

Transport stream ID 0 to 65535 Identifies the transport stream; correlates
to TSID parameters in the SDT and EIT.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

Transport streams may be further defined with the addition of the following SI
descriptors:

Service_list
Stuffing
Satellite_delivery_system
Cable_delivery_system
Private_data_specifier
User defined

Refer to SI Descriptors, beginning on page 3–134, for more information.

Parameter Possible Values Notes

Event ID 0 to 65535 Identifies the event

Start time Date

Time (24 hour)

yyyy/mm/dd (today’s date is suggested)

hh/mm/ss

Duration 00:00:00 to 99:59:59 hh/mm/ss

Running status 0 (Undefined)
1 (Not running)
2 (Starts in a few seconds)
3 (Pausing)
4 (Running)

Select through the drop-down list box or
enter the value and click the EIT icon;
Edit Table changes the corresponding
entry.

Free CA mode 0 (Not scrambled)
1 (Scrambled)

Select through the drop-down list box;
Edit Table changes the numeric value.

Transport Streams
(in NIT or BAT)

EIT Events
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EIT events may be further defined with the addition of the following SI
descriptors:

Stuffing
Linkage
Short_event
Extended_event
Tme_shifted_event
Component
CA_identifier
Content
Parental_rating
Telephone
Private_data_specifier
Short_smoothing_buffer
User defined

Refer to SI Descriptors, beginning on page 3–134, for more information.

The Running Status Table updates the timing status of one or more events, which
may be necessary when a scheduling change causes an event to be early or late.
The RST has no parameters or descriptors of its own; event parameters describe
the event and indicate its running status.

Parameter Possible Values Notes

Transport stream ID 0 to 65535 Identifies the transport stream to which
the RST pertains; the TS can be in any
multiplex within the delivery system.

Original Network ID 0 to 65535 This is the network ID of the originating
delivery system.

Service ID 1 to 65535 Must be the same as the program
number in the corresponding PMT.

Event ID 0 to 65535 Identifies the event

Running status 0 (Undefined)
1 (Not running)
2 (Starts in a few seconds)
3 (Pausing)
4 (Running)

Select through the drop-down list box or
enter the value and click the event icon;
Edit Table changes the corresponding
entry.

RST Events
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Descriptors are structures that may be used to extend the definitions of programs
and program elements. You can add the appropriate PSI descriptors to a PMT or
to the elementary streams under a PMT.

Audio Stream. The audio_stream_descriptor identifies the coding version of an
audio elementary stream.

Parameter Possible Values Notes

Free format flag Bitrate index � 0000 (0)
Bitrate index � 0000 (1)

Select through the drop-down list box;
Edit Table changes the numeric value.

ID 0 or 1 Set this to the same value as the ID
fields in the audio stream.

Layer 0 to 3 Set this to the same value as the layer
fields in the audio stream.

Variable rate audio
indicator

No decoding discontinuity (0)
Decoding discontinuity (1)

Select through the drop-down list box;
Edit Table changes the numeric value.

Conditional Access. The conditional_access_descriptor is used, where required,
to enable scrambling, either system-wide or of a service, program, elementary
stream, or event.

Parameter Possible Values Notes

CA system ID 0 to 65535 Indicates the applicable type of CA
(scrambling) system; private and not
defined in international standards.

CA PID 0 to 8191 The PID of the transport stream packets
that contain conditional access (ECM or
EMM) information.

Private data bytes An even number of hexade-
cimal characters

May be speciified by the CA system
provider.

Copyright. The copyright_descriptor may be used to identify copyrighted work.
The descriptor applies to the entire program when added to a PMT and to a
single elementary stream when added to an ES.

Parameter Possible Values Notes

Copyright identifier 0 through 232 Identifies the copyright registration
authority; number is provided by 
ISO/IEC JTC1/SC29.

Additional copyright
information

An even number of hexade-
cimal characters

May be specified by the copyright
registration authority.

PSI Descriptors
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Data Stream Alignment. The data_stream_alignment_descriptor indicates the type
of alignment used in the elementary stream.

Parameter Possible Values Notes

Alignment type 1 (Slice, video access unit,
or audio syncword)
2 (Video access unit)
3 (GOP or SEQ)
4 (SEQ)

Select through the drop-down list box;
Edit Table changes the numeric value.

(GOP = group of pictures)

Hierarchy. The hierarchy_descriptor identifies program elements that contain
parts of elementary streams that are multiplexed in multiple transport streams.

Parameter Possible Values Notes

Hierarchy type 1 (Spacial scalability)
2 (SNR scalability)
3 (Temporal scalability)
4 (Data partitioning)
5 (Extension bitstream)
6 (Private stream)
15 (Base layer)

Select through the drop-down list box or
enter the number and click the descriptor
icon; Edit Table changes the correspond-
ing entry.

Hierarchy layer index 0 to 63 The hierarchy index of the elementary
stream; no two streams in a program can
have the same index.

Hierarchy embedded
layer index

0 to 63 Defines the hierarchy table index of the
program element that must be accessed
before the elementary stream can be
decoded.

Hierarchy channel 0 to 63 Indicates the intended transmission
channel of the elementary stream.

IBP. The IBP_descriptor indicates how groups of (I, P, and B) pictures are
encoded in the video elementary stream.

Parameter Possible Values Notes

Closed GOP flag 0 or 1 Set to 1 when a group of pictures header
is encoded before every I-frame.

Identical GOP flag 0 or 1 Set to 1 when the sequence of picture
types between I-frames is the same
throughout the sequence.

Max GOP length 1 to 16383 The maximum number of coded pictures
between any two I-pictures in the
sequence.
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ISO 639 Language. The ISO_639_language_descriptor, through subdescriptors,
identifies the language or languages used in associated program elements. You
may set two subdescriptor parameters through Edit Table.

Parameter Possible Values Notes

ISO 639
language code

Three alpha characters See ISO 639

Audio type 1 (clean effects)
2 (hearing impaired)
3 (visual impaired commen-
tary)

Select through the drop-down list box;
Edit Table changes the numeric value.

Maximum Bitrate. The maximum_bitrate_descriptor indicates the highest bitrate,
including transport overhead, to be encountered in the program or program
element. If the descriptor is added to the PMT, the indicated bitrate applies to the
entire program; if it is added to the ES icon, it applies to a single elementary
stream.

Parameter Possible Values Notes

Maximum bitrate 0 to 4194303 (222) Units are 50 bytes/second

Multiplex Buffer Utilization. The multiplex_buffer_utilization_descriptor provides
upper and lower time limits for occupancy of the T-STD multiplex decoder. This
information may be used by some remultiplexing devices.

Parameter Possible Values Notes

Bound valid flag Not valid (0)
Valid (1)

Applies to the LTW offset bounds of this
descriptor; select through the drop-down
list box; Edit Table changes the numeric
value.

LTW offset 
lower bound

0 to 32767 The lower limit, in (27 MHz/300) clock
periods, of LTW offset values in the
stream(s) referenced by this descriptor.

LTW offset
Upper bound

0 to 32767 The upper limit, in (27 MHz/300) clock
periods, of LTW offset values in the
stream(s) referenced by this descriptor.
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Private Data. The private_data_descriptor can facilitate compatible private
extensions to the PSI data stream.

Parameter Possible Values Notes

Private data indicator 0 to 232 The value of this parameter has no
universal meaning; the target decoder
must be able to interpret the value.

Registration. The registration_descriptor is used to identify private data formats.

Parameter Possible Values Notes

Format identifier 0 to 232 Assigned by a registration authority.

Additional identifica-
tion information.

An even number of hexade-
cimal characters

Defined by the assignee of the for-
mat_identifier.

Smoothing Buffer. The smoothing_buffer_descriptor describes the smoothing
buffer for the program or elementary stream.

Parameter Possible Values Notes

SB leak rate 0 to 4194303 (222) The rate at which data is removed from
the buffer, in units of 400 bits/second.

SB size 0 to 4194303 (222) Size of the smoothing buffer, in bytes.

STD. The STD_descriptor determines how the T-STD transfers elementary stream
data from the multiplex buffer to the elementary stream buffer. The leak method
is the default, used if this descriptor is not present.

Parameter Possible Values Notes

Leak valid flag 0 (VBV_delay method)
1 (Leak method)

Select through the drop-down list box;
Edit Table changes the numeric value.
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System Clock. The system_clock_descriptor conveys information about the
system clock used to generate program time stamps.

Parameter Possible Values Notes

External clock refer-
ence indicator

0 (Internal reference)
1 (External reference)

Select through the drop-down list box;
Edit Table changes the numeric value

Clock accuracy
integer

0 to 63 These parameters together indicate
system clock accuracy in ppm; if
cloc cc r cy i te er system

Clock accuracy
exponent

0 to 7
clock_accuracy_integer = 0, system
clock accuracy is, by default, 30 ppm.

Target Background Grid. The target_background_grid_descriptor, combined with
the video_window_descriptor, determines the placement of an undersized picture
on the display area. The target_background_grid_descriptor describes the display
area.

Parameter Possible Values Notes

Horizontal size 0 to 16383 Horizontal size, in pixels, of the target
background grid (display area).

Vertical size 0 to 16383 Vertical size, in pixels, of the target
background grid (display area).

Aspect ratio
information

1 (1.0000)
2 (0.6735)
3 (0.7031)
4 (0.7615)
5 (0.8055)
6 (0.8437)
7 (0.8925)
8 (0.9157)
9 (0.9815)
10 (1.0255)
11 (1.0695)
12 (1.0950)
13 (1.1575)
14 (1.2015)

Select the correct ratio through the
drop-down list box; Edit Table automati-
cally changes the parameter value.

See ISO/IEC13818-2 for a definition of
aspect_ratio_information.
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Video Stream. The video_stream_descriptor identifies the coding parameters of a
video elementary stream.

Parameter Possible Values Notes

Multiple frame rate
flag

0 (Single frame rate)
1 (Multiple frame rates)

Select through the drop-down list box;
Edit Table changes the numeric value

Frame rate code 1 (23.976)
2 (24.0, 23.976*)
3 (25.0)
4 (29.97, 23.976*)
5 (30.0, 23.976*, 24*, 29.97*)
6 (50.0, 25.0*)
7 (59.94, 23.976*, 29.97*)
8 (60.0, 23.976*, 24.0*,

29.97*, 30.0*, 59.94*)

Frames per second

*ed rates are permitted when the 
multiple frame rate flag = 1

MPEG1 only flag 0 (MPEG1 or 2 video data)
1 (MPEG1 video data)

Select through the drop-down list box;
Edit Table changes the numeric value.

Constrained
parameter flag

0 or 1 Set to 0 when the video stream may
contain both constrained and uncon-
strained video data; always set to 1
when the MPEG1_only_flag is set to 0.

Still picture flag 0 (Moving and still pictures)
1 (Still pictures)

Available when the MPEG1_only_flag
is 0; Select through the drop-down list
box; Edit Table automatically changes
the numeric value.

Profile and level
indicator

0 to 255 Available when the MPEG1_only_flag
is 0; set this to the same value as the
profile_and_level_indication fields in the
video stream.

Chroma format 1 (4:2:0)
2 (4:2:2)
3 (4:4:4)

Available when the MPEG1_only_flag
is 0; set this to the same value as the
chroma_format fields in the video
stream.

frame rate extension
flag

0 or 1 Available when the MPEG1_only_flag
is 0; set this flag to 1 when either the
frame_rate_extension_n or the
frame_rate_extension_d field in the
video stream is non-zero.
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Video Window. The video_window_descriptor, combined with the target_back-
ground_grid_descriptor, determines the placement of an undersized picture (or
window) on the display area. The video_window_descriptor determines the
location of the smaller picture on the display area and the priority of the picture
when it overlaps with other pictures on the same display.

Parameter Possible Values Notes

Horizontal offset 0 to 16383 Horizontal position of the video window,
in pixels, from the left edge of the
background grid (display area).

Vertical offset 0 to 16383 Vertical position of the video window, in
pixels, from the top edge of the back-
ground grid (display area).

Window priority 0 to 15 Zero is the lowest priority, 15 is the
highest; windows with priority 15 are
always visible.

You can add appropriate SI descriptors to PMT, NIT (and TS), BAT (and TS),
SDT services, and EIT events.

Bouquet Name. The bouquet_name_descriptor carries the bouquet name in text
form.

Parameter Possible Values Notes

Name Alphanumeric characters —

SI Descriptors
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CA Identifier. The CA_identifier descriptor indicates that the bouquet, service,
event, or component is associated with a conditional access system and identifies
the type of CA system. You must add a subdescriptor in order to specify the CA
system; the table lists values for the CA system subdescriptor parameter.

Parameter Possible Values Notes

CA system ID Reserved (0)
Standardized Systems (1)
Canal Plus (256)
CCETT (512)
Deutch Telecom (768)
Eurodec (1024)
France Telecom (1280)
Irdeto (1536)
Jerrold/GI (1792)
Matra Communication (2048)
News Datacom (2304)
Nokia (2560)
Norwegian Telecom (2816)
NTL (3072)
Philips (3328)
Scientific Atlanta (3584)
Sony (3840)
Tandberg Television (4096)
Thomson (4352)
TV/Com (4608)
HPT—Croatian P&T (4864)
HRT—Croatian R&TV (5120)
IBM (5376)
Nera (5632)
BetaTechnik (5888)

When you select the system ID through
the drop-down list box, Edit Table
automatically changes the numeric
value.

Each CA system specifier has been
assigned a range of numeric values; see
ETR 162 for more information.

You may enter an appropriate number in
the value box and click the subdescriptor
icon; Edit Table automatically changes
the CA system specifier name to match.

Cable Delivery System. The cable_delivery_system_descriptor identifies the
characteristics of the cable delivery system.

Parameter Possible Values Notes

Frequency 0000.0000 to 9999.9999 MHz

FEC outer 1 (No outer FEC coding)
2 (RS 204/188)

Select through the list box or enter the
appropriate value and click the descriptor
icon.

Modulation 1 (16 QAM)
2 (32 QAM)
3 (64 QAM)
4 (128 QAM)
5 (256 QAM)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.
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Parameter NotesPossible Values

Symbol rate 000.0000 to 999.9999 Msymbols/second

FEC inner 1 (1/2 conv. code rate)
2 (2/3 conv. code rate)
3 (3/4 conv. code rate)
4 (5/6 conv. code rate)
5 (7/8 conv. code rate)
15 (No conv. coding)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Component. The component_descriptor identifies the type of component stream
and may be used to provide a text description of the elementary stream.

Parameter Possible Values Notes

Stream content 1 (Video)
2 (Audio)
3 (Teletext)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
te e try i t e corres o i ielComponent type Value depends on stream

content; see the following
table

ate entry in the corresponding field.

Component tag 0 to 255 Enter the same value as in the PMT
stream_identifier descriptor (if present).

ISO 639 language
code

A 3-character language code
as defined in ISO 639

Use when the stream content is audio or
teletext.

Description Alphanumeric characters A text description of the elementary
stream.
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The possible component types depend on the value of the stream content
parameter.

Stream Content Possible Component Type Values

Video (1) 1 (4:3 aspect ratio)
2 (16:9 aspect ratio with pan vectors)
3 (16:9 aspect ratio without pan vectors)
4 (Greater than 16:9 aspect ratio)

Audio (2) 1 (Single mono channel)
2 (Dual mono channel)
3 (Stereo (2 channel))
4 (Multi-lingual, multi-channel)
5 (Surround sound)
64 (For visually impaired)
65 (For the hard of hearing)

Teletext (3) 1 (EBU teletext subtitles)
2 (Associated EBU teletext)
10 through 13, 32 through 35 (Various DVB subtitle types; refer to
ETS 300 468)

Content. The content_descriptor classifies event content. ETS 300 468 lists more
than 75 content classifications such as “motor sport” or “musical/opera.” The
content descriptor must have a content nibble subdescriptor. The following table
describes the subdescriptor parameters.

Parameter Possible Values Notes

Content nibble level 1 1 (Movie)
2 (News/current affairs)
3 (Show/game show)
4 (Sports)
5 (Children/youth programs)
6 (Music/ballet/dance)
7 (Arts/culture) 
8 (Social/political/economics)
9 (Education/science/factual
10 (Leisure hobbies)

The content class. Select through the
drop-down list box; Edit Table automati-
cally changes the numeric value.

You may also enter an appropriate
number in the value box and click the
subdescriptor icon; Edit Table automati-
cally changes the CA system specifier
name to match.

Content nibble level 2 Choices depend on and
correspond to the level 1
selection. See ETS 300 468
for a complete list.

The content sub-class. Select through
the drop-down list box, Edit Table
automatically changes the numeric
value.

User nibble (2 fields) 0 to 15 Defined by the broadcaster
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Country Availability. The country_availability_descriptor can either list the
countries for which the bouquet or service is intended or those countries for
which it is not intended. You can add both an intended and a not intended
descriptor; if the lists conflict, the not intended descriptor takes precedence.

Parameter Possible Values Notes

Country availability
flag

0 (Not intended)
1 (Intended)

Enter the flag value or select from the
drop-down list box.

Country code One or more 3-character
country codes as specified in
ISO 3166 [2] or ETR 162

Do not insert spaces between the codes.
For example, to specify both the UK and
Scandinavia, enter GBR900.

Extended Event. The extended_event_descriptor can provide a detailed descrip-
tion of an event. You may use a set of up to 16 extended event descriptors in
addition to the short event descriptor.

Parameter Possible Values Notes

Descriptor number 0 to 15 Determines the order of this descriptor in
the set of associated descriptors.

Last descriptor
number

0 to 15 The number of the last descriptor in this
set of extended event descriptors.

ISO 639 language
code

A 3-character language code
as defined in ISO 639

The language of the descriptor text

Text char Up to 256 alphanumeric
characters

The descriptor text

You can use extended event subdescriptors to arrange text into two columns.
Each subdescriptor Edit window has an “item description char” field and an
“item char” field. In a typical application, the information in the extended event
subdescriptors is arranged as follows:

item_description_chars_1 item_chars_1
item_description_chars_2 item_chars_2
item_description_chars_3 item_chars_3

Actual content could resemble the following:

Title: MTS 210, The Movie
Director: John D. Rector
Producer: Jack Producer

The number of subdescriptors appears as “Nb item:” (in gray characters) on the
extended event descriptor Edit window.



Using the PSI and SI Table Editor

Tektronix MPEG Test System User Manual 3–139

Linkage. The linkage_descriptor identifies a service that can be presented when
the consumer requests additional information.

Parameter Possible Values Notes

Transport stream ID 0 to 65535 Identifies the TS that contains the
indicated information service

Original network ID 0 to 65535 The network ID of the originating delivery
system for the indicated information
service.

Service ID 0 to 65535 Uniquely identifies an information service
within a transport stream; must be the
same as the program number in the
corresponding PMT.

Linkage type 1 (Information)
2 (Electronic program guide)
3 (CA replacement)

Enter the value or select from the
drop-down list box.

Private data bytes An even number of hexade-
cimal characters

Mosaic. The mosaic_descriptor and subdescriptors can describe a mosaic
component, which is a collection of different video images that form a coded
video component. Each video image occupies a small region of the screen. The
information in the descriptors and subdescriptors determines the content and
arrangement of the mosaic. Refer to ETS 300 468 for a full explanation of the
mosaic descriptor and subdescriptors.

Parameter Possible Values Notes

Mosaic entry point 0 or 1 A value of 1 indicates that this mosaic is
the highest in a hierarchy.

Nb of horizontal
elementary cells

0 (one cell)
1 (two cells)
...
7 (eight cells)

Cells = value+1

Enter the value or select from the
drop-down list box.

Nb of vertical
elementary cells

0 (one cell)
1 (two cells)
...
7 (eight cells)

Cells = value+1

Enter the value or select from the
drop-down list box.
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The mosaic subdescriptors have the following parameters:

Parameter Possible Values Notes

Logical cell ID 0 to 63

Cell presentation info 0 (undefined)
1 (video)
2 (still picture)
3 (graphics/text)

Enter the value or select from the
drop-down list box.

Cell linkage info 0 (undefined)
1 (bouquet related)
2 (service related)
3 (other mosaic related)
4 (event related)

Enter the value or select from the
drop-down list box.

Bouquet ID 0 through 65535 Present only if the cell linkage info value
is 1.

Original network ID 0 through 65535 Present when cell linkage info value is
or 4

Transport stream ID 0 through 65535
 2, 3, or 4.

Service ID 0 through 65535

Event ID 0 through 65535 Present only if the cell linkage info value
is 4.

Each mosaic subdescriptor may have several subsubdescriptors. The subsubdes-
criptors have only one parameter, the elementary cell ID, which can have a
numeric value from 0 to 63.

Network Name. The network_name_descriptor provides the network name.

Parameter Possible Values Notes

Network name Alphanumeric characters The network name

NVOD Reference. The NVOD_reference_descriptor, in conjunction with the time
shifted service and time shifted event descriptors, provide a mechanism for
describing a group of services that carry the same event sequence at start times
that are offset from one another. Such a group of time-shifted services is known
as near video on demand, or NVOD.
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The NVOD reference descriptor uses subdescriptors to list the services that
together form an NVOD service. The following table lists the NVOD reference
subdescriptor parameters.

Parameter Possible Values Notes

Transport stream ID 0 to 65535 Identifies the TS that contains the
service

Original network ID 0 to 65535 The network ID of the originating delivery
system for the service.

Service ID 0 to 65535 Uniquely identifies the service within a
transport stream; must be the same as
the program number in the correspond-
ing PMT.

Parental Rating. The parental_rating_descriptor, through subdescriptors, can
contain a rating based on country and age of the potential viewers. The following
table lists the parental rating subdescriptor parameters.

Parameter Possible Values Notes

Country code A 3-character country code Codes are specified in ISO 3166 [2]

Rating (+3 = mini-
mum age)

1 to 15 The suggested minimum age of viewers
is the rating plus three; thus a rating of 4
suggests that viewers should be at least
7 years old.

Private Data Specifier. The private_data_specifier_descriptor identifies the source
of private data used in the SI stream so the decoder can reliably interpret the
private data. The location of this descriptor determines the entities (network,
bouquet, events, or services) to which it applies; refer to ETS 300 468 for a
complete explanation.

Parameter Possible Values Notes

Private data specifier 0 to 232 Assigned in ETR 162 [6]
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Satellite Delivery System. The satellite_delivery_system_descriptor identifies the
characteristics of the satellite delivery system.

Parameter Possible Values Notes

Frequency (GHz) 000.00000 to 999.99999 —

Orbital position 000.0 to 999.9 Degrees; many possible entries are
meaningless

West east flag 0 (Western position)
1 (Eastern position)

Enter the value or select from the
drop-down list box

Polarization 0 (linear–horizontal)
1 (linear–vertical)
2 (circular–left)
3 (circular–right)

Enter the value or select from the
drop-down list box

Modulation 0 (undefined)
1 (QPSK)

Enter the value or select from the
drop-down list box

Symbol rate 000.0000 to 999.9999 Msymbols/second

FEC inner 1 (1/2 conv. code rate)
2 (2/3 conv. code rate)
3 (3/4 conv. code rate)
4 (5/6 conv. code rate)
5 (7/8 conv. code rate)
15 (No conv. coding)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Service. The service_descriptor provides the service type, service name, and
service provider.

Parameter Possible Values Notes

Service type 0 (reserved)
1 (digital television)
2 (digital radio sound)
3 (teletext)
4 (NVOD reference)
5 (NVOD time-shifted service)
6 (mosaic)
7 (PAL coded signal)
8 (SECAM coded signal)
9 (D/D2–MAC)
10 (FM radio)
128 to 254 (user defined)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Provider name Alphanumeric text

Service name Alphanumeric text
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Service List. The service_list_descriptor uses subdescriptors to list the services in
a transport stream by service ID and type. The table lists the service list
subdescriptor parameters.

Parameter Possible Values Notes

Service ID 0 to 65535 Uniquely identifies the service within a
transport stream; must be the same as
the program number in the correspond-
ing PMT except when the service type is
NVOD reference.

Service type 0 (reserved)
1 (digital television)
2 (digital radio sound)
3 (teletext)
4 (NVOD reference)
5 (NVOD time-shifted service)
6 (mosaic)
7 (PAL coded signal)
8 (SECAM coded signal)
9 (D/D2–MAC)
10 (FM radio)
128 to 254 (user defined)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Service Move. The service_move_descriptor enables a decoder to track a service
as it is moved from one transport stream to another.

Parameter Possible Values Notes

New
original network ID

0 to 65535 The ONID of the transport stream after
the move

New
transport stream ID

0 to 65535 The TSID after the move

Short Event. The short_event descriptor provides the event name and a short text
description of the event. If a longer description is required, use up to 15 extended
event descriptors in addition to this descriptor.

Parameter Possible Values Notes

ISO 639 language
code

A 3-character language code
as defined in ISO 639

The language of the text used in this
descriptor

Event name Alphanumeric text

Description Alphanumeric text
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Short Smoothinq Buffer. The short_smoothinq_buffer_descriptor can appear in
EIT present/following and EIT schedule tables to indicate the bit rate of each
event.

Parameter Possible Values Notes

SB size 0 (DVB reserved)
1 (buffer = 1536 bytes)

Enter the value or select from the
drop-down list box

SB leak rate 0 (DVB reserved)
1 (0.0009 Mbits/s)
2 (0.0018 Mbits/s)
...
60 (108.0 Mbits/s)

Refer to ETS 300 468 for a complete list
of possible values.

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

DVB reserved bytes An even number of hexade-
cimal characters

—

Stream Identifier. The stream_identifier_descriptor can attach a component tag to
PMT transport stream descriptions. This component tag allows the EIT, through
the same tag in a component descriptor, to reference the stream.

Parameter Possible Values Notes

Component tag 0 to 255 —

Stuffing Descriptor. The stuffing_descriptor provides a means of inserting dummy
descriptors for table stuffing.

Parameter Possible Values Notes

Descriptor length 0 to 255 Bytes

Telephone. The telephone_descriptor provides a telephone number that can be
used for modem dial-up; communication via modem may be used with narrow-
band interactive channels.

Parameter Possible Values Notes

Foreign availability 0 (from inside the country)
1 (from outside the country)

Enter the value or select from the
drop-down list box

Connection type 0 to 31 Type must be recognized by the decoder
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Parameter NotesPossible Values

Country prefix Alphanumeric characters Consistent with international and local
telecomm ic tio s st r s

Int’l area code Alphanumeric characters
telecommunications standards.

Operator code Alphanumeric characters

National area code Alphanumeric characters

Core number Alphanumeric characters

Teletext. The teletext_descriptor, with subdescriptors, can appear in an ES
definition in the PMT to identify streams that contain EBU teletext data. The
table lists the teletext subdescriptor parameters.

Parameter Possible Values Notes

ISO 639 language
code

A 3-character language code
as defined in ISO 639

The language of the teletext data

Teletext type 1 (initial teletext page)
2 (teletext subtitle page)
3 (addit’l information page)
4 (program schedule page)

Select through the list box or enter the
appropriate value and click the descriptor
icon; the application makes the appropri-
ate entry in the corresponding field.

Teletext magazine
number

0 to 7 Identifies the magazine

Teletext page
number

0 to 255 Identifies the page

Time Shifted Event. The time_shifted_event_descriptor identifies an event that is
a time-shifted copy of another event.

Parameter Possible Values Notes

Reference service ID 0 to 65535 The ID of the NVOD reference service;
does not have a corresponding service in
the PMT.

Reference event ID 0 to 65535 Identifies the reference event (of which
this event is a copy).
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Time Shifted Service. The time_shifted_service_descriptor identifies a service that
is a time-shifted copy of another service.

Parameter Possible Values Notes

Reference service ID 0 to 65535 The ID of the NVOD reference service
(of which this service is a copy); does
not have a corresponding service in the
PMT.

User. The user defined descriptor may be added to almost any table, stream,
service, or event definition.

Parameter Possible Values Notes

Descriptor tag 128 to 254 Pick your own.

Private bytes An even number of hexade-
cimal characters

—

Learning More About Table Items
PSI tables are defined in the ISO/IEC 13818-1 international standard; SI tables
and descriptors are defined in ETS 300 468. The ISO/IEC 13818-1 text is
included, in Windows help format, with the MTS 210. To open this document,
click MPEG-2 Help in the Tektronix MPEG Test System submenu.

Once the help application opens, use the Contents and Search commands to find
the information you need. For example, you can find a detailed description of the
registration descriptor by clicking Contents, and then clicking the following
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hyperlinks: TECHNICAL ELEMENTS; PROGRAM AND PROGRAM
ELEMENT DESCRIPTORS; Registration descriptor.

You may also wish to refer to ISO/IEC 13818-2 for additional information about
video encoding or ISO/IEC 13818-3 for information about audio encoding.
These publications are available through the ISO (International Organization for
Standardization. The URL of the ISO web page is http://www.iso.ch/ the URL of
the online ISO catalog is http://www.iso.ch/infoe/catinfo.html (current as of
March 1997).

ETS 300 468 is available through the European Telecommunications Standards
Institute (ETSI). The URL of the ETSI web page is http://www.etsi.fr/ (current
as of March 1997). Much of the information in ETS 300 468 is available through
the Edit Table Help menu. You will notice that Edit Table. Help has many fewer
hyperlinks than MPEG-2 help; to find information about most topics, click the
Help Topics command button on the Help window tool bar.
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Global View
The Global View command opens a window that shows the association between
selected NIT, SDT, and EIT table files. These files can have some relationship to
each other, or none at all.

Unassociated tables Highly associated tables

The files with a high degree of association are not interdependent. You can use
these table files with table files other than the associated ones. The association
ties together the files as shown below.

Found in
NIT table file

Found in
SDT table file

Found in
EIT table file

Service ID

Service ID

Transport
stream ID

Transport
stream ID

Transport
stream ID

The NIT contains the Transport Stream, with a Transport Stream ID defined in
the Transport Stream’s Edit window.

If the Transport Stream ID (from the SDT Edit window) is the same, then the
SDT is associated with the NIT.
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If the SDT has a service that has a descriptor, there may be a service or special
service icon (shown in Table 3–13 on page 3–109). The service Edit window
contains the service ID parameter.

If the EIT parameters (from the Edit window) are the same as the SDT parame-
ters for both the Service ID and the Transport Stream ID, then the EIT is
associated with the SDT.

NIT and SDT files can be associated without an EIT file. Likewise, SDT and
EIT files can be associated without an NIT file. NIT and EIT files cannot be
associated without a SDT file between them. (The Service ID is only present in
the SDT.)
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Creating Files with Complex Associations (Tutorial)
This section describes how to make table files with complex associations
between networks, services, and events. Many of the simpler steps are not
explained in detail. If you need help, please review the tutorial on Creating
Transport Stream Files with DVB Information beginning on page 2–83.

1. Start by closing all currently open table files. (Use the Close command from
the File menu.)

2. Create new NIT, SDT, and EIT table files. (Use the New command from the
File menu.)

3. Choose Global view from the File menu (or click the G button on the upper
tool bar). This brings up the Global View File Selection dialog box with the
New table files as the default parameters.

4. Click OK. This opens the Global View window.

5. Click the NIT icon in the global view to display the NIT in the Edit Table
hierarchy and Edit windows.



Using the PSI and SI Table Editor

Tektronix MPEG Test System User Manual 3–151

6. Enter � in the network ID text box.

7. Click on the NIT icon to apply the change. Notice that the number below the
NIT icon changes to N1 in both the Edit Table hierarchy and the Global
View.

8. Add a transport stream to the NIT.

a. Click the Add (+) button on the upper tool bar.

b. Select Transport stream in the resulting dialog box.

c. Click OK.

9. Select the TS icon. Enter � as the transport stream ID and � as the original
network ID. Notice that the network ID has the same number as the network
ID at the NIT level.
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10. Apply the changes by clicking on the TS icon. Notice that both the Edit
Table hierarchy and the Global View show the changes.

11. Add an another transport stream. (Choose Add from the tool bar. Transport
stream is already selected in the Add dialog box; click OK.)

12. Click on the new TS icon to select it. Enter � as the transport stream ID
and � as the original network ID.

13. Apply the changes (click the TS icon) and notice the results in the hierarchy
and Global View.

14. Create a new NIT section (choose New from the Section menu) and change
the network ID to ��.

15. Add two transport streams to the new section. Enter �� as the transport
stream ID of the first and �� as the ID of the second; give them both the
original network ID of ��.



Using the PSI and SI Table Editor

Tektronix MPEG Test System User Manual 3–153

16. Notice the changes to the Global View.

Network ID

Transport stream ID

Transport stream ID

17. Click the SDT command button (or the SDT icon in the Global view) to
display the SDT file.

18. Enter � in the transport stream ID field and � in the original network ID
field.
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19. Apply these changes (click in the hierarchy window.). Notice that the SDT is
now associated with transport stream 2 in the Global View.

Experiment, if you like, with associating the SDT with other transport
streams. For example, change the stream ID to 3; or change the network ID
to 11 and the stream ID to 12. Watch the Global View when you click in the
hierarchy window to apply the changes. When you are done experimenting,
return the settings to stream ID = 2 and network ID = 1.

20. Click the Add button three times to add services to the SDT. Enter �, �, and
� as the respective service IDs.

21. When you are done, notice that the service ID number is displayed under
each of the service icons in both the Edit Table hierarchy and the Global
View.

22. Add a service descriptor to service S4.

a. Select the S4 icon; then click the Add button.

b. Select Descriptor in the Add dialog box; then click OK. The Descriptors
Selection dialog box appears.

c. Select service from the drop-down List of Descriptors and click Add.
Then click OK to finish adding the descriptor to service four.
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23. Click the new descriptor icon to select it.

24. Select digital television from the drop-down service type list box; the service
type value automatically changes from 0 to 1. Enter your name in the
provider name text box and enter ������
�	� in the service name box.

25. Click in the hierarchy window to apply the changes to the descriptor. Notice
that the S4 icon in the Global View changes to resemble a television set.

26. Add service descriptors to both S5 and S6.

a. Select the S4 service descriptor icon in the hierarchy window; then
choose Copy from the Edit menu (or type CTRL+C).

b. Select the S5 Service icon; then choose Paste from the Edit menu.

c. Select the S6 Service icon and type CTRL+V to paste the service
descriptor.

27. Select the S5 descriptor (D) icon in the hierarchy. Change the service type to
digital radio sound and enter ����	 in the service name text box.

28. Select the S6 descriptor icon. Change the service type to teletext and enter
��� in the service name text box.
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29. Click again in the hierarchy window. Notice that the S5 and S6 icons in the
global view have also changed appearance.

30. Create a new SDT section (choose New from the Section menu); notice that
a new SDT icon appears near the bottom of the global view, not associated
with any other icon.

31. Enter 3 in the transport stream ID text box and 1 in the original network ID
box. Click in the hierarchy window to apply the changes and notice that the
new SDT icon is now associated with TS3 in the global view.

32. Add three services and give them service IDs 41, 51, and 61 respectively.

33. Copy the S4, S5, and S6 service descriptors from the previous section and
paste them onto S41, S51, and S61.

a. Click the previous button on the lower tool bar—or click the SDT icon
associated with TS2 in the global view—to return to the first table
section.

b. In the hierarchy, select the descriptor icon connected to service S4; then
choose Copy from the Edit menu (or type the CTRL+C key equivalent).

c. Click the next button to return to SDT Section 2.

d. Select the S41 hierarchy icon and then choose Paste from the Edit menu
(or type the CTRL+V key equivalent).

e. Repeat the procedures in steps a through d to copy the S5 and S6
descriptors to S51 and S61.
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34. Notice that the full SDT tree in the global view is associated with transport
stream 3 (TS3).

35. In the global view, click the SDT icon associated with TS3. Then, in the Edit
window, change the transport stream ID from 2 to 12 and the original
network ID from 1 to 11. Notice how the SDT section moves to TS12 in the
global view.

Moved from here

To here

36. Click the EIT command button (or click the EIT icon in the Global View) to
select the EIT file.

37. Make the following parameter entries:

� Service ID = 51
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� Transport stream ID = 3

� Original network ID = 1

38. Click in the hierarchy to apply these changes. Notice that the EIT is now
associated with S51 (radio service) of TS3 in the Global View.

39. Create a new EIT section. (From the Section menu, choose New.)

40. Associate this EIT section with transport stream TS12, service S4 (televi-
sion), on network N11. (Service ID = 4, transport stream ID = 12, and
original network ID = 11.)

41. Apply these changes. Notice in the Global View that the new EIT is
associated with the television service of TS12.
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42. In the global view, click the SDT icon associated with TS12 to select section
1 of the SDT.

43. In the Edit Table hierarchy window, double-click the SDT icon to collapse
the hierarchy. Double-click again to restore the service and descriptor icons.

44. Double-click various icons in the global view to see how that hierarchy can
collapse under the clicked icon.

This concludes the Edit Table exercise. Several important rules of SI tables have
been illustrated in this section:

� The NIT sets the network ID.

� The NIT contains transport streams.

� Transport streams set their own IDs.

� The SDT is associated with a transport stream through the TS ID and the
original network ID.

� An SDT contains services.

� Service descriptors set the service ID.

� EITs are associated to SDTs through service ID, transport stream ID, and
original network ID.

NOTE. The table files that you have created will not pass a Coherence analysis.
They are intended only to illustrate associations between the various table types.
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Using the Data Store Administrator

The Data Store Administrator application manages the Data Store disks. It also
manages MPEG-2 transport stream acquisition and generation. Since the
Windows File Manager does not manage the Data Store disks, the Data Store
Administrator also performs all the low-level functions normally accomplished
with the File Manager.

This application, the SCSI drivers, and the EISA card are optimized to guarantee
a continuous data acquisition or generation rate of at least 55 Mbits/second for a
minimum of 19 minutes (approximately 40 minutes in later instruments with
18 Gbyte data storage space) without interruption of the flow and no loss of data.
“Looped” acquisition and generation is also available.

Terms
The terms Data Store disk and system disk are NOT interchangeable when
describing how the Data Store Administrator operates. CARB is a French
acronym for “Data Store.”

Data Store Disk. The Data Store disks are four hard drives physically connected
to the Data Store circuit board. These disks are used by the Data Store Adminis-
trator when generating and acquiring transport streams. They can also be used by
the Multiplexer and Analyzer when dealing with files that are too large for the
system disk.

Four 2  Gbyte Data Store disks, for a total capacity of 8 Gbytes, are standard on
Tektronix MPEG Test Systems with serial numbers below B060000. Later
instruments have 4.5 Gbyte Data Store disks, for a total of 18 Gbytes.

System Disk. The system disk is the fixed disk drive (hard disk) that contains
theWindows NT operating system files and the MTS 210 application software.
You can access this disk as on any personal computer using the Windows File
Manager. The system disk is configured during manufacture as the Mts100 (C:)
drive

CARB. The term CARB, a French acronym referring to the Data Store disks or
the Data Store board, is used often in the Data Store Administrator user interface.
CARB appears in this manual when necessary to reflect on-screen nomenclature
and avoid ambiguity.
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Special Features of the Data Store Disks
In order to generate or acquire MPEG-2 transport streams, the Data Store disks
have some special features required to accommodate constant, high bit rate
input/output.

First, no more than 255 files may be stored. Second, there is a rigid file structure.
Normally, file data can be scattered all over a hard disk, fitting in wherever there
is room. The Data Store disks must store each file in a single block. This
requirement has additional implications. When you delete a file, you do not
necessarily free up disk space. This is illustrated in Figure 3–1.

File 1

File 2

File 3

File 4

File 5

Empty

File 5

Empty

File 1

File 2

File 4

File 3
marked

as deleted

Empty Empty

File 1

File 2

File 4

File 5

(A) (B) (C)

Figure 3–1: How the data store disks manage their files

Column (A) shows the initial file structure. If a new file is added to the Data
Store disks, it is placed after file 5 at the top of the empty section.

Column (B) shows what happens when you “delete” file 3. Because file 3 is
surrounded by other files it is only marked as deleted, but it is not actually
deleted and cannot be overwritten. Thus, the disk space is not free for storing
other files. To free the disk space, you must “compress” the Data Store disks.
You can “undelete” it any time before you invoke the Compress command.
Notice, however, that you can delete the last file listed (File 5 in columns A and
B) as it is adjacent to the empty disk space and can add directly to that space.



Using the Data Store Administrator

Tektronix MPEG Test System User Manual 3–163

Column (C) shows what happens after a Compress command (see page 3–181).
File 3 is removed, files 4 and 5 are moved so that they now follow file 2, and the
space freed by moving files 4 and 5 is added to the empty space. This is the only
way to free disk space after deleting a middle file (other than first deleting all
files below it until the file is the last listed).

NOTE. The Compress function requires approximately one second per megabyte
of disk space to compress the Data Store disks. In other words, the Compress
function can take a long time. (For example, 8 Gbyte = 8192 Mb; 8192 seconds
is 136.5 minutes.)

Due to the rigid file structure, it is strongly advised that you use the Data Store
disks only for acquiring and generating transport stream files or storing large
transport stream (*.trp) files.

Starting the Application
To start the Data Store Administrator, double-click the application icon in the
Tektronix MPEG Test System program group window, as shown in Figure 3–2.

NOTE. The Analyzer and Multiplexer applications must be closed before starting
the Data Store Administrator.

Figure 3–2: Starting the Data Store Administrator
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The Application Window
When you open the Data Store Administrator, the application window shown in
Figure 3–3 occupies the screen.

Menu bar
Toolbar

Figure 3–3: The Data Store Administrator application window
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Menus
This section summarizes the commands available in the various Data Store
Administrator menus

Use To
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

FAT Read ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

List the files available on the Data Store disks
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Board to PC (Read) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Copy a file from the Data Store disks to the system hard drive (or oth-
er disk)

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PC to board (Write) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Copy a file from the system hard drive (or other media) to the Data
Store disksÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Delete
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Mark a Data Store file to be deleted (unless the file is at the bottom of
the list, it can be un-deleted any time before disk compression)ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
Undelete

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Remove the delete mark from a Data Store file

Exit Quit the Data Store Administrator application

Use To

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Acquisition ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Acquire a transport stream from the selected input port and save it as
a Data Store fileÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Generation
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Generate a transport stream from a transport stream file stored on the
Data Store disks and outputs it from the selected output port

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Interrupt transfer
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Stop the current Acquire or Generation process

File Menu

Acq/Gen Menu
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Use To

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Board Reset ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Perform a software reset on the Data Store board (use after an error)
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Resource[s] Parame-
ters

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Change the Data Store resource parameters

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

FAT Delete ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Initialize the Data Store disks. The partitions are preserved, but all
files are lost.ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Disk[s] Partitioning
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Create disk partitions. Must be run each time Data Store disks are
added, removed, or replaced.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Disk[s] Compress
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Free the disk space of all deleted files (marked DEL)
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Disk[s] Motor control
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Stop and restart the Data Store disk motors or specify automatic stop
and set the delay.

Use To
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

About ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Open the software version information window

Toolbar Command Buttons

The toolbar contains command buttons for several frequently used menu
commands. Click a button to select the corresponding menu command. The
commands are, from left to right:

FAT Read; see page 3–167 for additional information

Board to PC (Read); see page 3–168 for additional information

Service Menu

? (Help) Menu
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PC to board (Write); see page 3–169 for additional information

Acquisition; see page 3–172 for additional information

Generation; see page 3–176 for additional information

Interrupt transfer; see page 3–179 for additional information

Using File Menu Commands
The File menu provides file management commands such as file copies and
deletes. The commands available from the File menu are: FAT Read, Board to
PC (Read), PC to board (Write), Delete, Undelete, and Exit.

NOTE. Don’t forget that CARB refers to the Data Store disks.

FAT stands for File Allocation Table. The FAT Read command lists the files
available on the Data Store disks and shows their status. See Figure 3–4. A FAT
Read occurs whenever the Data Store Administrator is launched.

Figure 3–4: The FAT Information display

The FAT Information display gives the following information:

� Number of Disks detected on the Data Store board. There should be four.
Any fewer indicates that you may have a malfunctioning disk. (The
MTS 210 can operate with fewer than four disks if one or more fails and
immediate replacements are not available.)

� Size of each disk (in bytes)

� Partition information

� File name(s)

FAT Read
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� File size(s) in bytes.

� Files marked as “deleted” (DEL). These files are deleted when the Disks
Compress command is selected from the Service menu.

The Board to PC (Read) command copies a file from the Data Store disks to the
system hard drive (or other regular disk). Figure 3–5 shows the File Read from
CARB dialog box.

Figure 3–5: The File Read from CARB dialog box

NOTE. This command is not always necessary to read files from the Data Store
disks. The Analyzer application can read files directly from the Data Store disks
using the c:\carb0\mono directory.

Select the name of the Data Store disk file from the drop-down list box. Then
enter the new name for the system disk file. Click Browse if you wish to open a
Save As dialog box and select a directory on the system disk. See Figure 3–6.

Figure 3–6: The Save As dialog box

Board to PC (Read)
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After entering a name in the text box, click Save (or simply press ENTER). The
File Read from CARB dialog box will reappear; click Start  to copy the file to
the system disk.

Use the Board to PC command to move files that you have acquired with the
Data Store system to the system hard drive for analysis.

NOTE. It is possible to capture files on the Data Store disks that will not fit on
the system disk. You may want to check, through the Windows NT File Manager,
to see if there is room on the system disk for the file(s) you plan to copy.

The PC to board (Write) command copies a file from the system to the Data
Store disks. Use this command to move transport stream files created with the
Multiplexer application (and possibly modified with the Packet Jitter or
Coder/Decoder applications) to the Data Store disks. Once there, you can use
them to generate transport streams.

NOTE. This command is not always necessary to write files to the Data Store
disks. The Multiplexer application can write files directly to the Data Store disks
using the c:\carb0\mono directory.

1. Choose the command from the File menu or click the corresponding (W)
toolbar button. The resulting File Write to CARB  dialog box is shown in
Figure 3–7.

Figure 3–7: The File Write to CARB dialog box

2. Enter the full path and file name or click Browse to select the file that you
wish to transfer to the Data Store disks.

3. Then enter an appropriate file name in the Name of the CARB File text box.

PC to Board (Write)
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4. Finally, click Start to copy the file onto the Data Store disks.

The Delete command marks a Data Store file to be deleted.

1. To delete a file, select its name in the “Files informations” box, as shown in
Figure 3–8, and then choose Delete from the File menu. To select more than
one file from the list, hold the CTRL key down and then click the name of
each file you wish to delete.

Figure 3–8: Selecting a file to delete

2. The warning message shown in Figure 3–9 always opens, giving you an
opportunity to abort the file deletion.

Figure 3–9: The Warning dialog box

In most cases, you can later undelete a file that is marked as deleted as long as
you have not compressed the Data Store disks (see page 3–181). However, if you
delete the last file (or files) in the FAT table, it (or they) will be removed
immediately. In this case, you are given a special warning, shown in Figure
3–10, that the file is not recoverable.

Delete
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Figure 3–10: The last file is removed immediately

NOTE. The “file will not be recoverable” warning also appears when you select
the first-listed file for deletion. However, the warning is incorrect. Only the last
files in the FAT may be deleted without performing a disk compression.

Use the Delete command to free up space on the Data Store disks, but remember
that, if you wish to actually remove files that are listed anywhere but at the end
of the FAT, you must also select the Disks Compress command from the Service
menu (refer to Disk[s] Compress on page 3–181 for more information).

The Undelete command removes the DEL (delete) mark from a file on the Data
Store disks. If you change your mind and no longer want to delete a file, use this
command to return it to normal status.

To undelete a file, highlight its name in the Files informations box, as shown in
Figure 3–11, and choose the Undelete command from the File menu. To select
more than one file from the list, hold the CTRL key down and then click the name
of each file you wish to undelete.

Figure 3–11: Selecting a file to undelete

Using Acq/Gen Menu Commands
The Acq/Gen menu gives you access to commands to acquire or generate
MPEG-2 transport streams. There are three commands available from this menu:
Acquisition, Generation, and Interrupt transfer .

Undelete
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The Acquisition command acquires a transport stream from the selected input
port and stores it on the Data Store disks as a transport stream file. Figure 3–12
shows the Acquisition dialog box.

The Output group contains the CARB File text box and a Partition Type
drop-down list box. Enter the name that you want the transport stream saved
under in the CARB File text box. If the Data Store disks have more than one
partition, then choose the Partition type from the list box.

NOTE. The name of the Data Store File cannot already be in use by an existing
file or a file marked as “deleted”.

The Size group allows you to either define the size of the file acquired or leave it
open ended. If you want to leave the file size undefined, select the Not Defined
check box. This option allows the file to continue acquiring data until you
choose the Interrupt command (see page 3–179). If you do not select this check
box, you must enter a value in the text box. This number cannot be larger than
the selected partition size. When the MTS 210 has collected a file the same size
as defined in the text box, the acquisition process stops.

NOTE. The File Size must be greater than 1024 bytes.

Figure 3–12: The ACQUISITION dialog box

Acquisition
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The Interface group contains the Protocol, Port, Internal Clock, and Frequency
parameters. See Figure 3–13.

Figure 3–13: Examples of the Interface group

The Acquisition Protocol can be either Slave or Master. If it is Slave, the input
signal supplies the clock; therefore, neither Internal Clock or Frequency
parameters are available. Except that if the Port is set to G.703, the clock
frequency must be specified. If Protocol is set to Master, the Data Store board
generates the clock. Only the Parallel and Serial ECL ports can have Master
Protocol.

The Port parameter allows you to select at which port the incoming signal will
be available. The different ports conform to their own specification. The
available ports are: //ECL (Parallel ECL), Serial ECL, G.703, TTL (50 Ohm
TTL), and 10 Mbit Serial Port (RS–422).

The Internal Clock selects which of the internal references is used as the clock.
The options include: PLL, Osc 34.368 MHz, Ocs. 8.448 MHz, and External
Clock. If you select the PLL, then the Frequency parameter is available.

The frequency parameter should match the rate of the incoming signal. The
frequency range available is dependent upon the port as given in Table 3–14.

NOTE. The data rates for the G.703 ports must be exact. The PLL is not
available. Only these G.703 frequencies are available.

Table 3–14: Frequencies available for each port 

Port Minimum frequency Maximum frequency
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Parallel ECL ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

125 kHz ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

7.5 MHz
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Serial ECL ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1 MHz ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

60 MHz
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

G.703 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

8.448 MHz ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

34.368 MHz
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Table 3–14: Frequencies available for each port (Cont.)

Port Maximum frequencyMinimum frequency
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

TTL
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

1 MHz
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

45 MHz
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ10 Mbit Serial (RS422)

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ1 MHz

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ10 MHz

NOTE. The frequency step size is 1 Hz.

The Synchronization group (Figure 3–14) determines how the incoming signal
locks. The options include: none, PSYNC signal, and Pattern. None and Pattern
are available to all ports. PSYNC is only available to the ECL ports.

Figure 3–14: Examples of the Synchronization group

If you choose None and are using a serial port, you can not be sure to start at the
beginning of a byte or packet. In this case, it is better to choose pattern synchro-
nization. With Pattern synchronization, the first three packets are lost.

If Pattern is selected as the lock mode, then there are additional parameters that
also must be entered. These include: Stop if Desynchronized, Pattern (hex), and
Useful Bytes. If the Stop if Desynchronized check box is selected, the acquisi-
tion stops with an error message box after 8 bad synchronization bytes.

The Pattern is the actual synchronization signal in hexadecimal. For standard
transport packets, the sync byte is 47.

The Useful Bytes parameter is the size of the transport packet. The standard size
is 188.
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The simultaneous presence of PSYNC and the synchronization pattern is not
verified. The PSYNC signal is only used to trigger the start of acquisition
(detection of the first leading edge). Thus no desynchronization criterion exists
in this case. After the start of acquisition, the presence of the PSYNC signal is
not verified.

The mechanisms of synchronization and loss of synchronization vary according
to the synchronization method used given in Table 3–15.

Table 3–15: How synchronization works 

Synchronization method Acquisition begins with Loss of synchronization

none 1st clock received never

by PSYNC signal 1 recognition never

by pattern 3 exact recognitions Absence of exact recognition
during 8 cycles

If either of the ECL ports are in Master mode, then an additional group, Control
Port, is presented. See Figure 3–15. There are two or three parameters in this
group.

Figure 3–15: Examples of the Control Port group

The Useful Bytes parameter is the number of useful bytes as validated by a
validation signal.

Stuffing Bytes is the number of bytes when the DEN (data enable) is off.

Synchro. Byte Size is the synchronization signal size, in bytes. It can range from
1 to 4 bytes.
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NOTE. Only connect equipment to ports in use. This will prevent confusing data.
For example, for G.703 output, both G.703 ports are active at the selected rate,
but the voltage level is different on each port.

Changing Registry Values. To turn off the display of the dialog box after every
transfer, change the DefaultAlwaysDialogBox registry parameter. The possible
settings for the DefaultAlwaysDialogBox are shown in Table 3–18.

Table 3–16: DefaultAlwaysDialogBox registry parameter values 

Value Description

0x1 A dialog box is displayed after all transfers (default).

0 A dialog box is not displayed after transfers.

To change to value of the DefaultAlwaysDialogBox registry parameter, exit the
Data Store Administrator and use the Registry Editor program, Regedt32.exe,
located in the C:\WINNT\system32 directory.

NOTE. You do not have to be logged in with System Administrator rights to
change the DefaultAlwaysDialogBox parameter.

Use the following path to access the DefaultAlwaysDialogBox registry
parameter.

����	��������
������������������������

CAUTION. To prevent file corruption, verify that the Data Store Administrator is
not running before editing the DefaultAlwaysDialogBox parameter. When the
Data Store Administrator quits, it writes to the registry file and may overwrite
the value of the DefaultAlwaysDialogBox you have set.

The Generation command generates a transport stream (from a transport stream
file on the Data Store disks) and outputs it from the selected output port. Figure
3–16 shows the Generation dialog box.

The Source group contains the Data Store disks file selection. Select a file from
the drop-down list.

Generation
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Figure 3–16: The Generation dialog box

NOTE. The file must be on the Data Store disks to generate a transport stream.

If the Loop box is checked, it sends the file out continuously until it receives a
manual interrupt command. If it is not checked, the file is sent only once.

The Size text box is the size of the transport stream to be generated. It is
automatically filled in when a file is selected. You can use commas or spaces to
separate the digits. You can enter a smaller number if you do not want to use the
entire transport stream. If the Loop box is checked, the Size text box is not
available.

NOTE. Minimum file size for looping generation is one megabyte (1 Mb).

The Interface group allows you to select the output port and configure it to your
requirements. The parameters in this group include: Protocol, Port, Output
Clock, Frequency, Control Signals, Number Useful Bytes, Number Stuffing
Bytes, Stuffing Byte, and Synchronization Signal Size. All these parameters are
not always available. The availability is based on the Protocol and Port selected.

The Protocol can be either Master (the Data Store board generates the reference
clock) or Slave (the clock is generated by an external source). Only the ECL
ports can use Slave protocol.
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The Port drop-down list box selects which output port to use. The choices are:
//ECL (Parallel ECL), Serial ECL, G.703, TTL (the TTL 50 Ohm port), and
10 Mbit serial port (RS–422).

NOTE. Make sure equipment is only connected to ports in use. This will prevent
unexpected results.

All of the other parameters are based on the selected port. Table 3–17 lists all of
the non-control signal parameters available.

Table 3–17: The parameters available from each port 

l ig al
Oscillator
8 448 Hz

PLL

x e al lPort
Control signal
(DEN signal)

(8.448 MHz or
34.368 MHz) Min Max External clockÁÁÁÁÁÁ

ÁÁÁÁÁÁParallel ECL
ÁÁÁÁÁÁ
ÁÁÁÁÁÁAvailable

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁN/A

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ125 kHz

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ7.5 MHz

ÁÁÁÁÁÁ
ÁÁÁÁÁÁAvailableÁÁÁÁÁÁ

ÁÁÁÁÁÁSerial ECL
ÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ1 MHz

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ60 MHz

ÁÁÁÁÁÁ
ÁÁÁÁÁÁAvailableÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

G.703
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Not Available
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁ
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ÁÁÁÁÁÁ

TTL ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Not Available ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁ

1 MHz ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

45 MHz ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

10 Mbit Serial ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Not Available ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

N/A ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
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ÁÁÁÁÁÁ

Available

Output Clock allows you to select either one of the two internal oscillators
(8.448 MHz or 34.368 MHz) or the PLL. If you select the PLL, the Frequency
text box is displayed. Enter the desired frequency within the allowable range
(125 kHz to 60 MHz.) The frequency step size is 1 Hz.

NOTE. The data rates for the G.703 ports must be exact. Therefore only the two
internal oscillators with the G.703 frequencies are available.

The Control Signals check box is available only with the ECL ports since they
are the only ones with a DEN (data enable) signal. If Control Signals is selected
you are in “burst mode.”

NOTE. If you select burst mode, be sure that the first byte(s) of the file are sync
bytes (SB), typically 0x47, because the SB signal is on during the first byte(s) of
the file.

The Number of Useful Bytes is the number of bytes when DEN is on.

The Number of Stuffing Bytes is the number of bytes when the DEN is off. All
stuffing bytes have the same value, that entered in the Stuffing Byte text box.
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The Sync Signal Size is the number of bytes when the SB signal (Sync Byte) is
on.

Changing Registry Values. To turn off the display of the dialog box after every
transfer, change the DefaultAlwaysDialogBox registry parameter. The possible
settings for the DefaultAlwaysDialogBox are shown in Table 3–18.

Table 3–18: DefaultAlwaysDialogBox registry parameter values 

Value Description

0x1 A dialog box is displayed after all transfers (default).

0 A dialog box is not displayed after transfers.

To change to value of the DefaultAlwaysDialogBox registry parameter, exit the
Data Store Administrator and use the Registry Editor program, Regedt32.exe,
located in the C:\WINNT\system32 directory.

NOTE. You do not have to be logged in with System Administrator rights to
change the DefaultAlwaysDialogBox parameter.

Use the following path to access the DefaultAlwaysDialogBox registry
parameter.

����	��������
������������������������

CAUTION. To prevent file corruption, verify that the Data Store Administrator is
not running before editing the DefaultAlwaysDialogBox parameter. When the
Data Store Administrator quits, it writes to the registry file and may overwrite
the value of the DefaultAlwaysDialogBox you have set.

The Interrupt transfer  command stops the current Acquisition or Generation
process.

Using Service Menu Commands
The Service menu contains “housekeeping” commands for the Data Store disks
and the Data Store board. The commands available from this menu are: Board
Reset, Resource[s] Parameters, FAT Delete, Disk[s] Partitioning , Disk[s]
Compress, and Disk[s] Motor control .

Interrupt Transfer
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The Board Reset command performs a software reset on the Data Store board.
Use this command after an error occurs (such as locking the application) to “fix”
the software.

The Resource Parameters command changes the resource parameters for the
Data Store board. These parameters should never be changed during normal
operation.

Figure 3–17: The Resource Parameters dialog box

Figure 3–17 displays the Resources Parameters dialog box. The parameters
available include:

� Slot is the slot number where the Data Store board is physically located.
(Default is 2.)

� Dialog Interrupt is the interrupt used for the dialog between the PC and the
Data Store board. (Default is 15.)

� DMA Interrupt is the interrupt used for DMA exchange. (Default is 10.)

� DMA Channel is the channel used for DMA exchange. (Default is 1.)

The FAT Delete command initializes the Data Store disks. The partitions are
preserved, but all files are lost. Performing a Fat Delete has the same affect as
deleting all files in the Files informations list (with the Delete command on the
File menu) and then using the Compress command (described below). You
cannot recover these files; be sure you are aware of the consequences before
using the Fat Delete command.

The Disk[s] Partitioning  command creates the disk partitions. It must be run
each time Data Store disks are added, removed, or replaced. It can be run
whenever you want to change the size or number of partitions. (See
Figure 3–18.)

Board Reset

Resource[s] Parameters

FAT Delete

Disk[s] Partitioning
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CAUTION. Partitioning erases all files from the Data Store disks; erased files
cannot be recovered. Be sure to transfer important files to the system disk or
another backup medium before partitioning the Data Store disks.

Figure 3–18: The Partitioning dialog box

Select the partition type from the drop-down list box. The choices are Single
shot, Loop, and Single shot & loop. When you select Single shot & loop, you
must also specify the portion of the available size you wish to use as the loop
partition.

The Disk[s] Compress command frees the disk space of all files marked for
deletion. This command performs the actual deletion and then optimizes the files
on the Data Store disks for maximum efficiency. You are always given a message
box to confirm this operation. See Figure 3–19.

Figure 3–19: The Compress confirmation dialog box

Disk Compress
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NOTE. The command can take a long time to complete. The Compress function
requires approximately one second per megabyte of disk space to compress the
Data Store disks.

For more information on why compression is necessary, see Special Features of
the Data Store disks beginning on page 3–162. If you wish to remove all files
from the Data Store disks, use the FAT Delete command, described on
page 3–180.

The Disk Motor control submenu contains three commands: Automatic control
Parameters, Start Disks motor, and Stop Disks motor.

Figure 3–20: The Disks Motor control submenu

Select Stop Disks motor to stop the Data Store disk motors when you intend to
leave the MTS 210 server running for an extended period but know that you will
not be using the Data Store system for some time. Stopping the Data Store disk
motors will extend their life. Note that restarting the Data Store Administrator
application or copying a file either to or from the system disk will also automati-
cally restart the disk motors.

Select Start Disks motor to manually restart the Data Store disk motors.

Select Automatic control Parameters to set an automatic motor stop delay.
Automatic stop in the resulting dialog box; the Motor delay entry box appears
as shown in Figure 3–21. The default delay is 10 minutes; recommended
minimum delay period is four hours, or 240 minutes. The disk motors automati-
cally stop after the specified delay period has passed with no disk access.

Figure 3–21: Specifying automatic motor control parameters

Disk[s] Motor control
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Changing MSB/LSB Order
When the Data Store system is configured appropriately, you can specify the bit
order of the transport stream serial port or input through the Interface section of
the ACQUISITION  and GENERATION  dialog boxes. Select the Msb first
check box, located at the lower-left corner of the dialog box, when you expect to
receive data MSB-first or wish to output MSB-first data. Notice that the option is
only available when a serial port is selected and when the Data Store system is
configured for the option.

Select to output
MSB first

Figure 3–22: The Msb first option

Use the Set CARB application to specify whether the MSB/LSB option appears
in the dialog boxes.

1. Select Set Carb from the MPEG Test System submenu or program group.
The window shown in Figure 3–24 appears.

Figure 3–23: Starting the Set CARB application
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2. The Msb first  option appears only when the MSB and LSB possibility
option is selected. Click the check box to select or clear the option.

Figure 3–24: The Data Store Setup window

3. After you change the MSB and LSB possibility setting, click Restart.

Data Store Transfers
The easiest way to check the operation of an MTS 210 is with another MTS 210
or an MTS 215. The results of MTS 210 to MTS 210 transfers will be vary
depending on generation, acquisition, and synchronization mode.

In either acquisition or generation, files can be processed in loop-back mode.
During read or write file loop back, the system must be configured to assure that
the data flow is never interrupted. The file loop back does not cause the insertion
of stuffing data. Refer to Table 3–19 for information on MTS 210 to MTS 210
transfers.

Table 3–19: MTS 210 to MTS 210 transfer results 

Interface
Generation
mode Acquisition mode Expected result

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ECL
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Non-looping
ÁÁÁ
ÁÁÁ
ÁÁÁ

Size:

Sync:

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Generator’s File size

Sync Byte
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ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Auto stop,
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ECL
ÁÁÁÁÁÁ
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Non-looping
ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ

Size:

Sync:

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
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first three packets lost.
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Not defined

None, Pattern, or Sync Byte
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No auto stop, 
manual stop size is truncated in
1 Mbyte (1024 Bytes).
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Table 3–19: MTS 210 to MTS 210 transfer results (cont.)

Interface Expected resultAcquisition mode
Generation
mode
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ECL ÁÁÁÁÁÁ
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Non-looping ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ
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ÁÁÁÁÁÁÁÁÁÁ

> Generator’s file size

None, Pattern, or Sync Byte
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ÁÁÁÁÁÁÁÁÁÁ
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ÁÁÁÁÁÁÁÁÁÁ

No auto stop, 
manual stop size is not predictable
because the algorithm for smooth-
ing the size of each internal trans-
ferred block.

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

G.703, TTL, or 
10 Mbit/sec serial
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Non-looping ÁÁÁ
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Generator’s file size
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ÁÁÁÁÁÁÁÁÁÁ

Auto stop,
first three packets lost and last
three packets are stuffed “FF”.ÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

G.703, TTL, or
10 Mbit/sec serial
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
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ÁÁÁ
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Pattern or None
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No Auto stop,
manual stop is truncated in
1 Mbyte (1024 Bytes) increments.
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G.703, TTL, or
10 Mbit/sec serial
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Non-looping ÁÁÁ
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> Generator’s file size

No synchronization or synchroniza-
tion on pattern with NO stop after
desynchronization
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ÁÁÁÁÁÁÁÁÁÁ
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Auto stop,
remaining packets to the end of the
file are stuffed “FF”.
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10 Mbit/sec serial
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> Generator’s file size

No synchronization and synchro-
nization on pattern with AUTOMAT-
IC stop after desynchronization
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Auto stop,
the requested size is not reached.
The size of the stored file is not
user predictable because of the
algorithm for smoothing the size of
each internal transferred block.ÁÁÁÁÁÁÁÁÁ
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Acquirer’s file size

None, Pattern, or Sync Byte (ECL
only)
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Auto stop.
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ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
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Not defined.

None, Pattern, or Sync Byte (ECL
only)
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No auto stop,
manual stop size is truncated in
1 Mbyte (1024 Bytes) increments.

Problems
You may encounter problems while using the Data Store Administrator.

� If the Data Store board does not respond to commands, but the application
will respond to mouse or keyboard input, try selecting the Board Reset
command on the Service menu.

� Some problems result in on-screen error messages;  refer to Error Messages,
below, for a brief explanation of the Data Store error messages.

� You may be able to clear an error condition by shutting the MTS 210 server
down and switching power off for approximately five minutes; try doing so
before proceeding to When All Else Fails, on page 3–187.
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The following is a list of error messages and their meanings. Recall that CARB
is a French acronym for the Data Store system.

CARB Time out Error  (ERR_CARB_TIME_OUT)
Time–out in TEST mode (i.e.: SCSI access, EISA access ...)

Desynchronization (ERR_CARB_DESYNCHRONIZATION)
During an acquisition with stop on desynchronization option,  the synchro-
nization pattern has been lost

Disk error  (ERR_CARB_DISK_ERROR)
Indicates a disk error on a check condition SCSI request

Disk Initialization Error  (ERR_CARB_DISK_INIT)
The first disk does not respond to the initialization sequence.

End of disk Error  (ERR_CARB_END_OF_DISK)
Caused by an attempt to access outside the end of the disk or partition

End of file Error  (ERR_CARB_END_OF_FILE)
Caused by an attempt to access outside the end of the file

Error busy card  (ERR_CARB_DRIVER_BUSY)
There is already a command in progress.

Error : file not found  (ERR_CARB_FILE_NOT_FOUND)
The file is not listed on the Data Store disks FAT (file allocation table).

Error : no partition  (ERR_CARB_NO_PARTITION)
No partition exists on the Data Store disks; you must create a partition before
capturing or storing a file

Error : unknown command code (ERR_CARB_CODE_UNKNOWN)
The CPU has received an unknown command.

FAT Error  (ERR_CARB_FAT_ERROR)
No partition exists on the Data Store disks; you must create a partition before
capturing or storing a file.

FAT Full Error  (ERR_CARB_FAT_FULL)
255 files (32 files, on early instruments) are present on the Data Store disks,
not able to create another one

File already exist (ERR_CARB_FILE_ALREADY_EXIST)
Try to create a file that already exist

Line Error  (ERR_CARB_LIGNE_ERROR)
Overflow in acquisition mode (the line FIFO is full)

Parameter error (ERR_CARB_PARAM_ERROR)
A parameter of the command is incorrect (i.e.: value out of range).

Error Messages
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SCSI Error  (ERR_CARB_SCSI_ERROR)
Disk error on non DMA operations

SCSI Overflow Error  (ERR_CARB_OVERFLOW_SCSI)
The SCSI memory bank is full, causing an overflow in acquisition mode.

SCSI Read Error (ERR_CARB_READ_SCSI)
Disk error on DMA read operations

SCSI Write Error  (ERR_CARB_WRITE_SCSI)
Disk error on DMA write operations

System Error (ERR_CARB_SYST_ERROR)
SCSI memory bank underflow or SCSI disks not responding

Time-out Error  (Detected by CPU) (ERR_CARB_DRIVER_TIME_OUT_2)
The Data Store board does not respond to the NT driver request (The CPU
board has received the NT driver request but does not respond to it)

Time-out Error  (Not detected by CPU) (ERR_CARB_DRIVER_TIME_OUT)
The Data Store board does not respond to the NT driver request (The CPU
board has not received the NT driver request)

If an error message does not explain the problem sufficiently and a temporary
shutdown does not clear the problem, please contact your nearest Tektronix
representative or service facility.

When All Else Fails
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Using the Packet Jitter Application

Part of the MTS 210’s function is not only to create error-free transport streams
but also to create transport stream files with known errors.

The Packet Jitter application allows you to create transport stream files with
multiplex errors in assigning the PCRs or which simulate transmission delay
variations that affect the clocks of the transport file. This allows you to test the
robustness of decoders under various conditions.

This application takes in a transport stream file (*.trp), introduces clock jitter to
the *.trp file, and creates a new *.trp file.

This section of the manual explains all of the commands available from the
Packet Jitter application.

Application
The main application of the resulting Packet Jitter files is to aid in designing
decoder PLLs. The known errors produced by the Packet Jitter application
introduce a known amount of jitter into the transport stream. This application
modulates the data values in the PCRs away from their correct values. The
receiving PLL is then required to filter out these modulations in order to produce
a stable clock reference. Use these transport stream files in real-time hardware
experiments at the receiver, not for Analyzer tests. The Analyzer application will
show the errors purposely introduced into the PCR data.

Terms
This application is similar to the Multiplexer application in that it outputs a
transport stream file not a transport stream. Since there is an important difference
between the two terms, the definitions are repeated here for emphasis.

A transport stream is the signal that comes out of (or into) one of the connectors
on the rear panel of the MTS 210.

A transport stream file is a file on a disk. When the MTS 210 sends this file out
one of the rear panel connectors (properly timed), it becomes a transport stream.
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Starting the Packet Jitter Application
To start the Packet Jitter application, choose Packet Jitter from the Tektronix
MPEG Test System program group.

Menu Commands

Table 3–20: Packet Jitter menu commands 

Menu Command Function

File Open Opens a transport stream file for addition of jitter

Quit Exits the Packet Jitter application

Jitter Definition Allows you to define the PCRs and type of jitter added

Go(Calculate) Calculates a new transport stream file with jitter added (*.jit).

? Help Provides help for the Packet Jitter application

The File menu commands allow you select a transport stream to work on and to
close the application.

Open. Choosing the Open command brings up the Multiplex Transport File
dialog box shown in Figure 3–25.

File Menu



Using the Packet Jitter Application

Tektronix MPEG Test System User Manual 3–191

Figure 3–25: The Multiplex Transport File dialog box

Select a file from the File Name list and choose OK. This returns with the List of
Programs window in the application window. See Figure 3–26. Use this as a
quick reference for PID numbers when defining the jitter (see page 3–192).

Figure 3–26: The List of Programs window

Quit. The Quit command closes the Packet Jitter application. No verification of
the Quit command is given before exiting the application.

The Jitter menu commands allow you to define the jitter and perform the jitter
calculation.

Jitter Menu
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Definition. Choosing the Definition command brings up the PCR Clock Selection
dialog box. See Figure 3–27.

Figure 3–27: The PCR Clock Selection dialog box

This dialog box allows you to choose if the jitter calculation is done to all PCR
clocks or only the PCR for one PID (program). This permits you to have a set of
reference PCRs in the same transport stream file.

Once the option is selected, choose OK. This brings up the Jitter Type dialog
box. See Figure 3–28.
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Figure 3–28: The Jitter Type dialog box

The Jitter Type dialog box allows you to choose the kind of jitter you want
inserted into the PCRs. Select from: Offset, Square, Sine, or Random. Only one
option is allowed.

Offset simply adds the value (time) entered in the Value text box to the PCRs. Its
equation is:

PCR = PCR + offset

Where offset equals the time entered in the text box.

Square also adds a value (time) to the PCR but the time is calculated by the
equation:

PCR(n) = PCR(n) + square(t)

Where square(t) equals the value of the square wave defined by the period and
amplitude entered in the Jitter Type dialog box at the time defined by PCR(n).
See Figure 3–29.
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+A

-A

0

PCR1 PCR2 PCR3

Time (+)

T

Figure 3–29: Illustration of the square jitter function

Using PCR2 in Figure 3–29 as an example, the value of the square wave at
PCR2 is A, thus the “jitter-added” PCR2 = PCR2 + A.

Sine jitter is like the square jitter except it is a sine wave instead of a square
wave. The equation for the PCR calculation is:

PCR(n) = PCR(n) + Asin(t)

Where Asin(t) is the sine function defined by the period entered in the text box
in the Jitter Type dialog box times the defined amplitude. Figure 3–30 illustrates
this concept.

+A

-A

PCR1 PCR2 PCR3

Time (+)

T

PCR4

Figure 3–30: Illustration of the sine jitter function

Using PCR2 from Figure 3–30 as an example, the value of the sine wave at
PCR2 is –0.55A. Thus, after jitter is applied, PCR2 will equal the correct value
of PCR2 less 0.55A.
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Random adds uniformly distributed random values to the PCRs. The range of
the random values is between 0 and the value (plus or minus) defined in the
Value field. The equation for the PCR is then:

PCR = PCR ± random

When the desired type of Jitter is defined, choose OK. This does not cause any
changes to the *.trp file. It only defines the changes that will be made when the
Calculate command is called.

The Jitter application allows you to set jitter frequency independent of the PCR
rate. To prevent misleading results, only use jitter frequencies less that one-half
the PCR frequency. For example, if the PCR rate is 25 per second (period = 0.04
second) then the maximum jitter frequency the user should specify is 12.5 Hz
(period = 0.08 second). For an example of a jitter frequency that is too high for
the PCR frequency, see Figure 3–29.

NOTE. The PCR Analysis uses the previous PCR as the reference point to
calculate the error in the current PCR. This can cause the error calculation to be
misleading for some PCR jitter functions. Specifically, the jitter added by the
MTS 100 may not be easily interpreted by the PCR analysis display.

Calculate. The Calculate command uses the parameters defined by the Definition
command to create a new transport stream file with jitter included. First, the
Calculate command displays the Output File dialog box shown in Figure 3–31.

Figure 3–31: The Output File dialog box

Use this dialog box to name the resulting transport stream file. Enter the desired
name in the File Name dialog box; the *.trp extension is automatically added.
Once you choose OK, the jitter calculation begins. As shown in Figure 3–32,
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there is a status gauge that shows you how far the calculation has progressed. It
also shows the type of Jitter being added and the parameters. The Status Bar also
gives information on the calculation.

Figure 3–32: The display during jitter calculation

When the calculation is complete, the status gauge reads 100%. The new file can
then be used as a transport stream file.

Figure 3–33 shows the result of a “jittered” file that has had its PCRs analyzed
by the Analyzer application. If you viewed this screen on the MTS 210, you
would see that most of the clocks are in error (red).
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Figure 3–33: PCR analysis of a “jittered” transport stream file

The ? menu allows you to access the Help command.

Help. The Help command gives you additional information about the application
and its commands.

About Packet Jitter. Choose the About command to display the Packet Jitter
version and copyright information.

Toolbar
There are three commands on the toolbar: Open, Definition, and Calculate; they
are explained in Table 3–21.

Table 3–21:  Commands available from the Packet Jitter toolbar

Icon Name Function

Open Chooses the transport stream file and places its program PID
numbers in the List of Programs window. (See page 3–190.)

Definition Defines the type of Packet Jitter added to the transport stream
file. (see page 3–192.)

Calculate Creates a new transport stream file with the defined amounts
of jitter added to the PCRs. (see page 3–195.)

? Menu



Using the Packet Jitter Application

3–198 Tektronix MPEG Test System User Manual



Tektronix MPEG Test System User Manual 3–199

Using DVB Channel Coding & Decoding

The European Digital Broadcasting Project (DVB) has specified a baseline
system for satellite broadcasting. The Channel Coding portion of the specifica-
tion has the following coding flow:

� MPEG-2 Transport stream file (Multiplexer)

� Energy Dispersal — randomizing

� Outer Coder RS (204, 188) — for byte error correction

� Interleaver — better burst error correction

� Inner Coder (Viterbi p/q) — bit error correction

� QPSK Modulator

The Coder/Decoder application provides the defined channel coding for the
transport stream file and also provides the decoding to return the coded file to a
standard transport stream file.

Table 3–22 lists the type of coding/decoding, the type of input expected, and the
resulting file.

Table 3–22: Expected input file types 

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Operation
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Expected Input Type
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Output Type
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁEnergy Dispersal

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ*.trp

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ*.edsÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁReed-Solomon
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ*.eds

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ*.resÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁByte Interleaving
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ*.res

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ*.inlÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁViterbi Encoding
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ*.inl

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ*.vtbÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Byte Deinterleaving
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

*.inl
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

*.din

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Reed-Solomon decoding ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

*.din ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

*.drs

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Energy Dispersal removal ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

*.drs ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

*.edr
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Starting the Application
Start the DVB channel Coding & Decoding application by double-clicking on
the DVB Channel Coding and Decoding icon. Figure 3–34 shows the application
window with the major parts named.

Status bar

Duration gaugeTitle bar

Menu bar

Figure 3–34: The initial Coding/Decoding application window

Duration Gauge. The Gauge gives the status of the coding or decoding operation
in percent.
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Menu Commands
This section lists the commands available from the Menu bar and explains how
to use them.

Table 3–23: Commands from DVB Channel Coding & Decoding 

Menu Commands Function

ÁÁÁÁ
ÁÁÁÁ

File ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Quit ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Exits the Coder/Decoder application

ÁÁÁÁ
ÁÁÁÁ

Coding ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Chain ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines a list of coding modules

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Energy Dispersal ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines and performs Energy Dispersal coding on a
selected file

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Reed - Solomon ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines and performs Reed-Solomon coding on a
selected fileÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Interleaver
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines and performs Interleaver coding on a selected
field

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Viterbi
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines and performs Viterbi coding on a selected file
ÁÁÁÁ
ÁÁÁÁ

Decoding
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Chain
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines a string of decoding modules for a fileÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁDe-Interleaver

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁDecodes a file for Interleaver codingÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁReed - Solomon

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁDecodes a file for Reed-Solomon codingÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Energy Dispersal
Removal

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Decodes a file for Energy Dispersal coding

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

Generation Pattern Generates a user-defined repetitive pattern and puts it in
a file

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

Transport Packet Generates a user-defined pseudo transport packet and
puts it in a file

? Help Provides useful information on all the commands and
additional information on coding in general

The File menu only offers the Quit command.

Quit. The Quit command exits the Coder/Decoder application.

File Menu
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The Coding menu provides access to the required DVB Channel Coding for
satellite broadcasting (Energy Dispersal, Reed-Solomon, Interleaver, and
Viterbi). It also provides for chaining the various coding methods together.

Chain. The Chain command allows you to create DVB-compliant files. Fig-
ure 3–35 shows the Coding Chain dialog box.

Figure 3–35: The Coding Chain dialog box

Each check box is for one module in the coding chain. When all the check boxes
are selected, then coding will produce a DVB-compliant file. If you deselect any
of the check boxes, then you will generate a non-compliant file. (This feature is
available for testing purposes.)

NOTE. If Energy Dispersal is not selected, it is replaced by a “B8 sync byte add
only” module in the chain.

When you select OK for this option box, the dialog box shown in Figure 3–36 is
displayed. Select the file to code using this dialog box.

Coding Menu
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Figure 3–36: The Open dialog box for the Chain command

Although all file types (*.*) are available, the expected file type, for DVB
compliance, is a *.trp file. This is a transport stream file. Make a transport
stream file by either using the Multiplexer application or by acquiring one from a
transport stream input through a rear-panel connector.

Once you select OK, the coding process begins. Each coding module is
performed in the order given in the dialog box. During the coding process there
is a gauge in the Application Window that gives the status of the coding. The
gauge goes from 0 to 100% for each type of coding.

NOTE. If you need to stop the coding process, press the ESC key. This stops the
coding with the current coding module.

“READY” in the status bar indicates that the coding process is finished for all
selected modules and the application is ready for another command. There are
now three additional files in the same directory as the original transport stream
file. They are the *.eds, *. res, and *.inl files with the same base name as the
original file.

For more information on the individual coding modules, see their individual
descriptions (Energy Dispersal is on page 3–214, Interleaver is on page 3–216,
and Reed-Solomon is on page 3–215).

Energy Dispersal. The Energy Dispersal command allows you to use this coding
scheme alone, instead of in conjunction with the other code modules using the
Chain command. This module performs the sync byte inversion for the first of
each group of eight transport packets and randomizing the data using a PRBS
(Pseudo Random Binary Sequence). For more information on the actual coding,
refer to Energy Dispersal Coding on page 3–214.

Selecting Energy Dispersal opens the dialog box shown in Figure 3–37.
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Figure 3–37: The Energy Dispersal Open dialog box

This first byte of the selected input file should be the first byte of a transport
stream packet file (the sync byte, 47HEX). Therefore, the input file should be a
transport stream file, *.trp. Other file types are permitted, as long as they meet
the sync byte requirement.

When you choose OK, the coding process starts. There is a gauge in the
Application Window that gives the status of the coding process. When the gauge
reads 100% and “READY” is displayed in the Status bar, then the coding process
is complete.

The completion of the coding results in a file with the same base name as the
original, except the extension is *.eds.

If you choose a file that is not appropriate for Energy Dispersal the coding will
occur anyway.

You can stop the coding process at any time, by pressing the ESC key.

Reed-Solomon. The Reed-Solomon coding takes the randomized transport packet
(from the Energy Dispersal coding) and adds 16 bytes to the field. (188 initial
packet size + 16 bytes of Reed-Solomon = 204 bytes.) For a more detailed
explanation of Reed-Solomon coding, see Reed-Solomon Coding on
page 3–215.

Figure 3–38 shows the Reed-Solomon dialog box that is displayed after choosing
this command. You enter the desired Coded Block Size and Size of Block to
Code in the appropriate text boxes. The maximum for both parameters is 255.
The default values (204 and 188) are the correct values for DVB.
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Figure 3–38: The Reed Solomon dialog box

If you choose the Configuration command button, the dialog box shown in
Figure 3–39 appears.

Figure 3–39: The Reed-Solomon Configuration dialog box

The Reed-Solomon Configuration dialog box allows you to define different
values for p(x) (the Field Generator Polynomial), and alpha, which is the first
root of p(x). The default values are the correct ones for DVB applications.

When the configuration is complete, return to the Reed-Solomon dialog box by
selecting OK. When you are ready to code a file, select OK from the Reed-Solo-
mon dialog box. This returns the Open dialog box. Notice that this coding
module will only accept an *.eds file (one that has already been Energy Dispersal
coded).

Select a file and enter it in the File Name text box. Then choose OK. This starts
the Reed-Solomon coding process. The gauge displayed in the Application
Window tracks the progress of the coding process. When the coding is complete,
the gauge reads 100% and the Status bar says READY.

The coding results in a file with the same base name as the original, except it has
the extension *.res.
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Interleaver. This module performs the convolutional byte interleaving. See
page 3–216 for more information on the coding process.

When you choose the Interleaver command, the dialog box in Figure 3–40
appears. (There are no parameters for you to adjust for this coding module.)

Figure 3–40: The Open dialog box for Interleaver coding

The Interleaver requires a *.res file (a file that has already gone through
Reed-Solomon coding). After selecting a file to code, choose OK. This causes
the Interleaver coding module to begin. A gauge in the Application Window
keeps track of the coding progress. The coding is complete when the gauge reads
100% and the Status bar says READY.

Interleaver coding results in a file with the same base name as the selected file,
except the extension is *.inl.

Viterbi. Viterbi performs the inner coding based on Viterbi punctured convolu-
tional code. For more information on the coding, refer to Viterbi Coding on
page 3–217.

NOTE. This application does not provide a method to decode Viterbi coding.

The dialog box in Figure 3–41 appears when you choose Viterbi.
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Figure 3–41: The Viterbi dialog box

This dialog box allows you to choose the Viterbi Code. It can be: 1/2, 2/3, 3/4, or
7/8, with 7/8 being the default. When you choose OK, the open dialog box of
Figure 3–42 appears.

Figure 3–42: The Open dialog box for Viterbi coding

This dialog box allows you to select the file for Viterbi coding. The expected file
type is an *.inl (Interleaver coding result). Once you select the file, choose OK.
This begins the Viterbi coding process. A gauge in the Application Window
tracks the progress of the coding. The coding is complete when the gauge reads
100% and the Status bar says “READY”.

The result of this module is a file with the same base name as the original file,
but it now has *.vtb as the extension.



Using DVB Channel Coding & Decoding

3–208 Tektronix MPEG Test System User Manual

The Decoding menu provides access to the required DVB Channel Decoding for
satellite broadcasting (Deinterleaving, Reed-Solomon Decoding, and Energy
Dispersal Removal). It also provides for chaining the various decoding methods
together.

Chain. The Chain command allows you to decode the transport stream file using
the DVB-compliant method. Figure 3–43 shows the dialog box associated with
the Chain command.

Figure 3–43: The Decoding Chain dialog box

You can deselect any of the check boxes, but all are required to generate
DVB-compliant files.

Start Chain decoding by choosing OK. A gauge appears in the Application
window that keeps track of the progress of each decoding operation. The whole
chain decoding is complete when the gauge reads 100% and the Status bar says
“READY.”

If you deselect any of the decoding modules, you may generate DVB non-com-
pliant files. Use this only for testing purposes.

If the Energy Dispersal Removal module is not selected, it is replaced by a B8
sync byte removal module in the chain.

Decoding
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If you need to stop the decoding process, press the ESC key. This will end the
entire decoding chain with the current module.

Deinterleaver. Choosing the Deinterleaver command brings up the dialog box
shown in Figure 3–44.

Figure 3–44: The Open dialog box for the Deinterleaver

The expected input file is one generated by the Interleaver coding module (*.inl),
but the Deinterleaver module will accept any file.

When you choose OK, the Deinterleaving module begins. The gauge in the
Application Window tracks the status of the decoding process. The decoding is
complete when the gauge reads 100% and the Status bar says “READY”. The
resulting file has the same base name as the original, except is has the extension
*.din.

If you need to end the decoding at any time, press the ESC key.
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Reed-Solomon. Choosing the Reed-Solomon command brings up the dialog box
shown in Figure 3–45.

Figure 3–45: The Open dialog box for Reed-Solomon decoding

The expected input file is one generated by the Deinterleaver coding module
(*.din).

When you choose OK, the Reed-Solomon decoding module begins. The gauge
in the Application Window tracks the status of the decoding process. The
decoding is complete when the gauge reads 100% and the Status bar says
“READY”. The resulting file has the same base name as the original, except it
has the extension, *.drs.

If you need to end the decoding at any time, press the ESC key.

Energy Dispersal Removal. Choosing the Energy Dispersal Removal command
brings up the dialog box shown in Figure 3–46.

Figure 3–46: The Open dialog box for Energy Dispersal Removal
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The expected input file is one generated by the Deinterleaver coding module
(*.drs), although this decoding module will accept any file type.

When you choose OK, the Energy Dispersal Removal decoding module begins.
The gauge in the Application Window tracks the status of the decoding process.
The decoding is complete when the gauge reads 100% and the Status bar says
“READY”. The resulting file has the same base name as the original, except it
has the extension, *.edr.

If you need to end the decoding at any time, press the ESC key.

The Generation menu allows you to create new *.trp files by defining a pattern
or transport packets.

Pattern. This command generates a user-defined pattern. First, the Save As dialog
box shown in Figure 3–47 appears. Note that a default extension is not provided
for the file name. However, if you enter a file name without an extension, *.plp
is added automatically.

Figure 3–47: The Save As dialog box for the Pattern command

The first Pattern dialog box then appears as shown in Figure 3–48. This dialog
box requests the number of bytes in the pattern.

Generation
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Figure 3–48: Enter the number of bytes in the pattern

The next dialog box, shown in Figure 3–49, defines the Composition Motif (the
repetitive pattern). Enter the desired byte value, in hexadecimal. One byte is
placed in each Composition Motif dialog box; therefore as many of these dialog
boxes will appear as the number of bytes in the pattern (defined in the Pattern
dialog box, shown in Figure 3–48).

Figure 3–49: The Composition Motif

The final dialog box, shown Figure 3–50, allows you to define the number of
times that the pattern repeats. Once this number is entered in the text box and
OK is chosen, the pattern is created and stored in the selected file.

Figure 3–50: Set the number of pattern repetitions

Transport Packet. This command generates a repetitive pattern of user-defined
transport packets.

Transport Packets, shown in Figure 3–51, is the first dialog box. First, choose if
you want to define the payload or choose to have random data loaded. If the
CCITT 2^15-1 check box is selected, then random data is generated for the
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payload. In this case, you can only set the value of the first text box under
Transport Packet Header and the last three text boxes are grayed. The default
value of the first text box is 47. You can change the value if you wish. If the
CCITT 2^15-1 check box is not selected, then you can define the values in all
the text boxes under the Transport Packet Header. The default values in this case
are 47 00 00 00.

Figure 3–51: The Transport Packets dialog box

You also define the payload, which is then repeated 184 times.

After you have entered all of the desired data, choose OK. This brings up the
Number of Packets dialog box as shown in Figure 3–52. Enter the number of
transport packets you want in the transport stream file in the text box.

Figure 3–52: The Number of Packets dialog box

After entering the number of packets, choose OK. This brings up the Save As
dialog box shown in Figure 3–53. Enter the name of the file that you want the
transport packets saved under. Note that a default extension is not provided for
the file name. However, if you enter a file name without an extension, *.plp is
added automatically.



Using DVB Channel Coding & Decoding

3–214 Tektronix MPEG Test System User Manual

Figure 3–53: The Save As dialog box

When you choose OK, the application creates the desired transport stream file.
When the Gauge reads 100%, the transport stream file is complete.

Coding
This section gives an explanation of each of the various types of coding available
from this application.

This is the first coding module and the last decoding module.

The input of this coding module is an MPEG-2 transport stream, which is a
concatenation of packets of 188 bytes (1 sync byte plus 187 data bytes). See
Figure 3–54.

SYNC
1 byte

203 bytes

47HEX

Figure 3–54: The MPEG-2 Transport packet

In order to comply with DVB and to ensure adequate binary transitions, the data
from the MPEG-2 multiplex (transport stream file) is scrambled with a Pseudo
Random Binary Sequence (PRBS). The processing order at the transmitting side
always starts from the Most Significant Bit (MSB) of the synchronization byte (0
of 01000111).

Energy Dispersal Coding



Using DVB Channel Coding & Decoding

Tektronix MPEG Test System User Manual 3–215

The polynomial for the PRBS generation is : X15 + X14 + 1. It uses the 15-bit
shift register shown in Figure 3–55 for scrambling and descrambling (in the
channel coding process).

Enable
Clear/scrambled

data input

Scrambled/descrambled
data output

2 3 4 5 6 7 8 9 10 11 12 13 14 151

Figure 3–55: The Scrambler/Descrambler schematic for the PRBS

At the start of every eighth transport packet, the sequence 100101010000000
loads into the shift register. This provides an initialization signal for the
descrambler. The MPEG-2 sync byte (for the first transport packet in the group
of eight packets) is then inverted bit-wise from 47hex to B8hex. The first bit at the
output of the PRSB generator is applied to the first bit (MSB) of the first byte
following the inverted MPEG-2 sync byte (B8hex). To aid other synchronization
functions, during the MPEG-2 sync bytes of the subsequent seven transport
packets, the PRSB generation continues but its output is disabled, leaving these
bytes unrandomized. Thus the period of the PRSB sequence is 1503 bytes. See
Figure 3–56.

B8 187 randomized bytes 187 randomized bytes 187 randomized bytes 187 randomized bytes47 47 B8

8 randomized transported packets

Figure 3–56: The output after Energy Dispersal coding

The Reed-Solomon RS (204, 188) code corrects up to 8 bytes in a 204 byte
block. This module takes each randomized transport packet at the output of the
Energy dispersal module and produces 204 bytes by calculating and adding 16
bytes at the end of the packet (188 bytes).

The Reed-Solomon calculates in a Gallois Field generated by the polynomial:

p(x) = x8 + x4 + x3 + x2 + 1

The RS code generator polynomial (used for the 16 byte calculation) is:

g(x) = (x + �0)(x + �1)....(x + �15)

Reed-Solomon Coding
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where � = 02hex

The RS (204,188), shortened code from the original RS (255,239), is implement-
ed by adding 51 bytes, all set to zero, before the information bytes (a transport
packet) at the input of an RS (255, 239) encoder. After the RS coding procedure,
these null bytes are discarded.

B8 187 randomized bytes 16 bytes

Figure 3–57: The transport packet after Reed-Solomon coding

Convolutional Interleaving, with depth I = 12, is applied to the error protected
packets. The conceptual diagram of the Interleaver is shown in Figure 3–58.

Interleaver
input

Interleaver
output

17 = M cells

17x2 cells

17x11 cells

0

1

2

11

Figure 3–58: The conceptual diagram of the Interleaver coder

The Interleaver has 12 branches, cyclically connected to the input byte-stream by
the input switch. Each branch is a FIFO shift register, with depth (MJ) cells.

where M = 17 or N/I 
N = 204 the error protected frame length 
I = 12 the interleaving depth 
J = branch index

The cells of the FIFO contain 1 byte, and the input and output switches are
synchronized.

For synchronization purposes, the sync bytes and the inverted sync bytes are
always routed in the branch “0” of the Interleaver (corresponding to a null
delay).

Convolutional Interleaving
Coding
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The Deinterleaver is similar to the Interleaver, but the branch indexes are
reversed (that is, j = 0 corresponds to the largest delay). The deinterleaver
synchronization can be carried out by routing the first recognized sync byte in
the “0” branch.

B8 203 interleaved bytes 203 interleaved bytes47

Figure 3–59: The Interleaved transport packets

The inner coding is based on a Viterbi punctured convolutional code. See
Figure 3–60.

Data outputData input 1 2 3 5 6 74

1

2

Figure 3–60: Viterbi 1/2 Punctured coding

Each bit of the input stream (MBS first) loads in a 7 (K = 7, constant length) bit
shift register. It then executes two polynomial operations. To produce a p/q code
(q output bits for p input bits) a “puncture’ is applied to the output of the 1/2
coder.

For instance, in 7/8 mode, 7 bits produce 14 bits of 1/2 code and only 8 are
transmitted. (The puncture pattern for 7/8 is 11010101100110.)

Viterbi Coding
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Appendix A: Specifications

Specification. A document or a section of a document that lists and describes
characteristics and performance requirements of equipment and certain program-
ming material.

Characteristic. A property of the product.

Performance Requirement. A statement that defines a characteristic usually in
limit form. This statement is considered to be binding on the company (seller),
and can be verified by performing the appropriate portion of the Performance
Verification Procedure, or by a separate and available procedure.

Supplemental information. Statements that explain performance requirements or
provide performance information. These are not considered to be statements of
guaranteed performance and are not ordinarily supported by a performance
check.

Performance Conditions
The Performance requirements are valid within the environmental limits if the
instrument is adjusted at 25� C ±5� C, and a minimum warm-up time of
20 minutes is allowed.
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Hardware Electrical Specifications
The following tables give the specifications for the MTS 210 specific I/O ports.

Table A–1: G.703 — 8.448 MHz 

Characteristics Performance requirements Supplemental information
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ITU-CCITT G.703, G.823
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Line Encoding ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HDB3
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Serial Bit Rate ÁÁÁÁÁÁÁÁÁÁÁÁ
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8.448 Mbytes/s ± 10 ppm ÁÁÁÁÁÁÁÁÁÁÁÁ
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Generation/Acquisition Test ÁÁÁÁÁÁÁÁÁÁÁÁ
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Tested with a 10 Mbyte file (within the
constraints of synchronization)
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Voltage Levels ÁÁÁÁÁÁÁÁÁÁÁÁ
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Standard level within 0 to 4 dB cable
attenuation at 1/2 clock

Standard Levels:
Mark from 2.033 V to 2.607 V
Space from –0.237 to +0.237 VoltsÁÁ
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Return Loss (75 �)
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12 dB – 211 kHz to 422 kHz

18 dB – 422 kHz to 8.448 MHz

14 dB – 8.448 to 12.672 MHz
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Male SMB
(shared with the 34.36 Mbit input)ÁÁ
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Jitter Tolerance
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177 ns peak-to-peak 20 Hz to 400 Hz

23.6 ns peak-to-peak 3 kHz to 400 kHz

Log prorated – 400 Hz to 3 kHz
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59 ns nominal
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Conforms to 8.448 MHz Pulse Mask, G.703
Figure 16 (see Figure A–1)
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Required Receiver Termination ÁÁÁÁÁÁÁÁÁÁÁÁ
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75 � nominal resistive
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15 ns peak-to-peak with a 20 Hz lower
cut-off and a 400 kHz upper cut-off filter

5 ns peak-to-peak with a 3 kHz lower cut-off
and a 400 kHz upper cut-off filter

Allows a cascade of ten different regenera-
tors before system limit is reached
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Table A–1: G.703 — 8.448 MHz (cont.)

Characteristics Supplemental informationPerformance requirements
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ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

12 dB – 211 kHz to 422 kHz

18 dB – 422 kHz to 8.448 MHz

14 dB – 8.448 to 12.672 MHz

2.370 V
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0 V

49 ns
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Figure A–1: Pulse specification for a G.703 8.448 MHz pulse
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Table A–2: G.703 — 34.368 MHz 

Characteristics Performance requirements Supplemental information
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Standards Conformance
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ITU-CCITT G.703, G.823
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Connector
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

SMB
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁLine Encoding

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁHDB3ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Generation/Acquisition Test
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Error free
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Tested with a 10 Mbyte file
(within the constraints of synchronization)

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Serial Bit Rate ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

34.368 Mbits/s ± 20 ppm ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
Input

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Voltage Levels
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Standard level within 0 to 4 dB cable
attenuation at 1/2 clock

Standard level:
Mark from 0.9 V to 1.1 V
Space from –0.1 V to +0.1 V

ÁÁ
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Return Loss (75 �) ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

12 dB 860 kHz to 1.72 MHz

18 dB 1.72 MHz to 34.368 MHz

14 dB 34.368 to 51.55 MHz
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Connector ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Male SMB 
(shared with the 8 Mbit input)

ÁÁ
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Jitter Tolerance ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

43.7 ns peak-to-peak – 100 Hz to 1 kHz

4.37 ns peak-to-peak – 10 kHz to 800 kHz

Log prorated – 1 kHz to 10 kHz

Output
ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁPulse Width

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ14.5 ns nominalÁÁ

ÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁPulse “Mark” Amplitude

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ1.0 V ± 0.1 V

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁNo-Pulse “Space” Voltage

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ0 ± 0.1 V

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Pulse Shape
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Conforms to 34.368 MHz Pulse Mask,
Figure 17/G.703 (see Figure A–2 )

ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Required Receiver Termination
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

75 � nominal resistive
ÁÁ
ÁÁ
ÁÁ
ÁÁ
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Jitter
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

10 ns peak-to-peak with a 100 Hz lower
cut-off and a 800 kHz upper cut-off filter

2.45 ns peak-to-peak with a 10 kHz lower
cut-off and a 800 kHz upper cut-off filter

Allows a cascade of ten different regenera-
tors before system limit is reached

ÁÁ
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Return Loss ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

12 dB – 860 kHz to 1.72 MHz

18 dB – 1.72 MHz to 34.368 MHz

14 dB – 34.368 MHz to 51.55 MHz
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Figure A–2: Pulse specification for G.703 34.368 MHz
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Table A–3: ECL parallel, serial, and control ports 

Characteristics Performance requirements Supplemental information
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Connector

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Parallel Data: D25 
(pinout is given in Table A–4 )

Serial Data: D25 
(pinout is given Table A–5)

Flow Control: D9 
(pinout is given in Table A–6)

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Generation/Acquisition Test

Master/Slave
Slave/Master (w/control)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

All error free ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Tested with a 10 Mbyte file at maximum
data rates (within the constraints of
synchronization)

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Digital Format ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Binary, positive logic
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Input ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Maximum Data Rate ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Serial: 55 Mbits/s

Parallel: 7.5 Mbytes/s

Minimum Data Rate Clock Rate: 1 MHz

Serial: 1 Mbits/s
Parallel: 125 Kbytes/s

ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Signal Level Amplitude
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Differential ECL
Compliant with the ECL 100K levels

ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Time Reference ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Rising edge of the clock
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Output ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Maximum Data Rate ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Serial: 55 Mbits/s

Parallel: 7.5 Mbytes/sÁÁ
ÁÁ
ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Minimum Data Rate
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Clock rate: 1 MHz

Serial: 1 Mbits/s

Parallel: 125 Kbytes/s

Clock to Data Timing Data changes within 5 ns of falling clock
edge

ÁÁ
ÁÁ
ÁÁ

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Signal Level Amplitude ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Differential ECL
Compliant with the ECL 100K levels

ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

Required Receiver Termination ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

110 �, line-to-line
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Table A–4: ECL parallel data pinout 

ECL parallel port Pin Function Pin Function

1 DCLK 14 DCLK

1
4

2 Ground 15 Ground
2

5

14
3 DATA 7 16 DATA 7

4

3
16

15
4 DATA 6 17 DATA 6

5

4
17

6

5 DATA 5 18 DATA 55

6
9

18 6 DATA 4 19 DATA 4

7

6
19

7 DATA 3 20 DATA 3

9

8
21

20
8 DATA 2 21 DATA 2

9
21

22 9 DATA 1 22 DATA 1
10

4

23 10 DATA 0 23 DATA 0

12

11

5

24 11 DVALID 24 DVALID

13
25

12 PSYNC 25 PSYNC

13 Shield

Asserted Low differential signal.
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Table A–5: ECL serial data pinout 

ECL serial port Pin Function

1 DCLK

1
4

2 Ground
2

5

14
3 - 9 Not Managed

4

3
16

15
10 DATA 0

5

4
17

6

11 DVALID
5

6
9

18 12 PSYNC

7

6
19

13 Shield

9

8
21

20
14 DCLK

9
21

22 15 Ground
10

4

23 16 – 22 Not Managed

12

11

5

24 23 DATA 0

13
25

24 DVALID

25 PSYNC

Asserted Low differential signal.

data_clock

Data

data_valid

Active edge

D0

Figure A–3: Timing diagram for the ECL serial port
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Table A–6: ECL control port pinout 

ECL control port Pin Function

1 CHCLK (Channel Clock)

2 Ground

3 CHSYNC (Channel Sync)

2

1
6 4 CHCLKEN (Channel Clock Enable)

3

2
7

5 Shield

5

4
9

8
6 CHCLK (Channel Clock)

5
9

7 Ground

8 CHSYNC (Channel Sync)

9 CHCLKEN (Channel Clock Enable)

Asserted Low differential signal.

demand_clock
CHCLK

demand_clock_enable
CHCLKEN

Active edge

Data and stream

data_valid

data_clock
DCLK

Stuffing bytes

Figure A–4: ECL Timing diagram with control port
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Table A–7: 50  � TTL I/O 

Characteristics Performance requirements Supplemental information
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Connectors
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Male SMB
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Rise & Fall Times
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Between 2 ns and 6.5 ns
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Signal swing into 50 �
(output)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Low < 0.3 V
High > 2.65 V

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
Digital Format ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Binary, positive logic
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Maximum Data Rate ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

45 Mbits/s

Minimum Data Rate 1 Mbit/s
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Generation/Acquisition Test
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Error free
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Tested with a 10 Mbyte file at maximum
data rates (within the constraints of the
stop/start bits)

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Termination
(input)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ50 � nominal resistiveÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Timing Diagram
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

DATA signal is stable on the leading edge of
the clock signal (see Figure A–5)

Clock to Data Timing Data changes within 5 ns of falling clock
edge

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Signal Level Amplitude 
(input)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

TTL Low < 0.8 V
High > 2.0 V

Clock

Data

Figure A–5: Timing for the TTL port and the separate clock input

Table A–8: 10 Mbit serial port (RS-422 levels I/O Port) 

Characteristics Performance requirements Supplemental information

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Connector ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

9-pin sub-miniature D–type connector (see
Table A–9)ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

10 Mbit Serial Voltage Levels
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Differential outputs measured single-ended

Output Low < 0.5 V
High > 2.5 V

Input Low < –0.5 V differential
High > 0.5 V differential

Common Mode Range ±5 Volts
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Table A–8: 10 Mbit serial port (RS-422 levels I/O Port) (cont.)

Characteristics Supplemental informationPerformance requirements
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

10 Mbit Serial Rise and Fall Times
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Between 2 ns and 12 ns
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁMaximum Data Rate

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ10 Mbit/s

Minimum Data Rate 1 Mbit/s

Clock to Data Timing Data changes within 10 ns of falling clock
edge

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Generation/Acquisition Test
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Error free
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Tested with a 10 Mbyte file at maximum
data rates (within the constraints of the
stop/start bits)

Table A–9: 10 Mbit serial port pinout 

10 Mbit serial port Pin Function

1 DATA IN

2 CLK IN

3 DATA OUT

2

1
6 4 CLK OUT

3

2
7

5 Ground

5

4
9

8
6 DATA IN

5
9

7 CLK IN

8 DATA OUT

9 CLK OUT

Asserted Low differential signal.

Clock

Data

Figure A–6: Timing diagram for the 10 Mbit Serial port
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Table A–10: Clock Port 

Characteristics Performance requirements Supplemental information
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Clock Port Voltage Levels
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

TTL
Low < 0.8 V
High > 2.0 V

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Termination ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

50 �, nominally resistive

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Range ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

125 kHz to 45 MHz

Table A–11: PLL 

Characteristics Performance requirements Supplemental information

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Range ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

125 kHz to 60 MHz

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Resolution ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1 Hz

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Jitter ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

0.2 UI peak-to-peak over a 1000 UI delay ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
Settling Time ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

3 seconds after frequency change

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Frequency Accuracy ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

10 ppm � resolution
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Power Specifications

Table A–12: Power requirements 

Characteristics Performance requirements Supplemental information

Line Voltage 100 to 240 VAC

Line Frequency 60 Hz / 50 Hz

Rated Input Current 6 A to 3 A

Power Consumption (without monitor) 160 Watts nominal

Mechanical (Physical) Characteristics

Table A–13: MTS 210 mechanical characteristics 

Characteristics Supplemental information

Dimensions Base unit (does not include monitor, keyboard, pedestal, or mouse)

Height 17.92 inches (45.52 cm)

Width 8.83 inches (22.43 cm)

Depth 22.67 inches (57.58 cm)

Net Weight 65 lb (without accessories) (29.54 kg)

Shipping Weight 104 lb (47.17 kg) (with all accessories except monitor; monitor is shipped separately)

Environmental Characteristics

Table A–14: MTS 210 environmental characteristics 

Characteristics Supplemental information

Temperature

Non-operating (storage) –20° C (–4° F) to +60° C (140° F) (max. rate of change 20° C or 36° F per hour)

Operating +10° C (50° F) to +35° C (95° F) (max. rate of change 10° C or 18° F per hour)

Altitude

Non-operating 0 to 30,000 feet (9144 meters)

Operating 0 to 10,000 feet (3048 meters)

Humidity

Operating 20% to 80% (max. rate of change 10% per hour)

Non-operating 5% to 90% humidity, non-condensing
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Table A–15: Safety certification compliance 

Category Description
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Temperature (operating)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

+10° C (50°  F) to +35° C (95° F)

Altitude (maximum operating) 2000 Meters

Relative Humidity (maximum 
operating)

80% for temperatures up to 31° C (88° F), decreasing linearly to 50% to at 40° C (104° F)

Safety Class Class I – grounded product

Table A–16: Certifications and compliances 

Category Standard

EC Declaration of Conformity Meets intent of Directive 89/336/EEC for Electromagnetic Compatibility and Low Voltage
Directive 73/23/EEC for Product Safety.

Compliance was demonstrated to the following specifications as listed in the Official Journal of
the European Communities:

EN 50081-1 Emissions:
EN 55011 Class A Radiated and Conducted Emissions

EN 50082-1 Immunity:
IEC 801-2 Electrostatic Discharge Immunity
IEC 801-3 Radiated RF Electromagnetic Field Immunity
IEC 801-4 Electrical Fast Transient/Burst Immunity

Conditional Statements:
1) Using high quality shielded cables, including those supplied as standard accessories.

Low Voltage directive 73/23/EEC, amended by 93/68/EEC:
EN 60950 Safety of Information Technology Equipment, Including 

Electrical Business Equipment

Australia Declaration of Conformity Complies with electromagnetic compatibility standards as required under the
Radio Communications Act.

Compliance to:
AN/NZS 2064.1/2 Industrial, Scientific, and Medical Equipment: 1992
(demonstrated with compliance to EN55011 class A)
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Appendix B: What to Do if an Application Locks Up

As with all software, the MTS 210 applications occasionally lock up or freeze.
Follow the steps below to close a frozen application.

1. If you are in the Data Store Administrator application, first try a Board
Reset. (The Board Reset command is on the Service menu, see page 3–180.)

2. If that does not work, or you are in another application, try closing the
application using the Windows NT Security dialog box.

a. Press CTRL+ALT+DEL to open the Windows NT Security dialog box.

b. Click the Task List button to open the Task List dialog box.

c. Highlight the locked up application.

d. Choose the End Task command button. This should close the locked up
application. In some circumstances, another window opens to give you
the opportunity to wait, end the task, or cancel your “end task” instruc-
tion. Follow the window instructions; if you click End Task, the
application should close immediately.

e. If this does not close the application, press CTRL+ALT+DEL again to return
to the Windows NT Security dialog box.

f. Choose the Shutdown command button. This brings up the Shutdown
dialog box.

g. Choose the Shutdown and Restart option button and then choose OK.

3. If this does not end the application or shutdown the unit, power the MTS 210
server down (manual reset) until the hard disks stop spinning and then
proceed with a normal power on.

CAUTION. To avoid data loss, do not power off the MTS 210 server without first
exiting Windows NT. Use the manual reset method only if the entire MTS 210
server is not responsive.

Some low-level parameters in the Data Store boards are read only at power-on.
To be sure that all parameters are reset, a complete power-off cycle is recom-
mend if an application locks up.
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Appendix C: Software Repair

There are two parts to this appendix. The first part explains how to create and
use an Emergency Repair Disk. The second part tells you how to reload the test
system software onto your MTS 210 or MTS 215 if the installed copy becomes
corrupted.

Creating and Using an Emergency Repair Disk
An emergency repair disk, specific to the system, is supplied with each Tektronix
MPEG Test System. Whenever you upgrade the software or change your
password, it is strongly recommended that you also create a new emergency
repair disk. This will minimize the chances that you will need to completely
re-load the operating software for minor problem.

Use the emergency repair disk to restore your system to its initial setup state if
your system files become corrupt and you are unable to recover the previous start
up configuration (Last Known Good — the Windows NT startup screen option).
If you don’t have the emergency repair disk, you will have to reinstall Windows
NT. Please see the Windows NT System Guide, provided with your back-up
copy of Windows NT, for the procedure required to restore your system.

You may also need the emergency repair disk to restore user passwords if they
are forgotten. Be sure to update the emergency repair disk each time you add a
user or change a password.

CAUTION.  The files on the Emergency Repair Disk are MTS 210-specific; that is,
the disk shipped with an MTS 210 is the ONLY  one that will work with that unit.
Do not lose this disk. If you lose the Emergency Repair Disk provided with your
MTS 210, create a new one as described below.

To create an emergency repair disk, mark a High Density 3.5-inch disk clearly as
the emergency repair disk for MTS 210 (or MTS 215) serial number B0xxxxx
(be sure to write the serial number exactly as it appears on the rear panel) and
then perform the following steps.

Creating an
Emergency Repair Disk
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NOTE. The emergency repair disk is test-system-specific. Make sure that the
emergency repair disk is clearly marked with its serial number. The serial
number of your Tektronix MPEG Test System appears on the original emergency
repair disk and on the server rear panel, near the power input connector.

1. Choose Run from the Windows NT Start menu.

2. Type rdisk  in the Run dialog box. The Repair Disk Utility  dialog box, as
shown in Figure C–1, opens.

Figure C–1: The Repair Disk dialog box

3. Click Update Repair Info to save your current configuration. A message
appears to remind you that earlier repair information is overwritten. Click
Yes to continue.

4. When the process is complete, a message appears to ask if you wish to create
an Emergency Repair Disk. Click Yes. The message shown in Figure C–2
appears.

Figure C–2: All data on the disk will be erased

5. Insert a 3.5-inch disk in drive A and click OK . Rdisk formats the disk and
copies the configuration files onto it.

6. When the operation is complete, click Exit  in the Repair Disk Utility dialog
box. Remove the disk from drive A and keep it in a safe place.
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Always refer to the Windows NT documentation if you need more information.

1. Verify that you have a source of setup information available (the Win-
dows NT back up software package).

2. Insert the Windows NT Setup disk.

3. Restart the Test System.

4. When the Windows NT Setup Screen appears, press R (repair).

5. When prompted, insert the emergency repair disk.

6. The emergency repair disk performs the following:

� Runs CHKDSK.EXE on the WINNT and SYSTEM partitions.

� Verifies each file in the installation and replaces any that are missing or
corrupt.

� Replaces the System, Security, and Security Accounts Manager hives in
the registry.

� Reinstalls the Boot Loader (the boot sector, BOOT.INI, etc.).

Reinstalling the MTS 210 Software
Use the procedures below to reinstall your Test System software if it is accident-
ly deleted or becomes corrupted. Software has been supplied on CD ROM.

NOTE. The following instructions are for reinstalling MPEG Test System
software on a machine running Windows NT Workstation 4.0 only; procedures
for upgrading the software may be different. If you are installing a software
upgrade, follow the instructions provided with the upgrade kit.

Reinstalling the software involves four procedures:

� Uninstalling the software

� Copying the program files

If you are reinstalling because the MTS 210 software has become corrupted, you
should uninstall the software using unInstallShield, available through the
Tektronix MPEG Test System submenu.

Using the Emergency
Repair Disk

Uninstalling the Software
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1. Restart Windows NT.

2. Log in to Windows NT as administrator (Username = administrator;
password = MPEG2). You must log in as administrator in order to install the
MTS 210 applications.

3. Quit any applications that automatically started at login.

4. Select unInstallShield (see Figure C–3).

Figure C–3: Uninstall the software

5. When the dialog box asks you to confirm the file deletion, click Yes.

6. A window appears to show the progress of the uninstall process. When
uninstall is successfully completed, click OK  to continue.

7. Close the Tektronix MPEG Test System window; then start Windows NT
Explorer (through the Programs submenu of the Windows NT Start menu).

8. Drag the C:\Mts100 folder to the Recycle Bin.

9. Open the C:\Winnt\Profiles\All Users\Start Menu\Programs folder; then drag
the Tektronix MPEG Test System folder from the Start Menu folder to the
Recycle Bin.

10. Close the Windows NT Explorer window.

1. If you are continuing from the uninstall procedure, go directly to step 4; If
you did not uninstall the software, restart Windows NT now.

2. Log in to Windows NT as administrator (Username = administrator;
password = MPEG2). You must log in as administrator in order to install the
MTS 210 applications.

3. Quit any applications that automatically started at login.

Copying the Program Files
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4. Verify that the system disk on the MTS 210 workstation has at least 100 MB
of free space. The program will not install if the system disk has less than
100 MB of free space.

5. Place the MTS 210 Installation Software CD ROM into the CD ROM drive.
The CD ROM part number depends on the option, as listed in the following
table.

MTS option CD ROM part number

MTS 210 option 1A 063-2945-00

MTS 210 option 1G 063-2946-00

MTS 210 option AG and MTS 215 063-2947-00

6. The setup application starts automatically in a few seconds and displays the
dialog box shown in Figure C–4.

Figure C–4: The MTS 210 software installation dialog box

7. Read the text in the dialog box and then click Next to proceed to the Choose
Destination Directory dialog box shown in Figure C–5.
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Figure C–5: Specifying the destination directory

8. The default directory is C:\Mts100\. To accept the default directory, click
Next.

NOTE. It is strongly recommended that you use the default directory name.

9. Click Next to accept the default folder name (Tektronix MPEG Test System)
and continue. The Select Components window opens.

Figure C–6: Select RTA BOARD only for the MTS 215
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10. If you are installing software in an MTS 215, select both options; otherwise,
select only CARB Board. Then click Next; a second Select Components
window opens.

Figure C–7: Select the Data Store board configuration

11. Click Next to accept Layout 4. The Select Program Folder window
appears.

Figure C–8: The Select Program Folder dialog box

12. Click Next to accept the default folder name (Tektronix MPEG Test System)
and continue. The Select Components window opens.
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Figure C–9: Specify the Data Store slot

13. You must specify the slot in which the Data Store board is installed. For the
Proliant server, select Slot 2 - Proliant 2500 platforms and then click Next.

NOTE. You will be unable to use the Data Store Administrator application if you
do not specify the correct slot.

14. If you selected RTA BOARD in step 10, the Select Components window
opens again so you can specify the RTA board location. For the Proliant
server, select Slot 4 – Proliant 2500 platforms and then click Next.

Figure C–10: Specify the RTA slot (MTS 215 only)

NOTE. You will be unable to use the Real-Time Analyzer application if you do
not specify the correct slot.
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The setup program begins installing the MTS 210 software. The activity and
progress gauges shown in Figure C–11 appear to show that the installation
process is progressing. Installation proceeds without your input (and sometimes
with no apparent activity) for approximately 21⁄2 minutes.

Figure C–11: The progress dialog box and activity gauges

15. As the progress gauge nears 100%, an information dialog box, shown in
Figure C–12, reminds you to verify that the HASP is installed. Be sure that
the HASP is installed as described on page 1–11 of this manual; then click
OK  to continue.

Figure C–12: Check HASP installation

16. A dialog box appears when device driver installation is complete; click OK
to continue. The installation program finishes copying information to the
computer and then opens the Restart Windows NT dialog box.
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Figure C–13: The Restart Windows NT dialog box

17. Click OK  to restart the system.

Your reinstallation of the Version 2.2 software is complete.

Tektronix MPEG Test System Files
A list of the files that are installed for the Tektronix MPEG Test System, option
AG, begins on this page; the list of files installed for the MTS 210, option 1A,
begins on page C–13; and the list of files for the MTS 210, option 1G, begins on
page C–16.

MTS 210, Option AG
Files 

MTS100/README.TXT

MTS100/AUDIO/10KHZ.MP2

MTS100/AUDIO/15KZ_064.MP2

MTS100/AUDIO/15KZ_128.MP2

MTS100/AUDIO/15KZ_192.MP2

MTS100/AUDIO/15KZ_256.MP2

MTS100/AUDIO/1KHZ.MP2

MTS100/BIN/!CAR2500.CFG

MTS100/BIN/!PIA2500.CFG

MTS100/BIN/ADN_CARB.EXE

MTS100/BIN/ADONUM.CNT

MTS100/BIN/ADONUM.HLP

MTS100/BIN/BC453RTL.DLL
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MTS 210, Option AG
Files (Cont.)

MTS100/BIN/BDS501F.DLL

MTS100/BIN/BIDS47F.DLL

MTS100/BIN/BIDS50F.DLL

MTS100/BIN/BYTEFLIP.EXE

MTS100/BIN/CANAL.CNT

MTS100/BIN/CANAL.EXE

MTS100/BIN/CANAL.HLP

MTS100/BIN/CARBFILE.DLL

MTS100/BIN/CW3215.DLL

MTS100/BIN/CW3220.DLL

MTS100/BIN/D2HTLS32.DLL

MTS100/BIN/DOC2HELP.INI

MTS100/BIN/DYNAMIC.AVI

MTS100/BIN/EDITABLE.CNT

MTS100/BIN/EDITABLE.EXE

MTS100/BIN/EDITABLE.HLP

MTS100/BIN/EINJWIN.CNT

MTS100/BIN/EINJWIN.EXE

MTS100/BIN/EINJWIN.HLP

MTS100/BIN/GIGUE.CNT

MTS100/BIN/GIGUE.EXE

MTS100/BIN/GIGUE.HLP

MTS100/BIN/MATRACOM.EXE

MTS100/BIN/MFC30.DLL

MTS100/BIN/MFC30D.DLL

MTS100/BIN/MFC42.DLL

MTS100/BIN/MPEG2NT.HLP

MTS100/BIN/MSVCRT20.DLL

MTS100/BIN/MUX_CARB.EXE

MTS100/BIN/MUX_MPG2.CNT

MTS100/BIN/MUX_MPG2.HLP

MTS100/BIN/OWL253F.DLL

MTS100/BIN/OWL50F.DLL

MTS100/BIN/RTAMSG.DLL

MTS100/BIN/Rta.cnt
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MTS 210, Option AG
Files (Cont.)

MTS100/BIN/Rta.hlp

MTS100/BIN/SETCARB.EXE

MTS100/BIN/SYNT207.DLL

MTS100/BIN/SyntaxV.dll

MTS100/BIN/rta.exe

MTS100/CFG–TRP/!!CFG.NDX

MTS100/CFG–TRP/DEFAULT.BAT

MTS100/CFG–TRP/DEFAULT.CFG

MTS100/CFG–TRP/DEFAULT.EIT

MTS100/CFG–TRP/DEFAULT.NIT

MTS100/CFG–TRP/DEFAULT.PMT

MTS100/CFG–TRP/DEFAULT.SDT

MTS100/CFG–TRP/DEFAULT.TRP

MTS100/CFG–TRP/SAMPLE.TRP

MTS100/SERVICE/Flash.exe

MTS100/SERVICE/Flex1310.hex

MTS100/SERVICE/PiAdmin.exe

MTS100/SERVICE/Pia0.cfg

MTS100/SERVICE/README.TXT

MTS100/SERVICE/new_eisa/rtad2810.hex

MTS100/SERVICE/old_eisa/rtad2708.hex

MTS100/VIDEO/525/MOBL_015.MP2

MTS100/VIDEO/525/MOBL_060.MP2

MTS100/VIDEO/525/TESTPAT/100B_015.MP2

MTS100/VIDEO/525/TESTPAT/100B_060.MP2

MTS100/VIDEO/625/BARS_015.MP2

MTS100/VIDEO/625/BARS_060.MP2

MTS100/VIDEO/625/DEMO_015.MP2

MTS100/VIDEO/625/DEMO_060.MP2

MTS100/VIDEO/625/MOBL_015.MP2

MTS100/VIDEO/625/MOBL_060.MP2
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MTS 210, Option AG
Files (Cont.)

MTS100/VIDEO/625/TESTPAT/100B_015.MP2

MTS100/VIDEO/625/TESTPAT/100B_060.MP2

TEMP/LOOP32.VER

TEMP/MFC30D.DLL

TEMP/MSVCRT20.DLL

TEMP/PKUNZIP.EXE

TEMP/PKZIP.EXE

TEMP/RPCNS4.DLL

TEMP/RPCRT4.DLL

TEMP/RPCSERV.EXE

TEMP/RPCSUPER.DLL

WINNT/MUX.INI

MTS 210, Option 1A
Files 

MTS100/README.TXT

MTS100/AUDIO/10KHZ.MP2

MTS100/AUDIO/15KZ_064.MP2

MTS100/AUDIO/15KZ_128.MP2

MTS100/AUDIO/15KZ_192.MP2

MTS100/AUDIO/15KZ_256.MP2

MTS100/AUDIO/1KHZ.MP2

MTS100/BIN/!CAR2500.CFG

MTS100/BIN/ADN_CARB.EXE

MTS100/BIN/ADONUM.CNT

MTS100/BIN/ADONUM.HLP

MTS100/BIN/BC453RTL.DLL

MTS100/BIN/BDS501F.DLL

MTS100/BIN/BIDS47F.DLL

MTS100/BIN/BIDS50F.DLL
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MTS 210, Option 1A
Files (Cont.)

MTS100/BIN/BYTEFLIP.EXE

MTS100/BIN/CANAL.CNT

MTS100/BIN/CANAL.EXE

MTS100/BIN/CANAL.HLP

MTS100/BIN/CARBFILE.DLL

MTS100/BIN/CW3215.DLL

MTS100/BIN/CW3220.DLL

MTS100/BIN/D2HTLS32.DLL

MTS100/BIN/DYNAMIC.AVI

MTS100/BIN/EDITABLE.CNT

MTS100/BIN/EDITABLE.EXE

MTS100/BIN/EDITABLE.HLP

MTS100/BIN/EINJWIN.CNT

MTS100/BIN/EINJWIN.EXE

MTS100/BIN/EINJWIN.HLP

MTS100/BIN/GIGUE.CNT

MTS100/BIN/GIGUE.EXE

MTS100/BIN/GIGUE.HLP

MTS100/BIN/MATRACOM.EXE

MTS100/BIN/MFC30.DLL

MTS100/BIN/MFC30D.DLL

MTS100/BIN/MFC42.DLL

MTS100/BIN/MPEG2NT.HLP

MTS100/BIN/MSVCRT20.DLL

MTS100/BIN/OWL253F.DLL

MTS100/BIN/OWL50F.DLL

MTS100/BIN/SETCARB.EXE

MTS100/BIN/SYNT207.DLL

MTS100/CFG–TRP/!!CFG.NDX

MTS100/CFG–TRP/DEFAULT.BAT

MTS100/CFG–TRP/DEFAULT.CFG

MTS100/CFG–TRP/DEFAULT.EIT

MTS100/CFG–TRP/DEFAULT.NIT
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MTS 210, Option 1A
Files (Cont.)

MTS100/CFG–TRP/DEFAULT.PMT

MTS100/CFG–TRP/DEFAULT.SDT

MTS100/CFG–TRP/DEFAULT.TRP

MTS100/CFG–TRP/SAMPLE.TRP

MTS100/VIDEO/525/MOBL_015.MP2

MTS100/VIDEO/525/MOBL_060.MP2

MTS100/VIDEO/525/TESTPAT/100B_015.MP2

MTS100/VIDEO/525/TESTPAT/100B_060.MP2

MTS100/VIDEO/625/BARS_015.MP2

MTS100/VIDEO/625/BARS_060.MP2

MTS100/VIDEO/625/DEMO_015.MP2

MTS100/VIDEO/625/DEMO_060.MP2

MTS100/VIDEO/625/MOBL_015.MP2

MTS100/VIDEO/625/MOBL_060.MP2

MTS100/VIDEO/625/TESTPAT/100B_015.MP2

MTS100/VIDEO/625/TESTPAT/100B_060.MP2

TEMP/LOOP32.VER

TEMP/MFC30D.DLL

TEMP/MSVCRT20.DLL

TEMP/PKUNZIP.EXE

TEMP/PKZIP.EXE

TEMP/RPCNS4.DLL

TEMP/RPCRT4.DLL

TEMP/RPCSERV.EXE

TEMP/RPCSUPER.DLL

WINNT/SYSTEM32/CTL3D.DLL

WINNT/SYSTEM32/CTL3DV2.DLL

WINNT/SYSTEM32/DRIVERS/DRVCARB.SYS

WINNT/SYSTEM32/MUX.INI

WINNT/SYSTEM32/RHMMPLAY.DLL
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MTS 210, Option 1G
Files 

MTS100/README.TXT

MTS100/AUDIO/10KHZ.MP2

MTS100/AUDIO/15KZ_064.MP2

MTS100/AUDIO/15KZ_128.MP2

MTS100/AUDIO/15KZ_192.MP2

MTS100/AUDIO/15KZ_256.MP2

MTS100/AUDIO/1KHZ.MP2

MTS100/BIN/!CAR2500.CFG

MTS100/BIN/BC453RTL.DLL

MTS100/BIN/BDS501F.DLL

MTS100/BIN/BIDS47F.DLL

MTS100/BIN/BIDS50F.DLL

MTS100/BIN/BYTEFLIP.EXE

MTS100/BIN/CANAL.CNT

MTS100/BIN/CANAL.EXE

MTS100/BIN/CANAL.HLP

MTS100/BIN/CARBFILE.DLL

MTS100/BIN/CW3215.DLL

MTS100/BIN/CW3220.DLL

MTS100/BIN/D2HTLS32.DLL

MTS100/BIN/DYNAMIC.AVI

MTS100/BIN/EDITABLE.CNT

MTS100/BIN/EDITABLE.EXE

MTS100/BIN/EDITABLE.HLP

MTS100/BIN/EINJWIN.CNT

MTS100/BIN/EINJWIN.EXE

MTS100/BIN/EINJWIN.HLP

MTS100/BIN/GIGUE.CNT

MTS100/BIN/GIGUE.EXE

MTS100/BIN/GIGUE.HLP

MTS100/BIN/MATRACOM.EXE

MTS100/BIN/MFC30.DLL
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MTS 210, Option 1G
Files (Cont.)

MTS100/BIN/MFC30D.DLL

MTS100/BIN/MFC42.DLL

MTS100/BIN/MPEG2NT.HLP

MTS100/BIN/MSVCRT20.DLL

MTS100/BIN/MUX_CARB.EXE

MTS100/BIN/MUX_MPG2.CNT

MTS100/BIN/MUX_MPG2.HLP

MTS100/BIN/OWL253F.DLL

MTS100/BIN/OWL50F.DLL

MTS100/BIN/SETCARB.EXE

MTS100/BIN/SYNT207.DLL

MTS100/CFG–TRP/!!CFG.NDX

MTS100/CFG–TRP/DEFAULT.BAT

MTS100/CFG–TRP/DEFAULT.CFG

MTS100/CFG–TRP/DEFAULT.EIT

MTS100/CFG–TRP/DEFAULT.NIT

MTS100/CFG–TRP/DEFAULT.PMT

MTS100/CFG–TRP/DEFAULT.SDT

MTS100/CFG–TRP/DEFAULT.TRP

MTS100/CFG–TRP/SAMPLE.TRP

MTS100/VIDEO/525/MOBL_015.MP2

MTS100/VIDEO/525/MOBL_060.MP2

MTS100/VIDEO/525/TESTPAT/100B_015.MP2

MTS100/VIDEO/525/TESTPAT/100B_060.MP2

MTS100/VIDEO/625/BARS_015.MP2

MTS100/VIDEO/625/BARS_060.MP2

MTS100/VIDEO/625/DEMO_015.MP2

MTS100/VIDEO/625/DEMO_060.MP2

MTS100/VIDEO/625/MOBL_015.MP2

MTS100/VIDEO/625/MOBL_060.MP2

MTS100/VIDEO/625/TESTPAT/100B_015.MP2

MTS100/VIDEO/625/TESTPAT/100B_060.MP2
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MTS 210, Option 1G
Files (Cont.)

TEMP/LOOP32.VER

TEMP/MFC30D.DLL

TEMP/MSVCRT20.DLL

TEMP/PKUNZIP.EXE

TEMP/PKZIP.EXE

TEMP/RPCNS4.DLL

TEMP/RPCRT4.DLL

TEMP/RPCSERV.EXE

TEMP/RPCSUPER.DLL

WINNT/MUX.INI

WINNT/SYSTEM32/CTL3D.DLL

WINNT/SYSTEM32/CTL3DV2.DLL

WINNT/SYSTEM32/DRIVERS/DRVCARB.SYS

WINNT/SYSTEM32/RHMMPLAY.DLL
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Appendix D: Analyzer Tests

This section describes the tests performed by the Analyzer application, version
1.0, on the bitstreams.

NOTE. This appendix does not include tests added to version 2.0 and later of the
Tektronix MPEG Test System software.

The tests shown in normal typeface can be found in the compliance document
(ISO/IEC 13818–4 DIS).

The tests shown in italics are not described in the compliance document, or are
described but are erroneous and/or incomplete.

All the fields are indicated, even those for which no tests are performed. The
fields are listed exactly in the same order as given in the Standard (ISO/IEC
13818–1 IS of 13 November 1994).

Compliance at the Transport Stream Level
There are two parts at this level: the Transport Packet Header and the Adaptation
Field.

Table D–1: Compliance for the Transport Packet Header 

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

sync_byte (sb): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (sb == 0x47)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

transport_error_indicator (tei): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (tei != 1)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

payload_unit_start_indicator (pusi): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (pid == 0x1FFF) 
then test that (pusi == ‘0’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

transport_priority (tp): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PID (pid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that pid is in [0x0000, 0x0001, 0x0010 .. 0x1FFF]
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. issue a warning if pid emulates 0x47
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ3. verify that there is at least one packet with pid == 0x0000 in the streamÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

transport_scrambling_control (tsc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (pid == 0x0000 or 0x0001 or 0x1FFF) 
then test that (tsc == ‘00’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (pid == PID_PMT) 
then test that (tsc == ‘00’)

NOTE: the PID_PMTs are given by the program_map_PID fields in the PAT
sections.
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Table D–1: Compliance for the Transport Packet Header (cont.)

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

adaptation_field_control (afc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (pid == 0x1FFF) 
then test that (afc == ‘01’)
else test that (afc != ‘00’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

continuity_counter (cc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (afc in == ‘x1’) 
and ((AF.di == ‘0’) or (afc == ‘0x’))
and (pid != 0x1FFF) 
and packet is not a duplicate
then test that (cc == previous_cc + 1, modulo 16)

NOTE: previous_cc means value of the continuity_counter of the previous TS
packet with the same PID.ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

data_byte (db):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (pusi == ‘1’) 
and (pid == PID_PES) 
and (tsc == ‘00’) or stream has been unscrambled
t e test t t st rts it ollo e y t e correct siÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

then test that db starts with 0x000001 followed by the correct sid

2. if (pusi == ‘0’) 
and (pid == PID_PES) 

tsc or stre m s ee scr m leÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

and (tsc == ‘00’) or stream has been unscrambled
then test that db does not contain 0x000001 followed by the correct sid

3. if (pusi == ‘1’) 
i PI PSIÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

and (pid == PID_PSI)
and (tsc == ‘00’) or stream has been unscrambled
then test that db starts with pointer field to the correct table_id

4 i c et is ot lic teÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

4. if packet is not a duplicate
and (previous_AFH.sc == 0)
and (tsc == ‘00’) or stream has been unscrambled
then test that db starts with 0x000001 followed by the correct sid

NOTE:

1. PID_PES are given by the elementary_PID fields given in the PMT sections.

2. PID_PSI are 0x0000 for PAT, 0x0001 for CAT, the PIDs given by the
program_map_PID fields in the PAT sections, PID given by the network_PID
field in the PAT sections.

3. correct table_id are 0x00 for PAT, 0x01 for CAT, 0x02 for PMT and [0x40 ..
0xFE] for NIT.

4. correct sid means ‘1110 xxxx’ for video and ‘110x xxxx’ for audio.

5. previous_AFH.sc means the value of the splice_countdown field of the
previous TS packet with the same PID (duplicate packets and packets with
no payload excluded).
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The following test should be used to determine whether a packet is a duplicate
packet:

if  (afc == ‘x1’) 
and (AF.di == ‘0’) or not present
and (pid != 0x1FFF)
and (cc == previous_cc)
then packet is a duplicate

For a duplicate packet, the you should test that the previous packet with same
PID is not itself a duplicate packet.

Table D–2: Compliance for the Adaptation Field (AF) 

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

adaptation_field_length (afl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (TPH.afc == ‘10’)
then test that (afl == 183)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (TPH.afc == ‘11’)
then test that afl is in [0 .. 182]

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

discontinuity_indicator (di): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

random_access_indicator (rai): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

elementary_stream_priority_indicator (espi): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PCR_flag (pcrf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (opcrf == ‘1’) 
then test that (pcrf == ‘1’)

i r iÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (rai == ‘1’) 
and (TPH.pid == PID_PCR) 
then test that (pcrf == ‘1’)

NOTE: the PID_PCR are the PIDs given by the PCR_PID fields in the PMT
sections.ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁOPCR_flag (opcrf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

splicing_point_flag (spf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if packet is not duplicate
and (TPH.afc == ‘11’)
and (previous_spf == 1)
and (previous_sc != 0)
then test that (spf == 1)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁtransport_private_data_flag (tpdf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

adaptation_field_extension_flag (afef):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if packet is not duplicate
and (TPH.afc == ‘11’)
and (previous_afef == 1)
and (previous_sc != 0)
then test that (afef == 1)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁprogram_clock_reference_base (pcrb):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r1):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r1 == ‘111111’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_clock_reference_extension (pcre): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

Special Tests in the Case
of a Duplicate Packet
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Table D–2: Compliance for the Adaptation Field (AF) (cont.)

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

original_program_clock_reference_base (opcrb):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r2):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r2 == ‘111111’)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

original_program_clock_reference_extension
(opcre):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

splice_countdown (sc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (packet is not duplicate) 
and (TPH.afc == ‘11’)
then test that (sc == previous_sc – 1)

NOTE: previous_sc is the value of sc in the previous packet of the same PID
(duplicate packets and packets with no payload excluded).ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

transport_private_data_length (tpdl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that (tpdl > 0)

2. test that (tpdl < afl – compute_length())

com te le t is t e ollo i ctioÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

compute_length is the following function:
int compute_length()
{

int length = 1
if (pcrf == ‘1’) then length += 6

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

i cr t e le t 6
if (opcrf == ‘1’) then length += 6
if (spf == ‘1’) then length++
if (afef == ‘1’) then length += afel

}

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

private_data_byte (pdb): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

adaptation_field_extension_length (afel): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (afel > 0)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ltw_flag (lf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

piecewise_rate_flag (prf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

seamless_splice_flag (ssf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if packet is not duplicate
and (TPH.afc == ‘11’)
and (previous_ssf == 1)
and (previous_sc != 0)
then test that (ssf == 1)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r3): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r3 == ‘11111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ltw_valid_flag (lvf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ltw_offset (lo): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r4):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r4 == ‘11111111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

piecewise_rate (pr):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
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Table D–2: Compliance for the Adaptation Field (AF) (cont.)

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

splice_type (st):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (packet carries audio stream) then test that (st == ‘0000’)

i c et c rries vi eo stre m t e test t t st is ot i [ ]ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (packet carries video stream) then test that st is not in [‘0100’ .. ‘1011’]

3. if (not first occurrence of st) 
revio s scÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

i ot irst occ rre ce o st
and (previous_sc != 0)
then test that (st == previous_st)

NOTE:

1. for a definition of previous_sc, see note 1 of sc.

2. previous_st means the value of st in the previous packet with the same PID
(duplicate packets or packets without payload excluded).

3. the information about the type of stream (audio or video) can be found in the
stream_type fields of the PMT sections.ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

DTS_next_au (dtsna):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (not first occurrence of dtsna) 
and (previous_sc != 0)
then test that (dtsna == previous_dtsna)

NOTE:

1. for a definition of previous_sc, see note 1 of sc.

2. previous_dtsna means the value of dtsna in the previous packet with the
same PID (duplicate packets or packets without payload excluded).

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

marker_bit (mb): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (mb == ‘1’) for all mb in the packet
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r5):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r5 == ‘1111 1111’) for all bytes
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

stuffing_byte (sb):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (sb == ‘1111 1111’) for all bytes
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Compliance at the PES Packet Level
The following tests should be performed only if the transport_scrambling_con-
trol field of the transport packets is equal to ‘00’ or the PES stream has been
unscrambled.

Table D–3: Compliance for the PES packet header 

Parameter Error checkingÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁpacket_start_code_prefix (pscp):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (pscp == 0x000001)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

stream_id (sid):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. sid != a reserved value

si CÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. sid >= 0xBC

3. test that each PES packet carried in the TS packets of the same PID value
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

3. test that each PES packet carried in the TS packets of the same PID value
have the same sid

4 i c et c rries ioÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

4. if (packet carries audio) 
then test that sid is in [0xC0 .. 0xDF]

5 i c et c rries vi eoÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

5. if (packet carries video) 
then test that sid is in [0xE0 .. 0xEF]

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_packet_length (pespl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if sid indicates that packet does not carry video
then test that (pespl != 0)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ‘10’:
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that these two bits are really equal to ‘10’ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁPES_scrambling_control (pessc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_priority (pesp):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

data_alignment_indicator (dai): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

copyright ( ): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

original_or_copy (ooc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PTS_DTS_flags (ptsdtsf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (ptsdtsf != ‘01’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ESCR_flag (escrf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ES_rate_flag (esrf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

DSM_trick_mode_flag (dsmtmf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

additional_copy_info_flag (acif): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_CRC_flag (pescrcf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_extension_flag (pesef):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_header_data_length (phdl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that phdl >= sum of optional data fields ( > for stuffing)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that phdl <= 32

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

‘0010’: ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that these four bits are really equal to ‘0010’

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

marker bit (mb): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (mb == 1) for all mb in the packet

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PTS (pts): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

‘0011’: ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that these four bits are really equal to ‘0011’



Appendix D: Analyzer Tests

Tektronix MPEG Test System User Manual D–7

Table D–3: Compliance for the PES packet header (cont.)

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

‘0001’:
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that these four bits are really equal to ‘0001’
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁDTS (dts):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r1):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r1 == ‘11’)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁESCR (escr):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁES_rate (esr):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (esr != 0)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

trick_mode_control (tmc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

field_id (fid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (fid != ‘11’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

intra_slice_refresh (isr): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

frequency_truncation (ft): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

rep_cntrl (rc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (rc != 0)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r2): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r2 == ‘111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r3): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r3 == ‘11111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

additional_copy_info (aci): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

previous_PES_packet_CRC (pppc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_private_data_flag (pespdf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

pack_header_field_flag (phfl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_packet_sequence_counter_flag (ppscf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁP–STD_buffer_flag (pstdbf):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r4):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r4 == ‘111’)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁPES_extension_flag_2 (pesef2):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁPES_private_data (ppd):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁshall not emulate the packet_start_code_prefix (0x000001)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

pack_field_length (pfl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (pfl < pespl)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_packet_sequence_counter (ppsc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

MPEG1_MPEG2_identifier (mpeg1mpeg2i): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

original_stuff_length (osl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (mpeg1mpeg2i == 1) 
then test that (osl <= 16)
else test that (osl <= 32)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

‘01’:
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that these two bits are really equal to ‘01’
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁP–STD_buffer_scale (pstdbscale):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁP–STD_buffer_size (pstdbsize):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁPES_extension_field_length (pesefl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (pesefl < pespl)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r5):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r5 == ‘1111 1111’) for all bytesÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

stuffing_byte (sb):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that (sb == 0xFF) for all bytes

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that the number of sb <= 32 in PES packet header
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Table D–3: Compliance for the PES packet header (cont.)

Parameter Error checking
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PES_packet_data_byte (pespdb):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁpadding_byte (pb):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (pb == 0xFF) for all bytes

Compliance at the PSI level
The PSI level contains the following sections: PAT, PMT, CAT, NIT, and Private
Sections.

Table D–4: Compliance for the PAT sections 

Parameter Error checkÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁtable_id (tid):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (tid == 0x00)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_syntax_indicator (ssi):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (ssi == ‘1’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

0 (zero): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (zero == ‘0’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res1): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res1 == ‘11’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_length (sl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that (9 <= sl <= 1021)

i sl
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (sl == n) 
then test that ((byte[n] == 0x00) or (byte[n] == 0xFF) or (byte[n] == 0x47))
and test that (byte[n–4] .. byte[n–1] == CRC32)

NOTE: we use a C-type array notation, so byte[n] means the (n+1)th byte found
after sl.ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁtransport_stream_id (tsid):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁverify that tsid is the same for all sections with the same vnÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (res2):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (res2 == ‘11’)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁversion_number (vn):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

current_next_indicator (cni):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_number (sn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

last_section_number (lsn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_number (pn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

does not take any single value more than once within all sections of a version

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res3): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res3 == ‘111’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

network_PID (npid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that npid is not in [0x000 .. 0x000F]
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that (npid != 0x1FFF)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

3. test that npid is not a pid already used for audio or video
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

4. test that npid is not a pid already used for data

NOTE: a npid can be the same as a pmpid.
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Table D–4: Compliance for the PAT sections (cont.)

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_map_PID (pmpid):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that pmpid is not in [0x000 .. 0x000F, 0x1FFF]
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that pmpid is not a pid already used for audio, video

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

3. test that npid is not a pid already used for data

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC32 (crc): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that the CRC value is correct

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that the byte following the CRC is 0x00, 0x47 or 0xFF

Table D–5: Compliance for the PMT sections 

Parameter Error check

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

table_id (tid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (tid == 0x02)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_syntax_indicator (ssi): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (ssi == ‘1’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

‘0’ (zero): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (zero == ‘0’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res1): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res1 == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_length (sl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that (9 <= sl <= 1021)

i slÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (sl == n) 
then test that ((byte[n] == 0x00) or (byte[n] == 0xFF) or (byte[n] == 0x47))
and test that (byte[n–4] .. byte[n–1] == CRC32)

NOTE: we use a C-type array notation, so byte[n] means the (n+1)th byte found
after sl.

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_number (pn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. pn should be the one defined in PAT

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that (pn != 0)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res2): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res2 == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

version_number (vn):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (cni == 1) then test that all sections have the same vn
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ2. test that (v + 1) is the next version and has (cni == 1)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

current_next_indicator (cni):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_number (sn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (sn == 0)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

last_section_number (lsn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (sn == 0)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res3): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res3 == ‘111’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

PCR_PID (pcrpid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that pcrpid is not in [0x0002 .. 0x000F]

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res4): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res4 == ‘1111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

program_info_length (pil): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that (pil < 1024)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that (pil < (sl – 9))
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor:

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁsee descriptor test (beginning on page D–12)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁstream_type (st):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno test
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Table D–5: Compliance for the PMT sections (cont.)

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res5)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res5 == ‘111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁelementary_PID (epid):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that epid is not in [0x000 .. 0x000F, 0x1FFF]ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (res6):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (res6 == ‘1111’)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁES_info_length (esil):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (esil < 1024)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor:
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁsee descriptor test (beginning on page D–12)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC32 (crc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that the CRC value is correct

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that the byte following the CRC is 0x00, 0x47 or 0xFF

Table D–6: Compliance for the CAT section 

Parameter Error check

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

table_id (tid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (tid == 0x01)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_syntax_indicator (ssi): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (ssi == ‘1’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

0 (zero): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (zero == ‘0’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res1): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res1 == ‘11’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_length (sl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that (9 <= sl <= 1021)

i sl
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (sl == n) 
then test that ((byte[n] == 0x00) or (byte[n] == 0xFF) or (byte[n] == 0x47))
and test that (byte[n–4] .. byte[n–1] == CRC32)

NOTE: we use a C-type array notation, so byte[n] means the (n+1)th byte found
after sl.ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (res2):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (res2 == ‘1111 1111 1111 1111 11’)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

version_number (vn):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

current_next_indicator (cni): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_number (sn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

last_section_number (lsn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (cni == 1) then test that all sections have the same vn

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. test that (v + 1) is the next version and has (cni == 1)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor: ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

see descriptor test (beginning on page D–12)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC32 (crc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. test that the CRC value is correct
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ2. test that the byte following the CRC is 0x00, 0x47 or 0xFF
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Table D–7: Compliance for the NIT sections 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

table_id (tid):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that tid not in [0x00 .. 0x3F]
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_length (sl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

Table D–8: Compliance for the private sections 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

table_id (tid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that tid is in [0x00 .. 0x3F]
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_syntax_indicator (ssi): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

private _indicator (pi): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (res1):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (res1 == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

private_section_length (sl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁtable_id_extension (tide):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (res2):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (res2 == ‘11’)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁversion_number (vn):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁcurrent_next_indicator (cni):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

section_number (sn):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

last_section_number (lsn): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (cni == 1) then test that all sections have the same vn

2. test that (v + 1) is the next version and has (cni == 1)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC32 (crc) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that the CRC value is correct
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Compliance for the Descriptors
This section covers the compliance testing for the descriptors. This list of
descriptors tested includes: All (general), Video Stream, Audio Stream,
Hierarchy, Registration, Data Stream Alignment, Target Background Grid, Video
window, CA, ISO 636, System Clock, Multiplex Buffer, Utilitation, Copyright,
Maximum Bitrate, Private Data, Smoothing Buffer, STD, and IBP.

Table D–9: Compliance for all descriptors 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_tag (dt):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that dt not in [0, 1, 19 .. 63]
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if descriptor is in CAT section
then test that (sum of (dl + 1) == CAT.sl)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if descriptor is in PMT section after the program_info_length field
then test that (sum of (dl + 2) == PAT.pil)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

3. if descriptor is in PMT section after the ES_info_length field
then test that (sum of (dl + 2) == PAT.esil)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

CRC32 of the section ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that the CRC value is correct

The Video Stream Descriptor has descriptor_tag == 2. It tests that the descriptor
is at program and ES level and refers to video.

Table D–10: Video stream descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == mpeg1of * 2 + 1)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

multiple_frame_rate_flag (mfrf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

frame_rate_code (frc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no frame_rate_code in SH > frc
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

MPEG_1_only_flag (mpeg1of):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (mpeg1of == 1) 
then 

1. descriptor_length = 3
2. ES = MPEG2
3. stream_type = 0x02
4. stream_type : 0b1110 xxxx
5. constrained_parameter_flag = 0

else
1. descriptor_length = 1
2. ES = MPEG1
3. stream_type = 0x01
4. stream_type = 0b1110 xxxx
5. constrained_parameter_flag = constrained_parameter_flag in the SH

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

constrained_parameter_flag (cpf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

still_picture_flag (spf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
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Table D–10: Video stream descriptor (cont.)

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

profile_and_level_indication (pali):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

pali = profile_and_level_indication in the SHE
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁchroma_format (cf):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁcf = chroma_format in the SHEÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁframe_rate_extension_flag (fref):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁif (fref == 1) then frame_rate_extension_n != 0 and frame_rate_extension_d != 0ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r == ‘11111’)

The Audio Stream Descriptor is the descriptor with descriptor_tag == 3. It tests
that the descriptor is at program and ES level and refers to audio.

Table D–11: Audio stream descriptor 

Parameter Error checkÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor_length (dl):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (dl == 1)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

free_format_flag (fff):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

if (fff == 1) 
t e itr te r te i e i A

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

then bitrate_rate_index in AH = 0b0000
else bitrate_index in AH != 0b0000

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ID (id):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

id == ID in the AH
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

layer (l):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

l = Layer in the AH
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁvariable_rate_audio_indicator (vrai):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r == ‘111’)

Hierarchy Descriptor is the descriptor with descriptor_tag == 4. Only MPEG–2
streams may have this descriptor.

Table D–12: Hierarchy descriptor 

Parameter Error checkÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor_length (dl):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (dl == 4)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁreserved (r1):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (r1 == ‘1111’)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

hierarchy type (ht):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (ht == 1, 2, 3, or 4) then video and ht = profile_and_level in SHE

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (ht == 5) then audio

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r2): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r2 == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

hierarchy_layer_index (hli): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r3): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r3 == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

hierarchy_embedded_layer_index (heli): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r4): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r4 == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

hiearchy_channel (hc):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
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Registration Descriptor is the descriptor with descriptor_tag == 5.

Table D–13: Registration descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl >= 4)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

format_identifier (fid):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

additional_identification_info (aii):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

Data Stream Alignment Descriptor is the descriptor with descriptor_tag == 6. It
is only available for video and audio streams.

Table D–14: Data stream alignment descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor_length (dl):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (dl == 1)ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

alignment_type (at)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (at == 01, 02, 03 or 04) then
a. video
b. data_alignment_indicator in PES header = 1
c. test on the first PES_packet_data_byteÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

c test o t e irst P S c et t yte

2. if (at == 01) then
a. audio
b. data_alignment_indicator in PES header = 1
c t e irst P S c et t yte irst yte o io sy c or

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

c. the first PES_packet_data_byte = first byte of audio syncword

3. if (at == 01) then
a. video and audio
b. data_alignment_indicator = 0

Target Backgroound Grid Descriptor is the descriptor with descriptor_tag == 7. It
is only available for video streams.

Table D–15: Target background grid descriptor 

Parameter Error check

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl = 4)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

horizontal_size (hs): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

vertical_size (vs): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

aspect_ratio_information (ari) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
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Video Window Descriptor is the descriptor with descriptor_tag == 8. It is only
available for a video stream and the Target Background Grid Descriptor must
also be present.

Table D–16: Video window descriptor 

Parameter Error check

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 4)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

horizontal_offset (ho) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ho <= horizontal_size in the target background grid descriptor
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

vertical_offset (vo) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

vo <= vertical_size in the target background grid descriptor
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

window_priority (wp): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

CA Descriptor is the descriptor with descriptor_tag == 9. It is only available in
PMT or CAT.

Table D–17: CA descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl >= 4)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

CA_system_ID (casid): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (reserved == ‘111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

CA_PID (capid):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

capid != [0x0002, 0x000F] or 0x1FFF
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁprivate_data_byte (pdb):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno test

The ISO 639 Language Descriptor is the descriptor with descriptor_tag == 10.

Table D–18: ISO 639 language descriptor 

Parameter Error checkÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor_length (dl):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (dl % 4 == 0)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ISO_639_language_code (iso639lc)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

audio_type (at) ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

1. if (at == 0xAA) then video

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

2. if (at == 0xBB) or (at == 0xCC) then audio
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The System Clock Descriptor is the descriptor with descriptor_tag == 11. It is
only available at the program level in a PMT.

Table D–19: System clock descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 2)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁexternal_clock_reference_indicator (ecri):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno testÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r1):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r1 == ‘1’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

clock_accuracy_integer (cai): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

clock_accuracy_exponent (cae):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r2):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r2 == ‘11111’)

The Multiplex Buffer Utilization Descriptor is the descriptor with descrip-
tor_tag == 12.

Table D–20: Multiplex buffer utilization descriptor 

Parameter Error checkÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 3)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

bound_valid_flag (bvf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

LTW_offset_lower_bound (ltwolb): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r == ‘1’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

LTW_offset_upper_bound (ltwoub): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

The Copyright Descriptor is the descriptor with descriptor_tag == 13.

Table D–21: Copyright descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl >= 4)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

copyright_identifier (ci): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

additional_copyright_info (aci): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
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The Maximum Bitrate Descriptor is the descriptor with descriptor_tag == 14. It
is only available at the program or ES level.

Table D–22: Maximum bitrate descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 3)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r == ‘11’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

maximum_bitrate (mb): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

The Private Data Indicator Descriptor is identified by descriptor_tag == 15.

Table D–23: Private data indicator descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁdescriptor_length (dl):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁtest that (dl == 4)ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁprivate_data_indicator (pdi):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno test

The Smoothing Buffer Descriptor is the descriptor with descriptor_tag == 16.

Table D–24: Smoothing buffer descriptor 

Parameter Error checkÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 6)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r1): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r1 == ‘11’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

sb_leak_rate (sblr): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r2): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r2 == ‘11’)

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

sb_size (sbs): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test

The STD Descriptor is the descriptor with descriptor_tag == 17.

Table D–25: STD descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 1)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

reserved (r): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (r == ‘1111111’)
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

leak_valid_flag (lvf): ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
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The IBP Descriptor is the descriptor with descriptor_tag == 18.

Table D–26: IBP descriptor 

Parameter Error check
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

descriptor_length (dl):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

test that (dl == 2)
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

closed_gop_flag (cgf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no test
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

identical_gop_flag (igf):
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

no testÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁmax_gop_length (mgl):

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁno test
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Appendix E: Functional Check

The following procedure is used to check MTS 210 basic operation. Only
instrument functionality is checked, instrument specifications are not verified.
Performing this procedure requires only an oscilloscope, 50 � and 75 � BNC
terminators. In addition, the adapter cables shipped as standard accessories are
used to connect to the oscilloscope.

Required Equipment
The following equipment is required to perform this procedure:

� Oscilloscope: Capable of measuring 6 V amplitude and 1.4 ns rise time.

� 50 � SMB to BNC adapter cable (Tektronix part number 174-3578-xx)

� 75 � SMB to BNC adapter cable (Tektronix part number 174-3579-xx)

� 50 � feed-through terminator (Tektronix part number 011-0049-01)

� 75 � feed-through terminator (Tektronix part number 011-0103-02)

MTS rear panel

G.703 output
 (8.448 Mbits/s)

Test oscilloscope

75 � SMB-to-BNC
adapter cable

75 � feed-through
terminator

Ch 1 input

Figure E–1: Initial connections for the functional check
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Procedure
1. Connect the equipment as shown in Figure E–1.

2. Switch the Test System server power on.

3. Allow the Test System to go through the Windows NT initialization process.
No user intervention is required until initialization is complete.

4. When Windows NT initialization is finished, press CTRL + ALT + DELETE, as
instructed by the message box.

5. Type MTS100 for Username; do not enter a password. Click OK . If the
default Username or Password have been changed, use the current valid
Username and Password.

6. Once you have correctly logged in, double-click Data Store Administrator
icon in the Tektronix MPEG Test System program window.

Figure E–2: Starting the Data Store Administrator

7. Set up the Data Store Administrator as follows:

a. Click the G (Generate) toolbar button.

b. In the resulting GENERATION  dialog box, select any valid Data Store
file as the Source.

c. Select the Loop option.

d. In the Interface section of the dialog box, make the following
selections:
Protocol = Master. 
Port = G703
Output clock = 8.448 Mbits.

e. Click Start.
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8. Trigger the oscilloscope.

9. Check for a frequency of approximately 4.224 MHz, amplitude of approxi-
mately 5.7 volts and a rise time of approximately 1.4 ns. See Figure E–3 for
the location of the measurement points in the waveform.

10. Move the output cable to the G703, 34 M output. See Figure E–3.

MTS rear panel

G.703 output
 (34.368 Mbits/s)

Frequency

TR
10-90%

Amplitude

Test oscilloscope

75 � SMB-to-BNC
adapter cable

75 � feed-through
terminator

Ch 1 input

Figure E–3: Setup for measuring the G.703 34.368 Mbit/s output

11. Set up the Data Store Administrator as follows:

a. Click the Stop (red hand) toolbar button.

b. Click the G (Generate) toolbar button.

c. In the resulting GENERATION  dialog box, select any valid Data Store
file as the Source.

d. Select the Loop option.

e. In the Interface section of the dialog box, make the following
selections:
Protocol = Master. 
Port = G703
Output clock = 34.368 Mbits
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f. Click Start.

12. Trigger the oscilloscope.

13. Check for a frequency of approximately 17.2 MHz, peak-to-peak amplitude
of approximately 2.3 volts, and a rise time of approximately 3.8 ns. See
Figure E–3.

14. Remove the 75 � SMB-to-BNC adapter cable from the oscilloscope and the
MTS 210 G703 34 M Out connector.

15. Connect a 50 � SMB-to-BNC adapter cable from the TTL 50 � Clock I/O
Port, through a 50 � feed-through terminator, to the oscilloscope input. See
Figure E–4.

MTS rear panel

Clock I/O TTL
50 � serial port

Frequency

TR
10-90% Amplitude

Test oscilloscope

50 � SMB-to-BNC
adapter cable

50 � feed-through
terminator

Ch 1 input

Figure E–4: Setup for measuring the TTL 50 ohm clock I/O port

16. Set up the Test System as follows:

a. Click the Stop (red hand) toolbar button.

b. Click the G (Generate) toolbar button.

c. In the resulting GENERATION  dialog box, select any valid Data Store
file as the Source.

d. Select the Loop option.
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e. In the Interface section of the dialog box, make the following
selections:
Protocol = Master. 
Port = TTL
Output clock = PLL
Frequency = 1,000,000 Bits/s

f. Click Start.

17. Trigger the oscilloscope.

18. Check for a frequency of approximately 1 MHz, amplitude of approximately
3.0 volts and a rise time of approximately 2.0 ns. See Figure E–4.

19. Move the Test System output cable to the TTL 50 � Data I/O Port. See
Figure E–5.

MTS rear panel

Data rate

TR
10-90% Amplitude

Test oscilloscope

50 � SMB-to-BNC
adapter cable

50 � feed-through
terminator

Data I/O TTL
50 � serial port

Ch 1 input

Figure E–5: Setup for measuring the TTL 50 ohm data I/O port

20. Set up the Test System as follows:

a. Select Start.

b. Click the Stop (red hand) toolbar button.

c. Click the G (Generate) toolbar button.
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d. In the resulting GENERATION  dialog box, select any valid Data Store
file as the Source.

e. Select the Loop option.

f. In the Interface section of the dialog box, make the following
selections:
Protocol = Master. 
Port = TTL
Output clock = PLL
Frequency = 45,000,000 Bits/s

g. Click Start.

21. Trigger the oscilloscope on the plus slope.

22. Check for an amplitude of approximately 3.0 volts, a data rate of 45 MHz
and a rise time of approximately 2.0 ns. See Figure E–5.

23. Move the Test System output cable to the TTL 50 � Clock I/O Port. See
Figure E–4.

24. Trigger the oscilloscope.

25. Check for an amplitude of approximately 3.0 volts, frequency of 45 MHz
and a rise time of approximately 2.0 ns. See Figure E–4.

26. In the Data Store Administrator, click the Stop (red hand) toolbar button.

This completes the functional check.
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Appendix F: Repackaging

The Tektronix MPEG Test System is shipped in a carton designed to provide it
with the maximum protection. If the instrument is subsequently shipped you will
need to use this carton and the instrument support inserts to provide adequate
protection.

NOTE. The Test System shipping carton must be used to return the instrument to
Tektronix service centers. We cannot honor the warranties if it is not shipped in
its original carton or a purchased replacement carton.

New packaging material is available from Tektronix. The part numbers are in
Table F–1 and in the Replaceable Mechanical Parts List in the Service Manual.
Packaging components are shown in Figure F–1. Each component has an index
number which also appears in Table F–1. Contact your nearest Tektronix office
or representative to obtain new packaging parts.

Table F–1: Packaging material 

Item Tektronix part number Index number

Top cushion (Cardboard Insert) 004-4912-00 1

Instrument support inserts; top and
bottom

004-4913-00 2

Shipping box 004-4914-00 3

When the server is shipped, it is important to provide it with the maximum
protection. Figure F–1 shows how to repackage the server for shipment. As the
figure shows, it is not necessary to have the keyboard, mouse, server front door,
or server pedestal in the package for reshipment. However, the server pedestal
and front door must be removed from the server for reshipment to prevent
damage to the packaging or server parts.

NOTE. The software enabler key (HASP) is required by the Tektronix Service
Center if the Test System server is returned for repair.

Remove the server door first. Open the door all the way and lift up on the door to
disengage the hinge pins of the two hinges on the right side of the server door
from the hinge pin holes in the server chassis.

Obtaining Replacement
Packaging

Repackaging the Server
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Then remove the server pedestal as follows:

1. Carefully place the server on its top.

2. Locate the retaining clip that holds the pedestal on the server.

3. Use your thumb to release the retaining clip and slide the pedestal to
disengage the pedestal from the server.

1

2

3

Note: The keyboard, mouse, pedestal
and manual boxes do not need to be
returned with the MTS 210 for servicing.

2

Figure F–1: Repackaging the MTS 210 server

If the monitor is being shipped, it should be packaged in accordance with the
instructions contained in its documentation.

Repackaging the Monitor
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Glossary

NOTE. Additional information about MPEG-2 is available through the MPEG-2
Help application, part of the Tektronix MPEG Test System software.

BAT (Bouquet Association Table)
The BAT provides information regarding bouquets (collections of services
marketed as a single entity). DVB only.

CAT (Conditional Access Table)
The CAT provides the association between one or more CA systems, their
EMM (Entitlement Management Message) streams, and any special
parameters associated with them.

DTS (Decode Time Stamp) 
Time when the packet should be decoded.

DVB (Digital Video Broadcast)
A project group of the European Broadcasting Union (EBU).

DVB IRD (Digital Video Broadcasting Integrated Receiver Decoder)
A receiving decoder that can automatically configure itself using the MPEG2
Program Specific Information (PSI).

DVB-SI (Digital Video Broadcast Service Information)
The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. It has several tables, including: NIT,
SDT, BAT, and EIT. (NIT is also required for MPEG2.)

EIT (Event Information Table)
The EIT contains data concerning events (a grouping of elementary
broadcast data streams with a defined start and end time belonging to a
common service) and programs (a concatenation of one or more events under
the control of a broadcaster, such as event name, start time, duration, etc.).

EPG (Electronic Program Guide)
The EPG gives the content of the current program.

GA (Grand Alliance)
This group is establishing the North American HDTV standards.

LTW (Legal Time Window)

NIT (Network Information Table)
The NIT conveys information relating to the physical organization of the
multiplex — Transport streams carried via a given network, and the
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characteristics of the network itself. Transport streams are identified by the
combination of an original network ID and a transport stream ID in the NIT.

NVOD
Near Video on Demand

PAT (Program Association Table)

PCR (Program Reference Clock)
The “clock on the wall” time when the video is multiplexed.

PES
Packetized Elementary Stream

PID
Program ID

PMT (Program Map Table)
The PMT identifies and indicates the locations of the streams that make up
each service and the location of the Program Clock Reference (PCR) fields
for a service. This table is transmitted in sections.

PSI (Program Specific Information)
The PSI contains all the tables that define the MPEG2 transport stream. It
consists of the PAT, PMT, CAT, and NIT tables. (NIT is also used for
DVB-SI.)

PTS (Presentation Time Stamp)
When the packet should arrive and its destination.

SDT (Service Description Table)
The SDT contains data describing the services in the system. Examples
include: names of services, the service provider, etc.

SI (Service Information)
SI provides information on services and events carried by different Multi-
plexes, and even other networks. SI is structured as six tables (PAT, NIT,
CAT, SDT, EIT, and BAT). The applications are only concerned with NIT,
BAT, SDT, and EIT.
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Index
Symbols
? menu, Packet Jitter, 3–197

Numbers
10 Mbit serial port, 1–16

specifications, A–10
50 Ohm TTL Port, Specifications, A–10

A
Acq/Gen menu, Disk Manager, 3–165, 3–171
Acquisition command, Acq/Gen menu, Disk Manager,

3–172
Actual Rate, Multiplexer, 3–65
Adaptation Field, compliance, D–3
Adapters, 1–18
Add command, Edit Table, 2–70, 3–116–3–119
Add command button, Edit Table, 3–108
Analysis

Automatic, 3–44
Consistency check, 3–26
Dynamic, 3–38
LTW, 3–43
Multiplex allocation, 3–23
multiplex rate, 3–22
PCR, 3–30
PID map, 3–24
PSI/SI rate, 3–29
PTS/DTS, 3–34
Semantic, 3–37
Smoothing buffer, 3–44
Syntax, 3–25
T–STD, 3–39

Analysis menu
Analyzer, 2–9, 3–7
Edit Table, 3–107

Analyzer description, 1–2
Application, Locked, B–1
Application window

Analyzer, 3–3
Coding/Decoding, 3–200
Edit Table, 3–104
Multiplexer, 3–62

Associations, Table Files, 3–150–3–160
Audio Elementary Stream

Linking, 3–93

selecting, 2–55
Audio Elementary Stream icon, Multiplexer, 2–49,

3–69
Audio icon, embedded commands, 3–93
Audio Stream descriptor

compliance, D–13
Edit Table parameters, 3–128

Audio Stream dialog box, 2–54
AUI port, ethernet, 1–8
Automatic analysis, 3–44

options, 3–57

B
B Sync Byte Add Only module, 3–202
B Sync Byte Removal, 3–208
Base, Analyzer option, 3–56
BAT, 3–74, 3–103

Edit Table parameters, 3–123
BAT command button, Edit Table, 3–108
BAT icon

Edit Table, 3–109
Multiplexer, 2–49, 3–68

Binary view, Analyzer, 3–22
Bit order, changing, 3–183
Bit Stream CD ROM, 1–2
Board Reset, Fixing a locked application, B–1
Board Reset command, Disk Manager, 3–180
Bouquet Association Table, 3–103
Bouquet Name descriptor, Edit Table parameters,

3–134
Buffering simulation, 3–40
Burst mode, Transport Stream Generation, 3–178
Bytes, Number of Bytes in the Pattern, 3–211

C
CA descriptor, compliance, D–15
CA Identifier descriptor, Edit Table parameters, 3–135
Cable Delivery System descriptor, Edit Table

parameters, 3–135
Calculate packet jitter

command button, 3–197
menu command, 3–195

CARB, defined, 3–161
CARB File Read to PC command, Disk Manager,

3–168
CAT, compliance, D–10
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Chain command
Coding/Decoding, 3–202
Decoding menu, Coding/Decoding, 3–208

Channel Coder description, 1–3
Check CRC command, Analyzer, 2–22, 2–25
Clock Input, 1–16
Clock jitter, 3–189
Clock Port, Specifications, A–12
Close command, File menu, Edit Table, 3–112
Coded block size, Reed Solomon, 3–204
Coding, Satellite broadcasting, 1–3
Coding Flow, 3–199
Coding menu, Coding/Decoding, 3–202
Coherence command, Edit Table, 3–107
Collapse hierarchy, 3–70
Compliance

Adaptation Field, D–3
Analyzer Tests, D–1
descriptors, D–12
PES packet level, D–6
PSI level, D–8

Component descriptor, Edit Table parameters, 3–136
Composition Motif, Pattern, 3–212
Compress, Data Store disks, 3–163
Compress command, Service menu, Disk Manager,

3–181
Conditional Access descriptor, Edit Table parameters,

3–128
Configuration

Analyzer option, 3–58
Multiplexer. See Environment
Reed Solomon coding, 3–205

Configuration File, Example, 3–99
Configuration file, 2–46

linking audio elementary streams, 3–93
linking video elementary streams, 3–91
Multiplexer, 3–60
number of programs, 2–61

Connecting Cables, 1–17
Consistency check analysis, 3–26
Content descriptor, Edit Table parameters, 3–137
Control Port, File Acquisition, 3–175
Control Signals, Transport Stream Generation, 3–178
Convolutional Interleaving Coding, 3–216
Copy command, Edit menu, Edit Table, 3–119
Copy file, Data Store disks to system disk, 3–168
Copying files, from system to Data Store disks, 3–169
Copyright descriptor

compliance, D–16
Edit Table parameters, 3–128

Country Availability descriptor, Edit Table parameters,
3–138

Cut
command button, 3–108
menu command, 3–119

D
Data Elementary Stream icon, Multiplexer, 2–49
Data elementary stream icon, 3–69

embedded commands, 3–94
Data Format, Data Stream dialog box, 3–95
Data Store Administrator, 3–161–3–188
Data Store disks

copying to, 2–76
defined, 3–161
file management, 3–161, 3–162
file size, 3–98
generating directly to, 3–98
motor control, 3–182
use, 3–163

Data Stream Alignment descriptor
compliance, D–14
Edit Table parameters, 3–129

Decoder testing, 3–189
Decoding menu, Coding/Decoding, 3–208
Definition command, Jitter menu, Packet Jitter, 3–192
Definition command button, Packet Jitter, 3–197
DeInterleaver command, Decoding menu, Coding/De-

coding, 3–209
Delete, Files marked as, 3–168, 3–170
Delete command

Edit menu, Edit Table, 3–119
Multiplexer, 2–57, 3–97
Section menu, Edit Table, 3–114

Deleting, First or last file in FAT Table, 3–170
DEN, Transport Stream Generation, 3–178
Descriptor icon, Edit Table, 3–109
Descriptors

adding, 2–71
compliance, D–12
selection, 2–71

Dialog Interrupt, Resource Parameter, 3–180
Directories, Analyzer option, 3–57
Disk[s] Motor control, 3–182
DMA Channel, Resource Parameter, 3–180
DMA Interrupt, Resource Parameter, 3–180
Double-click, Multiplexer icons, 3–68
Duration Gauge

Coding/Decoding, 3–200
Multiplexer, 2–47, 3–65

DVB
Analyzer option, 3–55
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Multiplexer option, 2–83
DVB Channel Coding & Decoding, 3–199–3–218

Coding
Convolution Interleaving, 3–216
Reed Solomon, 3–215

DVB compliant files, 3–208
creating, 3–202

DVB File Selection, 2–84
Dynamic analysis, 3–38
Dynamic SI, Multiplexer, 3–75
Dynamic View, Multiplexer, 2–64

E
ECL Control port, 1–12
ECL Parallel/Serial port, 1–13

parallel data pinout, 1–14
serial data pinout, 1–14
Specifications, A–6

Edit menu
Analyzer, 2–9, 3–5
Edit Table, 3–106

Edit Table, starting from the Multiplexer, 2–69, 3–104
Edit window, Edit Table, 3–105
EIT, 3–74, 3–103

Edit Table parameters, 3–123
Table File Association, 3–149

EIT command button, Edit Table, 3–108
EIT icon

Edit Table, 3–109
Multiplexer, 2–49, 3–68

Elementary stream
Edit Table parameters, 3–124
files, 2–2

FTP site, 2–4
number in transport stream, 1–2
undefined, 3–98

Elementary stream icon, 3–109
Elementary stream initial delay

audio elementary stream, 3–94
video elementary stream, 3–92

Elementary stream offset, 3–72
Elementary stream rate

audio elementary stream, 3–93
video elementary stream, 3–91

Emergency Repair Disk, C–1
emergency repair disk, 1–5
End command button, Analyzer, 3–11
Ending, Locked Application, B–1
Energy dispersal coding, 1–3, 3–202, 3–214
Energy Dispersal command, Coding menu, Coding/De-

coding, 3–203

Energy Dispersal Removal command, Decoding menu,
Coding/Decoding, 3–210

Environment, Multiplexer, 3–73
Error command button, Analyzer, 3–11
Estimated Stop Time, Dynamic View, 3–71
ethernet ports

AUI, 1–8
RJ45, 1–8

Event icon, Edit Table, 3–109
Event Information Table, 3–103
Event Information Table (EIT), 3–103
Event parameters

EIT, 3–126
RST, 3–127

Exit command, Analyzer, 2–43
Expand hierarchy, 3–70
Extended Event descriptor, Edit Table parameters,

3–138

F
FAT Delete command, Service menu, Disk Manager,

3–180
FAT Read command, File menu, Disk Manager, 3–167
Field encoding changes, 3–90
Fields, Analyzer interpreted view, 3–18
File, opening, 3–12
File Delete command, File menu, Disk Manager, 3–170
File List, C–14
File location, File Generation, 3–177
File Management, Data Store Disks, 3–162
File Manager, Data Store disks, 3–161
File menu

Analyzer, 2–9, 3–4
Coding/Decoding, 3–201
Disk Manager, 3–165
Edit Table, 3–105
Packet Jitter, 3–190

File size
Acquisition, 3–172
Data Store disks, 3–98

File transfer, MTS-to-MTS, 3–184
File Undelete command, File menu, Disk Manager,

3–171
Files, storing on the Data Store disks, 2–59, 3–98
Filters, Analyzer, 3–46
Font, Analyzer option, 3–57
Frame encoding changes, 3–90
Free disk space, Data Store disks, 3–163
Freeing disk space, Data Store Disks, 3–181
Frequency Range

Data Store ports, 3–173
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Transport Stream Generation, 3–178
Frequency Step Size, PLL, 3–174
FTP site, elementary stream files, 2–4

G
G.703

data rates, 3–173
multiplex rate, 3–82

G.703 port, 1–15
G.703 Specifications

34.368 MHz, A–4
8.448 MHz, A–2

Generation command, Acq/Gen menu, Disk Manager,
3–176

Generation menu, Coding/Decoding, 3–211
Global multiplex start time, 3–72
Global View, Edit Table, 3–103
Global View command button, Edit Table, 3–108
Go To command button, Analyzer, 3–11

H
HASP, 1–5, 1–11, 2–1, C–9

connecting to the parallel port, 1–8
Help menu

Analyzer, 2–9
Disk Manager, 3–166
Edit Table, 3–107
Packet Jitter, 3–197

Hexadecimal view, Analyzer, 2–15, 3–19, 3–21
Hierarchic view

Analyzer, 2–11, 3–2, 3–13
Multiplexer, 3–67

Hierarchy
collapsing, 3–70
expanding, 3–70

Hierarchy command button, Analyzer, 3–11
Hierarchy descriptor

compliance, D–13
Edit Table parameters, 3–129

Hierarchy window, Edit Table, 3–104

I
I/O ports, 1–12
IBP descriptor

compliance, D–18
Edit Table parameters, 3–129

Icons
Analyzer hierarchic view, 3–13

Analyzer shortcut menus, 3–15
Edit Table, 3–109

Initial Delay, Data Elementary Stream, 3–95
Inner Coder, 1–3
Installation, 1–7

HASP, 1–11
Power Mains, 1–9

Inter Analysis, 3–115
Interface, Transport Stream Generation, 3–177
Interleaver

coding, 1–3
File type required, 3–206
menu command, 3–206

Internal Clock, File Acquisition, 3–173
Interpretation, Analyzer option, 3–57
Interpreted view, 3–17

Analyzer, 3–2, 3–14, 3–16
Interrupt, File Acquisition, 3–172
Interrupt command, Acq/Gen menu, Disk Manager,

3–179
Intra Analysis, 3–115
ISO 639 Language descriptor

compliance, D–15
Edit Table parameters, 3–130

Item number, in Analyzer interpreted view, 3–17

J
Jitter menu, Packet Jitter, 3–191
Jitter Type, 3–193

L
Linkage descriptor, Edit Table parameters, 3–139
logging in, 1–19
Logins, 1–20
Loop, Transport Stream Generation, 3–177
Loop sections, Data Stream dialog box, 3–95
Loss of Synchronization, Acquisition, 3–175
LTW analysis, 3–43

M
Manual Reset, B–1
Master, 3–173, 3–177
Maximum Bitrate descriptor

compliance, D–17
Edit Table parameters, 3–130

Menu bar
Analyzer, 3–4
Edit Table, 3–105
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Multiplexer, 3–62
Menu Map

DVB Coder/Decoder Application, 3–201
Packet Jitter Application, 3–190

monitor, 1–5
repackaging, F–2

Mosaic descriptor, Edit Table parameters, 3–139
MSB/LSB, changing output order, 3–183
MTS100 submenu, 1–20
Multiplex, 3–59

cannot generate, 3–98
Size, 3–92

Multiplex allocation, 2–18, 3–23
Multiplex analyses, 3–22
Multiplex Buffer Utilization descriptor

compliance, D–16
Edit Table parameters, 3–130

Multiplex generation, stopping, 3–99
Multiplex global start time, 3–71, 3–82
Multiplex icon, 2–48, 3–68
Multiplex menu, 3–98
Multiplex rate, 3–17, 3–22

specifying in Multiplexer, 3–82
Multiplex window, 2–48, 3–66

N
Network ID, 3–151

original, 3–151, 3–152, 3–154, 3–157
Network Information Table, 3–103
Network Name descriptor, Edit Table parameters,

3–140
New command, Section menu, Edit Table, 3–114
Next, Dynamic View, 3–72
Next command, Section menu, Edit Table, 3–113
Next command button

Analyzer, 3–11
Edit Table, 3–108

Next Error command button, 2–14, 2–31
NIT, 3–74, 3–103

Association, 3–148
compliance, D–11
Edit Table parameters, 3–121
editing in the Multiplexer, 3–85

NIT command button, Edit Table, 3–108
NIT icon, 2–84

Edit Table, 3–109
Multiplexer, 2–48, 3–68

Number command, Section menu, Edit Table, 3–114
Number command button, Analyzer, 3–11
Number of Sections, Edit Table, 3–106, 3–113

NVOD Reference descriptor, Edit Table parameters,
3–140

O
Offset jitter, 3–193
Offset PTS

Audio Elementary Stream, 3–94
Video Elementary Stream, 3–92

Open command
Analyzer, 2–10
File menu, Packet Jitter, 3–190

Open command button
Analyzer, 3–11
Packet Jitter, 3–197

Operating Basics, Menu Map
DVB Coder/Decoder Application, 3–201
Packet Jitter Application, 3–190

Options menu
Analyzer, 2–9, 3–55
Multiplexer, 3–73

Output Clock, Transport Stream Generation, 3–178
Output messages in file, Analyzer option, 3–56

P
Packet Jitter, 1–3
Packet Jitter application, 3–189
parallel port, 1–11
Parental Rating descriptor, Edit Table parameters,

3–141
Partitioning command, Service menu, Disk Manager,

3–180
Password, changing, emergency repair disk, 1–20
Paste command, Edit menu, Edit Table, 3–119
PAT

compliance, D–8
editing, 2–67
Multiplexer parameters, 3–84
period. See PSI period

PAT icon
embedded commands, 2–21
Multiplexer, 2–48, 3–68

Pattern
Composition Motif, 3–212
Number of Bytes in the Pattern, 3–211
Repetition, 3–212
Synchronization, File Acquisition, 3–174

Pattern command, Generation menu, Coding/Decoding,
3–211
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PC File Write to CARB, 2–76, 3–169
PCR, 2–26, 3–30, 3–189
PCR Analysis command, Analyzer, 2–26
PCR Clock Selection, Packet Jitter, 3–192
PCR period, 3–88
PCR Values, 2–27
Pedestal, server, installing, 1–7
PES format, Data Stream dialog box, 3–95
PES icon, embedded commands, 2–30
PES Packet, compliance, D–6
PES Packet Size

Audio Elementary Stream, 3–93
Video Elementary Stream, 3–92

PID, 3–191
PID 8191, 2–18
PID icon, embedded commands, 2–19
PID map, 3–24
PID Modification, 2–68
PID numbers, 3–97
PLL

decoder design, 3–189
File Acquisition, 3–173
Specifications, A–12
Transport Stream Generation, 3–178

PMT, 3–103
compliance, D–9
descriptors, 2–70
displaying Sections, 2–70
Edit Table parameters, 3–120
editing, 2–69
editing from within the Multiplexer, 3–85
period. See PSI period

PMT command button, Edit Table, 3–108
PMT icon

Edit Table, 3–109
embedded commands, 2–23
Multiplexer, 2–48, 3–68

Port
File Acquisition, 3–173
Transport Stream Generation, 3–178

Port Parameters, Transport Stream Generation, 3–178
Position, Analyzer interpreted view, 3–17
Power Cord Options, 1–10
Power mains

frequency, 1–10
voltage range, 1–9

Power switch, 1–19
PRBS, 3–203, 3–214
Previous, Dynamic View, 3–72
Previous command, Section menu, Edit Table, 3–113
Previous command button

Analyzer, 3–11
Edit Table, 3–108

Private Data (indicator) descriptor
compliance, D–17
Edit Table parameters, 3–131

Private Data Specifier descriptor, Edit Table parame-
ters, 3–141

Private sections, compliance, D–11
Program

adding, 2–61
Elementary Streams, 2–61
empty, 3–98

Program Bar, Dynamic View, 3–72
Program icon

embedded commands, 3–88
Multiplexer, 2–49, 3–69

Program start delay, 2–64, 3–72, 3–89
Program starting time, changing, 2–63
Programs, number in configuration file, 2–61
Protocol

File Acquisition, 3–173
Transport Stream Generation, 3–177

PSI
editing, 2–66
Period, 2–66

PSI dialog box, 2–68
PSI icon, Multiplexer, 2–48, 3–68
PSI Level, compliance, D–8
PSI period, 2–67

specify, 3–83
PSI/SI rate analysis, 3–29
PSYNC, File Acquisition, 3–174
PSYNC Mode, Acquisition, Synchronization, 3–175
PTS/DTS analysis, 3–34
PTS/DTS command, Analyzer, 2–32

Q
QPSK Modulating, coding, 1–3
Quit command, File menu, Packet Jitter, 3–191

R
Radio Service icon, Global View, Edit Table, 3–109
Random jitter, 3–195
Rate, Data Elementary Stream, 3–94
Rate Gauge

color, Multiplexer, 3–66
Multiplexer, 2–48, 3–65

Reed Solomon coding, 3–215
Coded Block Size, 3–204
Configuration, 3–205
size of block, 3–204
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Reed Solomon command
Coding menu, 3–204
Decoding menu, 3–210

Registration descriptor
compliance, D–14
Edit Table parameters, 3–131

Registry, editing values, 3–176, 3–179
Repair Disk Utility, C–2
reshipment carton, 1–7, F–1
Resource Parameters command, Service menu, Disk

Manager, 3–180
Right-click, Multiplexer icons, 3–68
RJ45 port, ethernet, 1–8
RS(204, 188), 3–215

coding, 1–3
Running Status Table, 3–103

S
Satellite broadcasting, 3–199

coding, 1–3
Satellite Delivery System descriptor, Edit Table

parameters, 3–142
Save

Elementary streams, 3–55
Error messages in file, 3–56
PES packets, 3–54
Table sections, 3–54
Transport packets, 3–53

Save All command, Edit Table, 3–111
Save As command, Edit Table, 3–111
Save command, Edit Table, 3–111
Save command button, Analyzer, 3–11
SB, Transport Stream Generation, 3–178
SDT, 3–74, 3–103

Edit Table parameters, 3–122
SDT command button, Edit Table, 3–108
SDT icon

Edit Table, 3–109
Multiplexer, 2–49, 3–68

Section
Data Stream dialog box, 3–95
EIT, Global View, 3–158
Global View, 3–152

Section menu, Edit Table, 3–106
Security, B–1
Selection menu, Analyzer, 2–9, 3–5
Semantic analysis, 3–37
Sequence Header, Video Stream dialog box, 3–92
Server pedestal

installing, 1–7
removal, F–2

Service, SDT, Table File Association, 3–149
Service Description Table, 3–103
Service descriptor, 3–155

Edit Table parameters, 3–142
table file association, 3–149

Service icon, Edit Table, 3–109
Service ID

EIT, Table File Association, 3–149
Global View, 3–154
SDT, Table File Association, 3–149

Service List descriptor, Edit Table parameters, 3–143
Service menu, Disk Manager, 3–166, 3–179
Service Move descriptor, Edit Table parameters, 3–143
Services, Global View, 3–154
shipping carton, 1–7, F–1
Short Event descriptor, Edit Table parameters, 3–143
Short Smoothing Buffer descriptor, Edit Table

parameters, 3–144
Shutdown, B–1
SI, 3–103
SI icon, 2–83

Multiplexer, 2–48, 3–68, 3–75
SI tables, Multiplexer, 3–95
Sine jitter, 3–194
Size

File Acquisition, 3–172
Transport Stream Generation, 3–177

Size of block, Reed Solomon coding, 3–204
Slave, 3–173, 3–177
Slot, Resource Parameter, 3–180
Smoothing buffer analysis, 3–44
Smoothing Buffer descriptor

compliance, D–17
Edit Table parameters, 3–131

software enable key, 1–5
specifications

Characteristic, A–1
Performance Requirement, A–1
Specification, A–1
Supplemental Information, A–1

Square jitter, 3–193
Standard Conformation, Draft prETS 300 468

November 1994, 3–104
Start command button, Analyzer, 3–11
STD descriptor

compliance, D–17
Edit Table parameters, 3–131

Stop if Desynchronized, File Acquisition, 3–174
Storing files on the Data Store disks, 3–98
Stream Identifier descriptor, Edit Table parameters,

3–144
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Stuffing Bytes
File Acquisition, 3–175
Transport Stream Generation, 3–178

Stuffing descriptor, Edit Table parameters, 3–144
Stuffing PID, 2–18
Subdescriptor icon, Edit Table, 3–109
Sync byte, 3–204
Sync Signal Size, Transport Stream Generation, 3–179
Synchro Byte Size, File Acquisition, 3–175
Synchronization, file acquisition, 3–174
Syntax analysis, 3–25
System Clock descriptor

compliance, D–16
Edit Table parameters, 3–132

System Hard Disk, definition, 3–161

T
T–STD analysis, 3–39
Table Files, Associations, 3–150–3–160
Target Background Grid descriptor

compliance, D–14
Edit Table parameters, 3–132

Task List, B–1
TDT, 3–74
TDT icon, Multiplexer, 3–69
TDT Period, 2–99
Technical support, 1–20
Telephone descriptor, Edit Table parameters, 3–144
Teletext descriptor, Edit Table parameters, 3–145
Terms, Analyzer, 3–2
Text Service icon, Global View, Edit Table, 3–109
Time, interpreted view, 3–17
Time Shifted Event descriptor, Edit Table parameters,

3–145
Time Shifted Service descriptor, Edit Table parameters,

3–146
Timing Cursor, Dynamic View, 3–72
Toolbar

Analyzer, 3–11
Disk Manager, 3–166
lower, Analyzer, 2–10
Packet Jitter, 3–197
Table Editor, 3–108

Transmission errors, 1–3, 3–189
Transport Packet command, Generation menu,

Coding/Decoding, 3–212
Transport Stream, 2–45, 3–59

creating errors, 1–3
defined, 3–189
Edit Table parameters, 3–126
file naming, 3–98

generation, 2–75, 2–79
Transport Stream file, 2–45, 2–59

defined, 3–189
generation, 2–75

Transport Stream icon, Edit Table, 3–109
Transport Stream ID, 3–151, 3–152

EIT, Table File Association, 3–149
Global View, 3–157
SDT, 3–154
Table File Association, 3–148

TS. See Transport Stream
TS icon, Analyzer, 2–13
TTL 50 Ohm Serial Port, 1–17
TV Service icon, Global View, Edit Table, 3–109

U
Undelete, Data Store Disks, 3–171
Uninstalling MTS software, C–3
Upper toolbar, 2–9
Useful Bytes

File Acquisition, 3–174
Transport Stream Generation, 3–178

User descriptor, Edit Table parameters, 3–146

V
Video elementary stream

icon, 2–49
Linking, 3–91
selecting, 2–52
set parameters, 2–51

Video Elementary Stream icon, Multiplexer, 3–69
Video Icon, embedded commands, Multiplexer, 3–91
Video Stream descriptor

compliance, D–12
Edit Table parameters, 3–133

Video Window descriptor
compliance, D–15
Edit Table parameters, 3–134

View command button, Analyzer, 3–11
Visual TSTD and LTW option, Analyzer, 3–38
Viterbi coding, 1–3, 3–206, 3–217

file type expected, 3–207
Viterbi decoding, 3–206

W
Window menu, Analyzer, 2–9
Windows NT, initialization, 1–19
Without Format, Data Stream dialog box, 3–95
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